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Preface 

This document describes how to use the MegaRAID Storage Manager. 

This preface includes the following information: 

 Intended Audience 

 Product Version 

 Release Notes 

 Document Conventions 

 Getting Help 

 Comments 
 

Notice: The use of MegaRAID Storage Manager and all other Hitachi Data 
Systems products is governed by the terms of your agreement(s) with Hitachi 
Data Systems. 
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Intended Audience 
This document is intended for the personnel who are involved in managing, 
configuring and operating the Compute Rack. 

 

Product Version 

This document revision applies to MegaRAID Storage Manager version 
11.08.03-02. 

 

Release Notes 

Release notes contain requirements and more recent product information that 
may not be fully described in this manual. Be sure to review the release notes 
before installation. 

 

Document Revision Level 
Revision Date Description 

01 March 2012 First Release 

MK-90CRC010-02 December 2012 Revision 02, supersedes and replaces Revision 01 

MK-90CRC010-03 July 2013 Revision 03, supersedes and replaces Revision 02 

Document Organization 
The table below provides an overview of the contents and organization of this 
document. Click the chapter title in the left column to go to that chapter. The 
first page of each chapter provides links to the sections in that chapter. 

 
Chapter  Description 

Chapter 1, Usage Precautions This chapter explains what you should know about MegaRAID Storage 
Manager (MSM) before use. Read this chapter before you uses the product. 

Chapter 2, MegaRAID Storage Manager This chapter explains how to install, remove, configure, and use MSM. 

Chapter 3, Operation of Disk Arrays This chapter explains how to operate disk arrays. 

Chapter 4, In the Event of a Fault This chapter explains the troubleshooting procedures against disk array faults. 

Chapter 5, Appendix This chapter explains a MSM events list etc. 

Abbreviation of Disk Array Management Utility 
In this manual, MegaRAID Storage Manager is abbreviated to the following: 
• MegaRAID Storage Manager (hereafter MSM) 
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Version of MegaRAID Storage Manager 
The version number displayed in the windows of MegaRAID Storage Manager 
shown in this manual may differ from the version number of your MegaRAID 
Storage Manager. 
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Document Conventions 
The term "Compute Rack" refers to all the models of the Compute Rack, 
unless otherwise noted. 

This document uses the following typographic conventions: 
 

Convention Description 

Bold Indicates text on a window, other than the window title, including menus, menu 
options, fields, and labels. Example: Click OK. 

Italic Indicates a variable, which is a placeholder for actual text provided by the user or 
system. Example: copy source-file target-file 

Note: Angled brackets (< >) are also used to indicate variables. 

screen/code Indicates text that is displayed on screen or entered by the user.  
Example: # pairdisplay -g oradb 

< > angled brackets Indicates a variable, which is a placeholder for actual text provided by the user or 
system. Example: # pairdisplay -g <group> 

Note: Italic font is also used to indicate variables. 

[  ] square brackets Indicates optional values. Example: [ a | b ] indicates that you can choose a, b, or 
nothing. 

{ } braces Indicates required or expected values. Example: { a | b } indicates that you must 
choose either a or b. 

| vertical bar  Indicates that you have a choice between two or more options or arguments. 
Examples: 

[ a | b ] indicates that you can choose a, b, or nothing. 

{ a | b } indicates that you must choose either a or b. 

underline Indicates the default value. Example: [ a | b ] 

This document uses the following icons to draw attention to information: 
   

Icon Meaning Description 

 
WARNING 

This indicates the presence of a potential risk that might cause death or 
severe injury. 

 
CAUTION 

This indicates the presence of a potential risk that might cause relatively 
mild or moderate injury. 

NOTICE NOTICE 
This indicates the presence of a potential risk that might cause severe 
damage to the equipment and/or damage to surrounding properties. 

 
Note 

This indicates notes not directly related to injury or severe damage to 
equipment. 

 
Tip This indicates advice on how to make the best use of the equipment. 
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Getting Help 

If you purchased this product from an authorized HDS reseller, contact that 
reseller for support. For the name of your nearest HDS authorized reseller, 
refer to the HDS support web site for locations and contact information. To 
contact the Hitachi Data Systems Support Center, please visit the HDS website 
for current telephone numbers and other contact information: 
http://support.hds.com.  

Before calling the Hitachi Data Systems Support Center, please provide as 
much information about the problem as possible, including: 

• The circumstances surrounding the error or failure. 

• The exact content of any error message(s) displayed on the host system(s). 

Comments 

Please send us your comments on this document: doc.comments@hds.com. 
Include the document title, number, and revision, and refer to specific sections 
and paragraphs whenever possible. All comments become the property of 
Hitachi Data Systems Corporation. Thank you! 

 

mailto:doc.comments@hds.com�
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Usage Precautions 

This chapter explains what you should know about MegaRAID Storage 
Manager (MSM) before use. Read this chapter before you uses the product. 

 RAID utility 

 MegaRAID Storage Manager 

 Restrictions on use of MegaRAID Storage Manager 

 LSI Software RAID 
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RAID utility 

This system unit supports two types of RAID utilities, Server installation and 
monitoring tool internal storage monitor and MSM. 

If you use unified management by MSM, install MSM. 
 

 
For Server installation and monitoring tool internal storage 
monitor, see "Server installation and monitoring tool User's Guide - 
internal storage monitoring functions". 

MegaRAID Storage Manager 

MSM is the utility software for managing disk array-mounted system units. 
MSM consists of MegaRAID Storage Manager Server (MSM Server) and 
MegaRAID Storage Manager Client (MSM Client). 
A MSM instance becomes an MSM Server or an MSM Client depending on the 
specification made at the time of installation. 
 

 

In an environment without Server installation and monitoring tool internal 
storage monitor / MSM installed, you might fail to detect a fault that causes 
loss of critical data or suffer inconvenience in fault analysis. Make sure that you 
install and use Server installation and monitoring tool internal storage 
monitor / MSM. 

 

 
When you update MSM, always remove the old version before 
installing the new version. 

 

 
A management PC is a PC that manages and monitors servers by MSM 
Client. A "management server" is a server that manages and monitors 
servers including itself. A "managed server" is a server that is 
managed and monitored. 

MSM provides the following functions: 

• Monitoring, managing, and maintaining disk array controllers and physical 
and virtual drives connected to disk array controllers, as well as remotely 
conducting these operations from a management PC 

• Centralized management 
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MSM consists of the following modules: (This is different from the actual 
program configuration.) 

Table 1-1 

General module Description 

MSM Server Core of MSM. It conducts various fault monitoring. 

(This module outputs events to the system log.) 

MSM Client Displays fault events on the GUI. 

(It is also used for remote management with a management PC.) 

MSM SNMP Reports faults via the SNMP interface. 

MSM remote Conducts real-time communication between different MSM instances over the 
network.*1 

*1: This module sends multicast packets on the network every five seconds. 
IP address: 229.111.112.12 (A packet is sent from each LAN port.) 

Content and operation of an MSM installation depend on its installation format. 

Table 1-2  

No. Installation format Installed content and its operation 

1 Complete All modules except MSM SNMP (recommended) or all modules 

Management and operation is enabled by MSM Server itself 
and by remote control. 

2 Standalone 

(Recommended installation 
format) 

All modules except MSM remote and MSM SNMP 

(recommended) or all modules except MSM remote 

Operation is enabled only by MSM Server itself. 

3 Client MSM Client module 

Remote management and operation with a management PC is 
enabled. 

 



1-4 Usage Precautions 

MegaRAID Storage Manager Instruction Manual 

Centralized management of MSM is enabled from a management PC. 

 

Figure 1-1 

A single management server can manage multiple servers including itself. If 
there is only one server, the server can be its own manager. 

 

Figure 1-2 

 

 

 
A management PC cannot manage a server that is connected to a 
network segment different from that of the management PC itself. 
When server management is centralized by a management PC, place 
the servers in the same segment. 

 

 
For centralized management by the MSM remote monitoring, a 
multicast packet is sent on the network every five seconds for each 
server. 
(Recommended installation format) 
When you do not conduct central management from a management PC 
or a management server, which also manages itself, install MSM in the 
"Standalone" format. 
OS event log logging and notification by pop-up windows are made 
only at the system unit where the event has occurred. 
The above processing is not performed on the remotely connected 
management PC. 
Services MrMonitor and MrMonitor monitoring are not installed in MSM 
Ver.11.08.XX.XX or later. 

Managed server 1 
(MSM Client, MSM Server) 

Management PC 
MSM Client 

Managed server 2 
(MSM Client, MSM Server) 

Manage server 3 
(MSM Client, MSM Server) 

Centralized management 
from management PC 

Management server 
(Managed server 1) 

(MSM Client, MSM Server) 

Managed server 2 
(MSM Client, MSM Server) 

Managed server 3 
(MSM Client, MSM Server) 
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Restrictions on use of MegaRAID Storage Manager 

This section explains the restrictions that you should know before using MSM 
(MSM Client) with a management PC. 

For other restrictions, see "Restrictions" on page 2-184. 

With Remote monitoring 

In an environment where centralized management is conducted, make sure 
that the MSM Client of the management PC has been stopped when you 
restart or switch off a managed server. 

If you restart or power off a managed server with the MSM Client running, 
the MSM Client becomes silent for about five minutes. 

With Centralized management by Linux 

When MSM is installed on Linux®, set the host name in the format conforming 
to the fully qualified domain name (FQDN). Remote monitoring does not work 
if a host name does not conform to the FQDN format. 

When introducing network security 

MSM uses its reserved ports 3071 and 5571. These port numbers cannot be 
changed. When introducing network security, register these ports as 
exceptions. 

When you use the firewall of Windows or Red Hat Enterprise Linux, you need 
to register the MSM module as an exception. For Linux, MSM functions are 
limited. See "Setting network security" on page 2-161 for details. 

IP addresses 

MSM needs to obtain an IP address for its operation. Set an IP address for 
each system unit. When a system unit obtains an IP address automatically, 
connect the system unit to a DHCP server. 

Restart the system unit after setting an IP address. 

Disable an unused LAN if any. 

For centralized management of managed servers, set the default gateway 
address. 

When there are multiple LAN addresses, the LAN address with the highest bind 
priority is configured as the default IP address of MSM. 
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In an environment where an IP address cannot be obtained, MSM may 
not be able to issue event notifications (That is, MSM may not be able 
to record events in the application log and MegaRAID Storage Manager 
log). 
In this case, an event is registered in the Windows application log with 
source: MSMFramework, Type: Warning, and Event ID: 1. 
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Changing an IP address, enabling or disabling a network, or 
connecting or disconnecting a TP line 

In the event of IP changing an address, enabling or disabling a network, or 
connecting or disconnecting a TP line, stop MSM service according to the 
following procedure: 

For Windows: 

1. Activate the service. 

2. Right-click the MSMFramework service, and select [Stop (O)]. 

3. The Another Service Stop window opens. Click [Yes (Y)]. 

4. Confirm that the MSMFramework service has stopped and the [State] 
has become blank. 

5. Change an IP address, enable or disable network, or connect or disconnect 
a TP line. 

6. Right-click the MSMFramework service, and select [Start (S)]. 

7. Confirm that the MSMFramework service has started and the [State] 
has become Started. 

8. Restart the system unit. 

The procedure is completed. 
 

 
If you fail to follow the above procedure, MSM may become unstable 
(unable to display status of servers including itself, or having CPU 
overload). If the system shows such a phenomenon, execute the 
above procedure excluding step 5. 
If no LAN cable is connected although a LAN port is available with a 
fixed IP address in the OS setup, the following pop-up message may 
appear after the system unit is started. 

 
Action: Confirm the following and restart the system unit. 
- Check the connection of the LAN port and the LAN cable. 
- Disable an unused LAN port if any. 
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For Linux: 

1. At /etc/rc.d/init.d/, stop the following service by the stop command: 

• vivaldiframeworkd 

[Command] 
# service vivaldiframeworkd stop 

2. Change an IP address, enable or disable a network, or connect or 
disconnect a TP line. 

3. At /etc/rc.d/init.d/, start the following service by the start command: 

• vivaldiframeworkd 

[Command] 
# service vivaldiframeworkd start 

4. Restart the system unit. 

The procedure is completed. 
 

 
If you fail to follow the above procedure, MSM may become unstable 
(unable to display status of servers including itself, or having CPU 
overload). If the system shows such a phenomenon, repeat the 
procedure above excluding step 3. 
If no LAN cable is connected although a LAN port is available with a 
fixed IP address in the OS setup, the following pop-up message may 
appear after the system starts. 

 
Action: Confirm the following and restart the system unit. 
- Check the connection of the LAN port and the LAN cable. 
- Disable an unused LAN port if any. 



 Usage Precautions 1-9 

MegaRAID Storage Manager Instruction Manual 

MegaRAID Storage Manager of management PC and management 
server 

The MSM version differs depending on a model. 

If system units of different MSM versions exist in the same network, the 
management PC or the management server might not be able to connect to a 
managed server. 

In such a case, update the MSM of the management PC to the latest version 
before using it. If centralized management by a management PC is not 
conducted, let the system unit with the latest version of MSM take the 
management server role. 

Centralized management by a management PC 

 

Figure 1-3  

Centralized management by a management server 

 

Figure 1-4  

For MSM update procedure, see "Installing and removing MegaRAID Storage 
Manager" on page 2-2. 

You must restart the system unit after MSM update. 

Managed server 1 
(MSM Client, MSM Server) 

Latest version 

Management PC 
MSM Client 

Latest version 

Managed server 2 
(MSM Client, MSM Server) 

Old version 

Managed server 3 
(MSM Client, MSM Server) 

Old version 

Update MSM of 
management PC to the 
latest version. 

Management server 
(Managed server 2) 

(MSM Client, MSM Server) 
Old version 

Management server 
(Managed server 1) 

(MSM Client, MSM Server) 
Latest version 

Management server 
(Managed server 3) 

(MSM Client, MSM Server) 
Old version 

Let the system unit with the latest version 
of MSM take the management server role 
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System environment required for MegaRAID Storage Manager 

MSM requires a system environment that satisfies the following conditions: 

• Intel Pentium or equivalent processors 

• A system memory capacity of at least 256 MB (512 MB recommended) 

• A network interface (when remote management functionality is used) 

• A spare capacity of 400 MB or more in the physical drive  

(We recommend a spare capacity of 1 GB or more including the space for 
log files.) 

• A mouse or other pointing device 

• A graphic controller and a display with 800 x 800 dots or more 

(We recommend a resolution of 1024 x 768 or higher.) 

• For Windows: 

Windows Server 2012, Windows Server 2008 R2, Windows Server 2008, or 
Windows XP 

• For Linux: 

Red Hat Enterprise Linux Server 6, Red Hat Enterprise Linux 5 

• TCP/IP protocol installation (when the remote management function is 
used) 
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LSI Software RAID 

For LSI Software RAID, the functions of MSM listed below cannot be used: 

Table 1-3 

Function Description Reference 
pages 

Expansion of virtual drive 
capacity 

Expands the capacity by adding a new physical drive to 
the existing virtual drive. 

2-135 

Write cache change Changes the cache setting of disk array controller. 2-140 

LED blinking Makes LED of each physical drive blink. 2-143 

Cache back module (BBU) 
diagnosis 

Diagnoses the cache back module (BBU). 2-145 

Enable/disable setting of 
SMART copyback 

Changes the enable/disable setting of SMART copyback. 

* This function is configured with MegaCli. 

2-148 

Firmware update Updates the firmware of disk array controller. - 

Patrol Read setting Configures Patrol Read, which runs in the background. 2-179 

Task rate setting Sets the rates of various tasks. - 

Setting of power-saving 
mode of physical drives 

Sets the power-saving mode of physical drives. - 

Setting of consistency 
check processing method 

Sets consistency check processing method. - 

SSD GuardTM Sets SSD GuardTM. - 

Buzzer setting of disk 
array controller 

Configures the buzzer of disk array controller. - 
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MegaRAID Storage Manager 

This chapter explains how to install, remove, configure, and use MSM. 

 Installing and removing MegaRAID Storage Manager 

 Activating MegaRAID Storage Manager 

 Exiting MegaRAID Storage Manager 

 Initialization 

 Screen configuration and descriptions of MegaRAID Storage Manager 

 Functions of MegaRAID Storage Manager 

 Replacing a physical drive 
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Installing and removing MegaRAID Storage Manager 

 
 

 

In an environment without Server installation and monitoring tool internal 
storage monitor / MSM installed, you might fail to detect a fault that causes 
loss of critical data or suffer inconvenience in fault analysis. Make sure that you 
install and use Server installation and monitoring tool internal storage 
monitor / MSM. 

 

 
When you update MSM, always remove the old version of MSM before 
installing a new version. 

Installation 

The MSM installation procedure is described below. 

MSM installation is different in location and procedure depending on a 
management configuration. 

• For standalone server management 

• Server: Installed by the standalone format 

(Exclude MSM Remote and MSM SNMP using the installation option.) 

• Centralized management of managed servers (single or multiple) from a 
management PC 

• Management PC: Installed in the client format 

(Exclude MSM SNMP using the installation option.) 

• Managed server: Installed in the complete format 

(Exclude MSM SNMP using the installation option.) 

• Centralized management of multiple managed servers by the management 
server 

• Management server: installed in the complete format 

(Exclude MSM SNMP using the installation option.) 

• Managed server: installed in the complete format 

(Exclude MSM SNMP using the installation option.) 
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The MSM Client function must be installed for maintenance work of 
managed servers. Install all MSM modules (MSM Server and MSM 
Client. MSM SNMP is excluded.) on the managed server. 
After installation, refer to "Initialization" on page 2-71 for 
configuration. 
 
If you install the MSM to Red Hat Enterprise Linux 6 (64-bit x86_64), 
there are libraries required to install it. Please install the required 
libraries refer to "Required libraries in Red Hat Enterprise Linux 6 (64-
bit x86_64) environment" on page 2-4. 

 

 
(Recommended installation format) 
When you do not conduct centralized management from a 
management PC or a management server, which also manages itself, 
install MSM in the standalone format. 
For a Linux environment, we recommend that you use GUI for 
installation. 
For Windows, Microsoft visual c++ 2005 is installed before the 
installation of MSM. 

 

 
In the case of Windows, if you set up MSM while the Windows 
Server Post-setup Security Updates window is kept open after 
completion of the OS installation, the MSM alert window opens as 
Windows Security Alert because the firewall is enabled. 
Handle this situation with reference to "Setting network security" on 
page 2-161. 
For Linux, CUI installation of MSM is not supported except for the 
standalone format. Install MSM with reference to "Linux: Installation 
in the standalone format (Recommended format)" on page 2-32. 
If MSM is installed in the CUI environment of Linux, the only MSM 
functions that can be used are event output to Linux 
(var/log/messages) and some functions that use MegaCli (functions 
described in this manual such as a consistency check). 
Pop-up window notification is disabled in the default setting of Linux 
event notifications. To enable pop-up window notification in the GUI 
environment, see "Setting" on page 2-171. 
In a non-GUI environment, pop-up window notification is not 
supported and should remain disabled. 
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Required libraries in Red Hat Enterprise Linux 6 (64-bit x86_64) environment 

If you install the MSM to Red Hat Enterprise Linux 6 (64-bit x86_64), there 
are libraries required to install it. 

Please install libraries from the media of each Red Hat Enterprise Linux 6. 

• Required libraries for Red Hat Enterprise Linux Server 6.4 (64-bit 
x86_64) 

• libstdc++-4.4.7-3.el6.i686.rpm 

• compat-libstdc++-33-3.2.3-69.el6.i686.rpm 

• libXau-1.0.6-4.el6.i686.rpm 

• libxcb-1.8.1-1.el6.i686.rpm 

• libX11-1.5.0-4.el6.i686.rpm 

• libXext-1.3.1-2.el6.i686.rpm 

• libXi-1.6.1-3.el6.i686.rpm 

• libXtst-1.2.1-2.el6.i686.rpm 

• Required libraries for Red Hat Enterprise Linux Server 6.2 (64-bit 
x86_64) 

• libstdc++-4.4.6-3.el6.i686.rpm 

• compat-libstdc++-33-3.2.3-69.el6.i686.rpm 

• libXau-1.0.5-1.el6.i686.rpm 

• libxcb-1.5-1.el6.i686.rpm 

• libX11-1.3-2.el6.i686.rpm 

• libXext-1.1-3.el6.i686.rpm 

• libXi-1.3-3.el6.i686.rpm 

• libXtst-1.0.99.2-3.el6.i686.rpm 

• Required libraries for Red Hat Enterprise Linux Server 6.1 (64-bit 
x86_64)  

• libstdc++-4.4.5-6.el6.i686.rpm 

• compat-libstdc++-33-3.2.3-69.el6.i686.rpm 

• libXau-1.0.5-1.el6.i686.rpm 

• libxcb-1.5-1.el6.i686.rpm 

• libX11-1.3-2.el6.i686.rpm 

• libXext-1.1-3.el6.i686.rpm 

• libXi-1.3-3.el6.i686.rpm 

• libXtst-1.0.99.2-3.el6.i686.rpm 
 

 
Please perform the following command to install the library. 
(The following is one example) 
# rpm -ivh <Library to install> 
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Windows: Installation in the standalone format (Recommended format) 
 

 
In the event of installation in the standalone format, MSM alone 
cannot realize centralized management from a management PC nor 
the centralized management of multiple servers by a management 
server, which also manages itself. 
Make sure that you select Custom in the Setup Type window of step 
11 of the installation procedure. Do not select standalone for 
installation. 

1. Start Windows and logon as Administrator. 

2. Insert the "Server installation and monitoring tool DVD" or "Driver Kit CD" 
in the CD/DVD drive. 

3. [ When "Server installation and monitoring tool DVD" is used ] 

Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 
 
(1) Default installation location 

"d:\(the target directory path)\TOOL\MSM_Installer.exe" *1 *2 

 (2) Non-default installation location, and fault monitoring through SNMP 
interface 

"d:\(the target directory path)\Setup.exe" *2 
 

 
[ When "Driver Kit CD" is used ] 
Select Start > Run, enter information as shown below, and click OK.  
 

(1) Default installation location 

"d:\Win2008\UTILITY\MSM\TOOL\MSM_Installer.exe" *1 *2 

 (2) Non-default installation location, and fault monitoring through SNMP 
interface 

"d:\Win2008\UTILITY\MSM\Setup.exe" *2 
 

*1: Running MSM_Installer.exe, the DOS prompt window opens. After 
a few minutes, when a pop-up window opens asking you to restart 
the system unit, perform the procedure from step 20. 

*2: d stands for a CD/DVD drive. 
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4. Click Install when the following window opens. 

 
The following progress window is displayed. 

 

5. Click Yes when the following window opens. 
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6. Click Next when the following window opens. 

 

7. The license agreement window opens. Select I accept the terms in the 
license agreement and click Next. 
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8. The Customer Information window opens. Read the description on the 
MSM usage privileges and click Next. 

Select Only for current user if you use MSM only as Administrator. 
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9. The window for specifying MSM installation destination opens. Change the 
installation location as necessary and click Next. 

The default installation destinations are as follows: 

• 64bit OS: 

C:\Program Files (x86)\MegaRAID Storage Manager 

• 32bit OS: 

C:\Program Files\MegaRAID Storage Manager 
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10. The Setup Type window opens. Confirm the installation descriptions and 
click Next. 

Make sure that you check Custom Installation, and click Next. 

 

11. The detailed version of the Setup Type window opens. Check Custom 
and click Next. 
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12. The Custom Setup window opens. 

If you use SNMP, do not select anything and go to the next step. 

If you do not use SNMP, select Server > Optional Utilities > SNMP, and 
select This feature will not be available. 

(*We recommend that you select This feature will not be available.) 

 

13. Select Server > Plugins > NetworkCapability, and select This feature 
will not be available. 
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14. Select Server > Plugins > CIM, select This feature will not be 
available, and click Next. 

 

15. The Ready to Install the program window opens. Confirm the content 
and click Install. 

 
Installation starts. 
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16. When the installation is finished, the InstallShield Wizard Completed 
window is displayed. Click Finish. 

 

17. The installer is terminated, and an MSM icon is generated on the desktop. 

 

18. [ When "Server installation and monitoring tool DVD" is used ] 
Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 
 
     "d:\(the target directory path)\TOOL\MSM_Installer.exe" 
 
 
[ When "Driver Kit CD" is used ] 
Select Start > Run, enter information as shown below, and click OK. 
 

"d:\Win2008\UTILITY\MSM\TOOL\MSM_Installer.exe" 

 

* d stands for a CD/DVD drive. 

When this file is executed, the DOS prompt window opens. 
 

 
Make sure that you execute MSM_Installer.exe. 
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19. After completion, a pop-up window opens to prompt you to restart the 
system unit. 

 

20. Remove the CD/DVD from the drive, and click YES on the pop-up window. 

The system unit restarts. 
 

 
Make sure that you restart the system unit after MSM installation. 

21. When Windows has started, logon as Administrator. 

The Window firewall blocks the MSM module (javaw) if enabled. Handle 
this matter with reference to "Setting network security" on page 2-161. 

MSM installation in the standalone format is completed. 

After installation, configure the disk array controller in accordance with 
your operation with reference to "Initialization" on page 2-71. 
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Windows: Installation in complete format (Installation on a management 
server or managed server) 
 

 
Make sure that you select Custom Installation in the Setup Type 
window of step 10 of the installation procedure. Do not select 
Complete for installation. 

 

 
If you intend to manage a standalone server without network 
connection, follow the description "Windows: Installation in the 
standalone format". 

1. Boot Windows and logon as Administrator. 

2. Insert the "Server installation and monitoring tool DVD" or "Driver Kit CD" 
in the CD/DVD drive. 

3. [ When "Server installation and monitoring tool DVD" is used ] 
Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 
 
    "d:\(the target directory path)\Setup.exe" 
 
 
[ When "Driver Kit CD" is used ] 
Select Start > Run, enter information as shown below, and click OK.  
 

"d:\Win2008\UTILITY\MSM\Setup.exe" 

 

* d stands for a CD/DVD drive. 



2-16 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

4. Click Install when the following window opens. 

 
The following progress window is displayed. 
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5. Click Yes when the following window opens. 

 
 

6. Click Next when the following window is displayed. 
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7. The license agreement window opens. Select I accept the terms in 
the license agreement and click Next. 

 

8. The Customer Information window opens. Read the description on the 
MSM usage privileges and click Next. 

Select Only for current user if you use MSM only as Administrator. 
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9. The window for specifying MSM installation destination opens. Change the 
installation location as necessary and click Next. 

The default installation destinations are as follows: 

• 64bit OS: 

C:\Program Files (x86)\MegaRAID Storage Manager 

• 32bit OS: 

C:\Program Files\MegaRAID Storage Manager 

 

10. The Setup Type window opens. Confirm the installation details and click 
Next. 

Make sure that you check Custom Installation, and click Next. 

 



2-20 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

11. The detailed Setup Type window opens. Check Custom and click Next. 

 

12. The Custom Setup window opens. 

If you use SNMP, do not select anything and click Next. 

If you do not use SNMP, select Server > Optional Utilities > SNMP, 
select This feature will not be available, and click Next. 

(* We recommend that you select This feature will not be available.) 
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13. The Ready to Install the Program window opens. Confirm the content 
and click Install. 

 
Installation starts. 

14. When the installation is finished, the InstallShield Wizard Completed 
window opens. Click Finish. 

 

15. The installer is terminated, and then an MSM icon is generated on the 
desktop. 
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16. [ When "Server installation and monitoring tool DVD" is used ] 
Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 
 
    "d:\(the target directory path)\TOOL\MSM_Installer.exe" 
 
[ When "Driver Kit CD" is used ] 
Select Start > Run, enter information as shown below, and click OK. 
 

"d:\Win2008\UTILITY\MSM\TOOL\MSM_Installer.exe" 

 
* d stands for a CD/DVD drive. 

When this is executed, the DOS prompt window opens. 
 

 
Make sure that you execute MSM_Installer.exe. 
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17. After completion, a pop-up window opens to prompt you to restart the 
system unit. 

 

18. Remove the CD/DVD from the drive, and click YES on the pop-up window. 

The system unit restarts. 
 

 
Make sure that you restart the system unit after MSM installation. 

19. When Windows has started, logon as Administrator. 

The Window firewall blocks the MSM module (javaw) if enabled. Handle 
this situation with reference to "Setting network security" on page 2-171. 

 

MSM installation in the complete format is completed. 

After installation, configure the disk array controller in accordance with your 
operation with reference to "Initialization" on page 2-71. 
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Windows: Installation in client format (Installation on a management PC) 
 

 
Make sure that you select Custom in the Setup Type window of 
step 11 of the installation procedure. Do not select Client for 
installation. 

 

 
MSM installation to a management PC is not required for the 
standalone operation. 

1. Boot Windows and logon as Administrator. 

2. Insert the "Server installation and monitoring tool DVD" or "Driver Kit CD" 
in the CD/DVD drive. 

3. [ When "Server installation and monitoring tool DVD" is used ] 
Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 
 
    "d:\(the target directory path)\Setup.exe" 
 
 
[ When "Driver Kit CD" is used ] 
Select Start > Run, enter information as shown below, and click OK.  
 

"d:\Win2008\UTILITY\MSM\Setup.exe" 
 

* d stands for a CD/DVD drive. 

4. Click Install when the following window opens. 
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The following progress window is displayed. 

 

5. Click Yes when the following window opens. 
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6. Click Next when the following window is displayed. 

 

7. The License Agreement window opens. Select I accept the terms in 
the license agreement and click Next. 
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8. The Customer Information window opens. Read the description on the 
MSM usage privileges and click Next. 

Select Only for current user if you use MSM only as Administrator. 
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9. The screen for specifying MSM installation destination opens. Change the 
installation location as necessary and click Next. 

The default installation destinations are as follows: 

• 64bit OS: 

C:\Program Files (x86)\MegaRAID Storage Manager 

• 32bit OS: 

C:\Program Files\MegaRAID Storage Manager 

 

10. The Setup Type window opens. Confirm the installation details and click 
Next. 

For a management PC, check Custom Installation. 
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11. The detailed Setup Type window opens. Check Custom and click Next. 

 
 

 
If you check Client here, real-time remote management will be 
disabled after installation. 

12. The Custom Setup window opens. Select Server > Optional Utilities > 
SNMP, select This feature will not be available, and click Next. 
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13. The Ready to Install the Program window opens. Confirm the content 
and click Install. 

 
Installation starts. 

14. When the installation is finished, the InstallShield Wizard Completed 
window opens. Click Finish. 

 

15. The installer is terminated, and an MSM icon is created on the desktop. 
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16. Remove the CD/DVD from the drive, and restart the system unit. 
 

 
Make sure that you restart the system unit after MSM installation. 

MSM installation in the client format is completed. 
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Linux: Installation in the standalone format (Recommended format) 
 

 
To install MSM on Linux and use the functions described in this 
manual, do it in an environment where all selectable items in the 
Linux installer have been selected for one of the Linux installation 
packages listed below. 
The items marked by (*1) are not required if MSM is used only with 
CUI. 
In this case, the only MSM functions that can be used are event 
output to Linux (var/log/messages) and some functions that use 
MegaCli (functions described in this manual such as consistency 
check). Therefore, we recommend that you install all of the 
following items: 
[Red Hat Enterprise Linux 6] 
• Desktop *1 
• General Purpose Desktop *1 
• X Window System *1 
• Base 
• Compatibility library 
[Red Hat Enterprise Linux 5] 
• GNOME desktop environment *1 
• X Window System *1 
• Base 
• Support of legacy software 
If these items are not installed, MSM installation and functions 
described in this manual cannot be performed normally. 
Disable SE Linux of the OS or set it to "Permissive". 
When installed with the standalone format, MSM alone cannot 
realize centralized management from a management PC nor the 
centralized management of multiple servers by a management 
server, which also manages itself. 
When you update MSM, remove the current MSM in the correct 
procedure, and then install a new version of MSM. To remove MSM, 
see the MSM manual that you have used for installation. 

1. Start Linux, and logon as root. 
If you install the MSM to Red Hat Enterprise Linux 6 (64-bit 
x86_64), some libraries are required. Please refer to "Required libraries in 
Red Hat Enterprise Linux 6 (64-bit x86_64) environment" on page 2-4 and 
install them. 

2. Start X Windows. 

# startx 

* Not required for a CUI environment 
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3. Insert the "Driver Kit" CD-ROM in the CD/DVD drive. 

4. Start the terminal. 

5. Mount the CD-ROM. This step is not required if the CD-ROM has been 
automatically mounted. 

# mount /dev/cdrom /media/ 
 

 
If the above command does not mount the CD-ROM, try the 
command again appending any number (1, 2, 3, ...) to "cdrom", 
and then see if the CD has been mounted. 
[Example: When the number is "2"] 
  # mount /dev/cdrom2 /media/ 

6. Copy "MSM_linux_installer-x.xx-xx.tar.gz" to any directory from "Driver 
Kit" CD-ROM. 
"MSM_linux_installer-x.xx-xx.tar.gz" is in \hitachi_utilities\msm 
directory. 

* "x" in MSM_linux_installer-x.xx-xx.tar.gz varies depending on the MSM 
version. 

Find out the actual file name. 

7. Execute the following command. 

# cd /copy-directory (the copy destination in step 6) 

# tar -xvzf copy-file (the copy destination in step 6) 



2-34 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

8. The disk directory and files are created. 

9. Execute the MSM installation command. 

Move to the directory in which the file has been uncompressed, and execute 
one of the following installation commands: 

[Installation command: 1] 

# cd /copy-directory (the copy destination in step 6) / disk 
# ./msminstall.sh 

[Installation command: 2] 

# cd /copy-directory (the copy destination in step 6) / disk 
# ./install.csh 

We recommend [Installation command: 1]. After execution of the command, 
go to step 12. 

To display the window for installation format specification, execute 
[Installation command: 2], and then go to step 10. 
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The install.csh command has the following command options: 
(When you have selected a command option, go to step 12.) 

* Command options of install.csh: 
   # ./install.csh -(first argument) -ru (second argument) 

• First argument: 

a: Installation in the complete format (all MSM modules) 

s: Installation in the standalone format (all modules excluding MSM 
Remote) 

c: Installation in the client format (only the MSM Client module) 

• Second argument: 

popup: When an event occurs, it is not displayed in a pop-up window (not 
supported). 

snmp: The SNMP module is not installed. 

Select an appropriate installation in accordance with your operation. 

The msminstall.sh command is equivalent to the standalone format 
installation by the install.csh command with the snmp specification. 

#./install.csh -s -ru snmp 
 

 
Do not specify popup of the second argument because it may 
prevent event outputs to Linux, which is not supported. 
The message below during installation command execution indicates 
that the MSM installation has not been done successfully. The 
kernel may be incompatible with MSM. In this case, check if the 
environment of the target system unit is supported. 
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MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 

10. The license agreement description opens awaiting your response. 

Read the license agreement, and enter Y or y and press Enter. 

 

11. The window for specifying the installation format opens. 

For the standalone format, enter 3 and press Enter. 

 
Installation starts. 

 

 
MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 
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12. Installation starts. After ending installation, unmount the CD-ROM, then 
remove the CD-ROM from the drive, and restart the system unit. 

 
 

 
Make sure that you restart the system unit after MSM installation. 

MSM installation in the standalone format is completed. 

After installation, configure the disk array controller in accordance with 
your operation form with reference to "Initialization" on page 2-71. 

This installation includes a command line program. The command line 
program is installed in the following directory: 

/opt/MegaRAID/MegaCli 

The name of the program to be executed varies depending on the OS. 

• 64bit OS: MegaCli64 

• 32bit OS: MegaCli 
 

 
Various messages may be displayed during installation. See 
"Precautions" on page 2-187 for details. 
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Linux: Installation in the complete format 
(Installation on a management server or managed server) 
 

 
To install MSM on Linux and use the functions described in this 
manual, do it in an environment where all selectable items in the 
Linux installer have been selected for on of the Linux installation 
packages below. 
[Red Hat Enterprise Linux 6] 
• Desktop 
• General Purpose Desktop 
• X Window System 
• Base 
• Compatibility library 
[Red Hat Enterprise Linux 5] 
• GNOME desktop environment 
• X Window System 
• Base 
• Support of legacy software 
If these items are not installed, MSM installation and functions 
described in this manual cannot be performed normally. 
Disable SE Linux of the OS or set it to "Permissive". 
If you intend to manage the server without network connection, 
perform the procedure of "Linux: Installation in the standalone 
format (Recommended format)" on page 2-32. 
Set the host name in the format conforming to the fully qualified 
domain name (FQDN). Remote monitoring does not work if a host 
name does not conform to the FQDN format. 
When you update MSM, remove the current MSM in the correct 
procedure, and then install a new version of MSM. To remove MSM, 
see the MSM manual that you have used for installation. 

1. Start Linux, and logon as root. 
If you install the MSM to Red Hat Enterprise Linux 6 (64-bit 
x86_64), some libraries are required. Please refer to "Required libraries in 
Red Hat Enterprise Linux 6 (64-bit x86_64) environment" on page 2-4 and 
install them. 

2. Start X Windows. 

# startx 
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3. Insert the "Driver Kit" CD-ROM in the CD/DVD drive. 

4. Start the terminal. 

5. Mount the CD-ROM. This step is not required if the CD-ROM has been 
automatically mounted. 

# mount /dev/cdrom /media/ 
 

 
If the above command does not mount the CD-ROM, try the 
command again appending any number (1, 2, 3, ...) to "cdrom", 
and then see if the CD has been mounted. 
[Example: When the number is "2"] 
  # mount /dev/cdrom2 /media/ 

6. Copy "MSM_linux_installer-x.xx-xx.tar.gz" to any directory from "Driver 
Kit" CD-ROM. 
"MSM_linux_installer-x.xx-xx.tar.gz" is in \hitachi_utilities\msm 
directory. 

* "x" in MSM_linux_installer-x.xx-xx.tar.gz varies depending on the MSM 
version. 

Find out the actual file name. 

7. Execute the following command. 

# cd /copy-directory (the copy destination in step 6) 

# tar -xvzf copy-file (the copy destination in step 6) 
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8. The disk directory and files are created. 

9. Execute the MSM installation command. 

Move to the directory in which the file has been uncompressed, and execute 
one of the following installation commands: 

[Installation command: 1] 

# cd /copy-directory (the copy destination in step 6) / disk 
# ./remsminstall.sh 

[Installation command: 2] 

# cd /copy-directory (the copy destination in step 6) / disk 
# ./install.csh 

We recommend [Installation command: 1]. After execution of the command, 
go to step 12. 

To display the window for installation format specification, execute 
[Installation command: 2], and then go to step 10. 
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The install.csh command has the following command options: 
(When you have selected a command option, go to step 12.) 

* Command options of install.csh: 
   # ./install.csh -(first argument) -ru (second argument) 

• First argument: 

a: Installation in the complete format (all MSM modules) 

s: Installation in the standalone format (all modules excluding MSM 
Remote) 

c: Installation in the client format (only the MSM Client module) 

• Second argument: 

popup: When an event occurs, it is not displayed in a pop-up window (not 
supported). 

snmp: The SNMP module is not installed. 

Select an appropriate installation in accordance with your operation. 

The remsminstall.sh command is equivalent to the complete format 
installation by the install.csh command with the snmp specification. 

#./install.csh -a -ru snmp 
 

 
Do not specify popup of the second argument because it may 
prevent event outputs to Linux, which is not supported. 
The message below during installation command execution indicates 
that the MSM installation has not been done successfully. The 
kernel may be incompatible with MSM. In this case, check if the 
environment of the target system unit is supported. 
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MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 

10. The license agreement description opens awaiting your response. 

Read the license agreement, and enter Y or y and press Enter. 

 

11. The window for specifying the installation format opens. 

For the complete format, type 1 and press Enter. 

 
Installation starts. 

 

 
MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 
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12. Installation starts. After ending installation, unmount the CD-ROM, remove 
the CD-ROM from the drive, and restart the system unit. 

 
 

 
Make sure that you restart the system unit after MSM installation. 

MSM installation in the complete format is completed. 

After installation, configure the disk array controller in accordance with 
your operation form with reference to "Initialization" on page 2-71. 

This installation includes a command line program. The command line 
program is installed in the following directory: 

/opt/MegaRAID/MegaCli 

The name of the program to be executed varies depending on the OS. 

• 64bit OS: MegaCli64 

• 32bit OS: MegaCli 
 

 
Various messages may be displayed during installation. See 
"Precautions" on page 2-187 for details. 
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Linux: Installation in the client format (Installation on a management PC) 
 

 
To install MSM on Linux and use the functions described in this 
manual, do it in an environment where all selectable items in the 
Linux installer have been selected for on of the Linux installation 
packages below. 
[Red Hat Enterprise Linux 6] 
• Desktop 
• General Purpose Desktop 
• X Window System 
• Base 
• Compatibility library 
[Red Hat Enterprise Linux 5] 
• GNOME desktop environment 
• X Window System 
• Base 
• Support of legacy software 
If these items are not installed, MSM installation and functions 
described in this manual cannot be performed normally. 
Disable SE Linux of the OS or set it to "Permissive". 
Set the host name in the format conforming to the fully qualified 
domain name (FQDN). Remote monitoring does not work if a host 
name does not conform to the FQDN format. 
When you update MSM, remove the current MSM in the correct 
procedure, and then install a new version of MSM. To remove MSM, 
see the MSM manual that you have used for installation. 

1. Start Linux, and logon as root. 
If you install the MSM to Red Hat Enterprise Linux 6 (64-bit 
x86_64), some libraries are required. Please refer to "Required libraries in 
Red Hat Enterprise Linux 6 (64-bit x86_64) environment" on page 2-4 and 
install them. 

2. Start X Windows. 

# startx 

3. Insert the "Driver Kit" CD-ROM in the CD/DVD drive. 

4. Start the terminal. 

5. Mount the CD-ROM. This step is not required if the CD-ROM has been 
automatically mounted. 

# mount /dev/cdrom /media/ 
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If the above command does not mount the CD-ROM, try the 
command again appending any number (1, 2, 3, ...) to "cdrom", 
and then see if the CD has been mounted. 
[Example: When the number is "2"] 
  # mount /dev/cdrom2 /media/ 

6. Copy "MSM_linux_installer-x.xx-xx.tar.gz" to any directory from "Driver 
Kit" CD-ROM. 
"MSM_linux_installer-x.xx-xx.tar.gz" is in \hitachi_utilities\msm 
directory. 

* "x" in MSM_linux_installer-x.xx-xx.tar.gz varies depending on the MSM 
version. Find out the actual file name. 

7. Execute the following command. 

# cd /copy-directory (the copy destination in step 6) 

# tar -xvzf copy-file (the copy destination in step 6) 
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8. The disk directory and files are created. 

9. Execute the MSM installation command. 

Move to the directory in which the file has been uncompressed, and execute 
one of the following installation commands: 

# cd /copy-directory (the copy destination in step 6) / disk 
# ./install.csh 
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The install.csh command has the following command options: 
(When you have selected a command option, go to step 12.) 

* Command options of install.csh: 
   # ./install.csh -(first argument) -ru (second argument) 

• First argument: 

a: Installation in the complete format (all MSM modules) 

s: Installation in the standalone format (all modules excluding MSM 
Remote) 

c: Installation in the client format (only the MSM Client module) 

• Second argument: 

popup: When an event occurs, it is not displayed in a pop-up window (not 
supported). 

snmp: The SNMP module is not installed. 

 

Select an appropriate installation in accordance with your operation. 
 

 
Do not specify popup of the second argument because it may 
prevent event outputs to Linux, which is not supported. 
The message below during installation command execution indicates 
that the MSM installation has not been done successfully. The 
kernel may be incompatible with MSM. In this case, check if the 
environment of the target system unit is supported. 

 
 

 
MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 
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10. The license agreement description opens awaiting your response. 

Read the license agreement, and type Y or y and press Enter. 

 

11. The window for specifying the installation format opens. 

For the client format, type 2 and press Enter. 

 
Installation starts. 

 

 
MSM is installed in the following directory: 
  # /usr/local/MegaRAID Storage Manager 
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12. Installation starts. After ending installation, unmount the CD-ROM, then 
remove the CD-ROM from the drive, and restart the system unit. 

 

 
Make sure that you restart the system unit after MSM installation. 

MSM installation with the client format is completed. 
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Uninstallation 

This subsection explains the MSM uninstallation procedure. 

Use this procedure also for uninstallation from a management PC. 

Uninstalling the Windows edition 
 
 

 
MSM has its own uninstallation module. 
Use this uninstallation module instead of a general application removal 
utility.  
Before you start uninstallation of MSM, close the MSM Client 
(including remote connections). Close other applications as well. 
The pop-up message shown below may be displayed. 
Click [Abort] when this pop-up is displayed. 
Then close all applications and retry. 

 

1. Start Windows and logon as Administrator. 

2. For Windows Server 2012, select All apps after pressing Windows Logo 
key and Space key in this order. And select MegaRAID Storage 
Manager > Uninstall. 
For OS's other than Windows Server 2012, click Start > All Programs* > 
MegaRAID Storage Manager > Uninstall. 

* In the classic Start menu, click Programs. 

     
Windows Server 2012          OS's other than Windows Server 2012 
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3. The uninstallation start window opens. Click Yes. 

 
 

 
Before you start uninstallation of MSM, close the MSM Client 
(including remote connections). Close other applications as well. 
The pop-up message shown below may be displayed. 
Click [Abort] when this pop-up is displayed. 
Then close all applications and retry. 

 

4. Uninstallation starts. 

The dialog box closes when the uninstallation is completed. 

 
 

 
After the dialog box closes, the following pop-up massage may be 
displayed asking you to restart the system. Select No in such cases. 
(Do not restart the system at this point.) 
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5. After step 4, check if the MSM installation directory still remains. 

The default installation destinations are as follows: 

• 64bit OS: 

C:\Program Files (x86)\MegaRAID Storage Manager 

• 32bit OS: 

C:\Program Files\MegaRAID Storage Manager 

If any of the above directories remains, remove it manually. 

If you cannot remove it, restart the system unit and retry. 

Uninstallation of the Windows edition of MSM is completed. Restart the 
system unit. 

 

 
Make sure that you restart the system unit after MSM removal. 
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Uninstalling the Linux edition 
 

 
If the MSM SNMP module has been installed on Red Hat Enterprise 
Linux 6, perform the following procedure at the time of MSM 
uninstallation. If you do not perform it, the MSM SNMP module 
becomes unable to be removed. 
- Enable the run level of snmpd of Linux. 

# chkconfig snmpd on 
- Reboot the system unit. 
- Uninstall MSM according to the procedure in this section. 
- Disable the run level of snmpd of Linux. 

# chkconfig snmpd off 
- Reboot the system unit. 

 

 
Before you start uninstallation of MSM, close the MSM Client 
(including remote connections). Close other applications as well. 
If MSM is running, MSM uninstallation cannot be performed. 

1. Start Linux, and log on as root. 

2. Start X Windows. 

# startx 

3. Click Application > System Tools > Uninstall MegaRAID Storage 
Manager in the GUI menu. 

 
 

 
Before you start uninstallation of MSM, close the MSM Client 
(including remote connections). Close other applications as well. 
MSM sometimes cannot be uninstalled. In such a case, close all 
applications and retry. 
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4. Uninstallation starts. 

Uninstallation completes in about a minute. Check Application > System 
Tools again. If Uninstall MegaRAID Storage Manager has been 
deleted, uninstallation is completed. If not deleted after you wait several 
minutes, use the command line as explained in the Tip below. 

 

 
MSM can be uninstalled from the command line. 
Move to the MSM installation directory, and execute the following 
command: 

# ./uninstaller.sh 
 
Before you execute the above command, close the MSM Client 
(including remote connections). Close other applications as well. MSM 
sometimes cannot be uninstalled with the message below. 
In such a case, close all applications and retry. 
MegaRAID Storage Manager is running. Please shutdown the 
process and retry.  
Error: %preun (MegaRAID_Storage_Manager-xxxxxx.noarch) 
scriptlet failed. Exit status 1 
(* "x" varies depending on the MSM version.) 

5. Uninstall the command line programs. 

Enter the following command: 

# rpm -ev MegaCli 

The command is completed if the MegaRAID folder under #/opt has been 
deleted. 

If the MegaRAID directory remains after execution of the above command, 
remove it manually. 

6. Uninstall the utility library programs. 

Enter the following command: 

# rpm -ev Lib_Utils-xxx-xxx.noarch .... (Note 1) (Note 2) (Note 3) 

# rpm -ev Lib_Utils2-xxx-xxx.noarch ... (Note 1) (Note 2) (Note 3) 
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The command is completed if the lsi folder under #/opt has been deleted. 

If the lsi directory remains after execution of the above command, remove 
it manually. 

Note 1: They are the same as the file names created under the disk 
directory expanded at the time of Linux installation. However, rpm 
is not required. 

Note 2: These utility programs are not installed for Ver.3.04-08 or earlier. 

Note 3: The following command displays utility programs currently 
installed: 
  # rpm -qa Lib_Utils* 

 

Uninstallation of the Linux edition MSM is completed. Restart the system 
unit. 

 

 
Make sure that you restart the system unit after MSM uninstallation. 
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Activating MegaRAID Storage Manager 

This section explains how to activate, log in, and exit MSM. 
 

 
To be enough time whenever you start MSM after system unit 
activation. 
Services MrMonitor and MrMonitor monitoring are not installed in MSM 
Ver.11.08.XX.XX or later. Therefore, the following events recorded in 
the OS event log just after OS boot will not be collected. 
 
[Windows OS, Linux OS] 

Monitor has started successfully 
[Only Windows] 

service monitor has started successfully 

Activating MSM 

1. Activate MSM in the following procedure: 

• For Windows 

For Windows Server 2012, select All apps after pressing Windows 
Logo key and Space key in this order. And select MegaRAID Storage 
Manager > StartupUI. 

For OS's other than Windows Server 2012, click Start > All 
Programs* > MegaRAID Storage Manager > StartupUI. 

* In the classic Start menu, click Programs. 
 

 
 

  
Windows Server 2012 OS's other than Windows Server 2012 
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You can start MSM also by double-clicking the MegaRAID Storage 
Manager icon on the desktop. 

 
• For Linux 

With X Window running, click Application > System Tools > 
MegaRAID Storage Manager StartupUI. 

 

2. The server selection window opens. 

Select and double-click a server displayed in the Remote servers window, 
or select the server and click Login. 
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If the system unit is not connected to LAN, the Remote servers 
window is blank. 
In this case, the window shown below opens. 
To log in the local server, enter "127.0.0.1" in IP Address and click 
Discover Host. Servers are displayed in the Remote servers 
window. Select and double-click a server, or select the server and click 
Login. 

 
Windows Server 2012 is indicated as "Windows NT(unknown)" in the 
Operating System pane of this dialog box. 

3. The login window opens. 

Enter your user name and password in the User Name and Password 
fields, and click Login. 
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Only one user can logon a managed server at a time with Login Mode 
set to Full Access. Simultaneous log on a managed server with Full 
Access is not allowed. 
When you logon the server with Login Mode of Full Access, you have 
to use the user name and password of the administrator account 
(Windows: Administrator, Linux: root). 

4. The main window opens. 
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Starting MSM (for remote connection) 

This section explains the case when MSM has been installed in the complete 
format 

1. Activate MSM in the following procedure: 

• For Windows 

For Windows Server 2012, select All apps after pressing Windows 
Logo key and Space key in this order. And select MegaRAID Storage 
Manager > StartupUI. 

For OS's other than Windows Server 2012, click Start > All 
Programs* > MegaRAID Storage Manager > StartupUI. 

* In the classic Start menu, click Programs. 
 

 
 

  
Windows Server 2012 OS's other than Windows Server 2012 

You can start MSM also by double-clicking the MegaRAID Storage 
Manager icon on the desktop. 
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• For Linux 

With X Window running, click Application > System Tool > 
MegaRAID Storage Manager StartupUI. 

 

2. The server selection window opens. 

In the IP Address entry field, enter the IP address of the server to be 
started (192.168.1.2, for example), and click Discover Host. 
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3. The server selection window opens. 

The server specified in step 2 is displayed in Remote servers. Select and 
double-click the server, or select the server and click Login. 

 
 

 
Windows Server 2012 is indicated as "Windows NT(unknown)" in the 
Operating System pane of this dialog box. 

4. The login window opens. 

Enter your user name and password in the User Name and Password 
fields, and click Login. 

 
 

 
Only one user can logon a managed server at a time with Login Mode 
set to Full Access. Simultaneous log on a managed server with Full 
Access is not allowed. 
When you logon the server with Login Mode of Full Access, you have 
to use the user name and password of the administrator account 
(Windows: Administrator, Linux: root). 
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5. The main window opens. 

 

6. You can log on a multiple server by repeating step 2 above. 
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Displaying multiple connected servers 

This section explains the case where multiple remote servers are connected 
(installed in the complete format). 

1. Activate MSM in the following procedure: 

• For Windows 

For Windows Server 2012, select All apps after pressing Windows 
Logo key and Space key in this order. And select MegaRAID Storage 
Manager > StartupUI. 

For OS's other than Windows Server 2012, click Start > All 
Programs* > MegaRAID Storage Manager > StartupUI. 

* In the classic Start menu, click Programs. 
 

 
 

  
Windows Server 2012 OS's other than Windows Server 2012 

You can start MSM also by double-clicking the MegaRAID Storage 
Manager icon on the desktop. 
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• For Linux 

With X Window running, click Application > System Tool > 
MegaRAID Storage Manager StartupUI. 

 

2. The server selection window opens. 

Click Configure Host. 

 
 

 
Windows Server 2012 is indicated as "Windows NT(unknown)" in the 
Operating System pane of this dialog box. 
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3. The Configure Host window opens. 

Select Display all the systems in the network of local server., and 
click Save Settings. 

 

4. The Confirmation pop-up message is displayed. 

Click Yes. 

The connected servers are searched for. 

 

5. The server selection window opens. 

All the connected servers are displayed in the Remote servers list. 

 

 



 MegaRAID Storage Manager 2-67 

MegaRAID Storage Manager Instruction Manual 

Switching servers to be displayed (for remote connection) 
 

 
Manage > Server cannot be used. Do not use this method.  
To switch server to be displayed, close MSM and perform the 
procedure "Starting MSM (for remote connection)" on page 2-60. 

1. In the main window, select Server from the Manage menu. 

 

2. The server selection window opens. 

Select and double-click the server to logon (to start), or select the server 
and click Login. 

 
 

 
Windows Server 2012 is indicated as "Windows NT(unknown)" in the 
Operating System pane of this dialog box. 
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3. A switch warning pop-up massage is displayed. 

Select Confirm, and click Yes. 

 

4. The login window opens. 

Enter your user name and password in the User Name and Password 
fields, and click Login. 

 
 

 
Only one user can logon a managed server at a time with Login Mode 
set to Full Access. Simultaneous log on a managed server with Full 
Access is not allowed. 
When you logon the server with Login Mode of Full Access, you have 
to use the user name and password of the administrator account 
(Windows: Administrator, Linux: root). 
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5. The main window of the selected server is displayed. 
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Exiting MegaRAID Storage Manager 

This section explains how to exit MSM. 

1. Click  at the upper right corner of the window, or select Exit from the 
Manage menu. You can also click Log Off. (Note 1) 

 
Note 1: When you click Log Off in Dashboard, the following pop-up 

massage is displayed. 
Click Yes. 

(Then the server selection window opens again. Click  at the 
upper-right corner.) 
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Initialization 

Initialize the system unit in accordance with its operation form. 

The table below lists the setting items. 
 

Setting item Description Reference 
pages 

Exception setting of network 
security 

Sets a network security exception for MSM. 2-161 

Event notification setting Sets the conditions for event notifications for disk 
array events. 

2-171 

Patrol Read setting* Configures Patrol Read, which runs in the background. 2-179 

Hot spare setting* If a hot spare physical drive has been included in the 
purchased system unit, the hot spare is configured as 
a global hot spare at the time of shipment. 

Change the setting to a dedicated hot spare as 
necessary. 

2-125 

* These cannot be used depending on the disk array controller type (including LSI Software RAID). 
These cannot be used depending on the number of the maximum mark of the physical drive which 
can be carried in a system unit. 

For setting details, see the page referenced in the table above. 
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Screen configuration and descriptions of MegaRAID 
Storage Manager 

The MSM main window configuration is described below. 

 

A Menu bar 
Lists five menus: Manage, Go To, Log, Tools, and Help. 

B Menu bar (graphical) 
Lists six menus: Server, Refresh, Group show progress, Create 
Virtual Drive, Exit, and Help. 

C Log Off 
Exits MSM. 

D Tabs 
Switches between the Dashboard, Physical, and Logical views. 

E Configuration information 
Displays the RAID (Dashboard), Physical, and Logical configuration 
information. 

F Message window 
Displays an event log. 

A 
B 

C 

D 

B 

E 

F 
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When you logon with Login Mode of View Only, the menu bar shows 
Manage, Log, and Help only. 

Menus 

The MSM menu items are described below. 

Manage: Manager menu 

 
 

Menu item Description 

Refresh          F5 Refreshes the controller and connected devices. 

Server Switches the displayed server. (Not supported) 

Check Consistency Performs a consistency check. 

Initialize Performs initialization. 

Show Progress Displays the status of running tasks (initialization of a virtual drive, rebuild, 
consistency check, and capacity expansion). 

Exit Exits MSM. 

Go To: Execution menu 

The Go To menu shows different menu items depending on the selected 
device (controller, physical drive, or virtual drive) in the Physical view or the 
Logical view. 

You can also display some of the operation menu items by right-clicking a 
target device. 
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• Main view 

 
 

Menu item Description 

Controller Menu for RAID controller 

Drive Group Menu for expansion of the virtual drive capacity 

Physical Drive Menu for physical drives 

Virtual Drive Menu for virtual drives 

BBU Menu for battery functions 

 
 

Replacing or deleting the configuration data during disk array operation will 
erase all data of virtual drives that have been configured. Be careful during 
operation. 

 

• When Controller is selected in the Physical view or the Logical view 

 
 

Menu item Description 

Create Virtual Drive Structures a new virtual drive 

Enable Alarm/Disable Alarm* Configures the buzzer alarm (switching between 
Enable and Disable). 

Start Patrol Read Starts Patrol Read. 

Set Patrol Read Properties Sets the processing method of Patrol Read. 

Enable SSD Guard* Configures SSD GuardTM. (Default: Disable) 

Scan Foreign Configuration* Reads configuration information from a physical drive 
and sets it again. 

Load Configuration Replaces the current configuration information with file 
content. 



 MegaRAID Storage Manager 2-75 

MegaRAID Storage Manager Instruction Manual 

Menu item Description 

Save Configuration Saves configuration information. 

Clear Configuration Deletes configuration information. 

Set Consistency Check Properties* Sets the consistency check processing method. 

Set Adjustable Task Rates Sets the rates of various tasks. 

Manage Power Save Settings* Sets the power-saving mode of physical drives. 

Update Controller Firmware* Updates the firmware of the disk array controller. 

Manage MegaRAID Advanced 
Software Options* 

Displays the advanced software options for MegaRAID. 

Manage Link Speed* Sets the transmission speed of a virtual drive. 

Save TTY Log Saves the TTY log of the disk array controller. 

* These menus may not be displayed depending on the disk array controller type (including LSI 
Software RAID). 

 

 
Do not use Load Configuration, Clear Configuration, or Scan 
Foreign Configuration. All data on the drive will be erased by 
replacing or deleting configuration data. 
Manage Power Save Settings, Manage MegaRAID Advanced 
Software Options, Manage Link Speed, and Save TTY Log are not 
supported. 

 

• When Drive Group is selected in the Logical view 

 
 

Menu item Description 

Modify Drive Group* Menu for expansion of the virtual drive capacity 

Manage Power Save Settings* Sets power-saving mode of virtual drives 

* These menus may not be displayed depending on the disk array controller type (including 
LSI Software RAID). 
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• When Physical Drive is selected in the Physical or Logical view (When a 
physical drive included in a virtual drive is selected) 

 
 

Menu item Description 

Make Drive Offline /  

Make Drive Online 

Sets a physical drive to on-line or off-line. 

(Switching between on-line and off-line) 

Start Locating Drive Makes the LED of a physical drive blink. 

Stop Locating Drive Stops blinking the LED of a physical drive. 

 

 
Do not use Make Drive Offline. Otherwise, a normal physical drive 
will be registered as an error, and isolated from the disk array. 
Do not use Make Drive Online. Otherwise, the generation of a parity 
and mirror data will be started automatically, thus losing all data on 
the disk array. 

 

 
The menu items Start Locating Drive and Stop Locating Drive are 
not supported for LSI Software RAID. 

 

• When Physical Drive is selected in the Physical or Logical view (When a 
physical drive configured as a hot spare is selected) 

 
 

Menu item Description 

Remove Hot Spare Release a hot spare. 

Start Locating Drive Makes the LED of a physical drive blink. 

Stop Locating Drive Stops blinking the LED of a physical drive. 

 

 
The menu items Start Locating Drive and Stop Locating Drive are 
not supported for LSI Software RAID. 
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• When Physical Drive is selected in the Physical view  
(when an unused physical drive is selected) 

      
 

Menu item Description 

Assign Global Hot Spare Sets a physical drive as a global hot spare drive. 

Assign Dedicated Hot Spare Sets a physical drive as a dedicated hot spare drive. 

Start Locating Drive Makes the LED of a physical drive blink. 

Stop Locating Drive Stops blinking the LED of a physical drive. 

Prepare for Removal Sets a physical drive off-line, and stops the motor. 

Undo Prepare for Removal Starts the motor of a physical drive that has been set off-line 
by Prepare for Removal so that the drive can be used. 

Drive Erase* Executes the Drive Erase function for a physical drive. 

* These menus may not be displayed depending on the disk array controller type (including LSI 
Software RAID). 

 

 
Do not use Prepare for Removal, Undo Prepare for Removal, or 
Drive Erase. Only one of Prepare for Removal or Undo Prepare 
for Removal is displayed depending on the current setting. 
For hot spare setting, see "Configuring a hot spare" on page 2-125. 

 

 
The menu items Start Locating Drive and Stop Locating Drive are 
not supported for LSI Software RAID. 
The menu items Prepare for Removal and Undo Prepare for 
Removal are not displayed. 

 



2-78 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

• When Virtual Drive is selected in the Logical view 

 
 

Menu item Description 

Rename Virtual Drive Renames a virtual drive. 

Delete Virtual Drive Deletes a virtual drive. 

Set Virtual Drive Properties Changes the setting of a virtual drive. 

Start Locating Virtual Drive Makes the LED of a virtual drive blink. 

Stop Locating Virtual Drive Stops blinking the LED of a virtual drive. 

Start Consistency Check Performs a consistency check. 

Start Initialization Performs initialization. 

Expand Expands the capacity of a virtual drive. 

Virtual Drive Erase* Executes the Drive Erase function for a virtual drive. 

* These menus may not be displayed depending on the disk array controller type (including LSI 
Software RAID). 

 

 
Virtual Drive Erase is not supported. 
The menu item Expand is displayed only when there is a virtual drive 
that has not exhausted the capacity of the drive group. This item is not 
supported. 

 

 
The menu items Start Locating Virtual Drive and Stop Locating 
Virtual Drive are not supported for LSI Software RAID. 
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• When BBU is selected in the Physical view 

 
 

Menu item Description 

Refresh Properties Updates the property of the cache backup module. 

Start Learn Cycle Performs diagnosis (Learn Cycle). 

Set Learn Cycle Properties Changes the setting of diagnosis (Learn Cycle). 

 

 
This item is displayed only for disk array controllers (with cache 
backup) 
Set Learn Cycle Properties is not supported. Avoid its use. Use the 
auto diagnosis with the default setting (Enable). 

 

 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 
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Log: Log menu 

        
 

Menu item Description 

Save Saves an event log. 

Save as Text Saves an event log in the text format. 

Clear Deletes an event log. 

Load Opens a saved event log. 

Rollback to Current Log Closes Load, and displays the latest event. 
(This item is added to the menu when Load is clicked.) 

 

 
Do not use Clear. Otherwise, fault analysis may be affected. 

 

Tools: Tool menu 

 
 

Menu item Description 

Monitor Configure Alerts Displays the event notification setting window. 

 

Help: Help menu 

 
 

Menu item Description 

Contents Displays help. 

About MegaRAID Storage Manager Displays MSM version information. 

 Server Info Displays server details. 
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Window icons 
 

Menu item Description 

 
Represents a server. 

 
Represents a disk array controller. 

 
Represents a port of a disk array controller. 

 Represents an enclosure device. 

 Represents a virtual drive group. 

 
Represents a virtual drive. 

 
Represents a RAID group. 

 
Represents a physical drive. 

 
Represents a global hot spare drive. 

 
Represents a dedicated hot spare drive. 

 
Represent a physical drive being rebuilt. 

 
Represents degradation of a virtual drive. 

 
Represents a device failure. 

 Represents a drive that was once used. 

 Represents a cache backup module. 

 

 
The menu item Enclosure is not displayed for LSI Software RAID. 
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Functions of MegaRAID Storage Manager 

This section explains MSM functions. 

The following table lists the major MSM functions: 
 

Function Description Reference 
pages 

Display of properties Configures the properties (detailed information) of 
devices such as physical drives and virtual drives. 

2-85 

Creating new virtual 
drive(s)*1 

Structures new virtual drive(s). 2-99 

Changing the setting of 
virtual drive(s)*1 

Changes the setting of virtual drive(s). 2-113 

Initialize of virtual drive(s)*1 Initializes virtual drive(s). 2-116 

Consistency check of virtual 
drive(s) 

Checks the consistency of virtual drive(s) of 
redundant configuration. 

2-118 

Configuration a hot spare*1 Creates and deletes a global hot spare or a dedicated 
hot spare. 

2-125 

Expanding virtual drive 
capacity*1 

Expands the capacity by adding a new physical drive 
to the existing virtual drive. 

2-135 

Deleting virtual drive(s)*1 Deletes virtual drive(s). 2-139 

Changing write cache*1 Changes the cache setting of the disk array controller. 
There is restriction in write cache change. Make sure 
that you read the precaution in the page of the 
detailed description. 

2-140 

Blinking LEDs*1 Makes LED of each physical drive blink. 2-143 

Diagnosing cache back 
module (BBU)*1 *2 

Diagnoses the cache back module (BBU). 2-145 

Enabling and disabling 
SMART copyback*1 

Changes the enable/disable setting of SMART 
copyback. 

* This function is configured with MegaCli. 

2-148 

Rescan Rescans a device. 2-153 

Event reference References various events that occur in the disk 
array. 

2-153 

Displaying task progress and 
terminating tasks 

Displays the progress of running tasks such as rebuild 
and consistency check, and stops tasks. 

2-157 

Updating firmware Updates the firmware of the disk array controller. 
Firmware update is not supported. 

Do not execute the following: 

[Firmware update] 

  Go To > Controller > Update Controller 
Firmware 

- 

Setting network security 
exceptions 

Sets a network security exception for MSM. 2-161 

Setting an event notification Sets the conditions for event notifications for disk 
array events. 

2-171 
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Function Description Reference 
pages 

Setting patrol Read*1 Configures Patrol Read, which runs in the background. 2-179 

Task rate setting Sets the rates of various tasks. 

Task rate setting is not supported. 

Do not execute the following: 

[Task rate setting] 

Go To > Controller > Set Adjustable Task 
Rates 

*Always set the task rate to the default value (30%) 

- 

Setting of power-saving 
mode of physical drives 

Sets the power-saving mode of physical drives. 

The power-saving mode setting for physical 
drives is not supported. 

Do not execute the following: 

[Setting of power-saving mode of physical 
drives] 

Go To > Controller > Manage Power Save 
Settings 

- 

Setting of the consistency 
check schedule 

Sets a consistency check schedule. 

Make sure that you apply this setting for LSI Software 
RAID. 

For a RAID device other than LSI Software RAID, this 
setting is not required because Patrol Read runs 
periodically. 

*This function is configured by MegaCli. 

2-120 

Setting of the consistency 
check processing method 

Sets a consistency check processing method. 

Setting of the consistency check method is not 
supported. 

Do not execute the following: 

[Setting of the consistency check processing 
method] 

Go To > Controller > Set Consistency Check 
Properties 

- 

SSD GuardTM Configures SSD GuardTM. [Default: Disable] 

SSD GuardTM is not supported. 

Do not execute the following: 

[SSD GuardTM setting] 

Go To > Controller > Enable SSD Guard 

, or 

Go To > Controller > Disable SSD Guard 

- 

Buzzer setting of the disk 
array controller 

Configures the buzzer of the disk array controller. 

Buzzer setting of disk array controllers is not 
supported. 

Do not execute the following: 

[Buzzer setting of the disk array controller] 

Go To > Controller > Enable Alarm 

, or 

Go To > Controller > Disable Alarm 

- 
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Function Description Reference 
pages 

Restrictions 

Precautions 

Explains restrictions and precautions on use of MSM. 2-184 and 
2-187 

*1: These cannot be used depending on the disk array controller type (including LSI Software 
RAID). 
These cannot be used depending on the number of the maximum mark of the physical drive 
which can be carried in a system unit. 

*2: This function can be used only for disk array controllers (with cache backup). To check if the 
device is a disk array controller (with cache backup), check BBU Present of "Controller" on 
page 2-88. If the value is Yes, the device is a disk array controller (with cache backup). 

Details of each function are explained in the pages that follow. 
 

 
Firmware update, task rate setting, setting of power-saving mode of 
physical drives, setting of the consistency check processing method, 
SSD Guard, and buzzer setting of the disk array controller are not 
supported. 
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Display of properties 

This function enables you to reference the properties of devices that are 
displayed in the Physical view and Logical view of the main window. 

The default view is the Dashboard view. You can switch between Physical 
and Logical views by operating the respective tab. 

The Dashboard view displays the overall properties of the target RAID. 

 
 

 
Do not use menu items other than Properties > View server profile 
and Background Operations > More details. 

In addition to the content displayed in the Physical view, the Logical view 
displays information on the status of the logical drives built. 
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Click the target device to display its properties. 

• Physical view 

 

• Logical view 
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Properties of each drive are as follows: 

Server 

This screen displays the installation OS, the host name, the IP address, and 
other information of the servers. 

 
 

Property Description 

Host Name  Host name of the server 

IP Address IP address of the server 

Operating System Operating system (OS) installed in the server 

OS Version Version of the OS installed in the server 

OS Architecture Architecture of the OS installed in the server 

 

 
In Windows Server 2012, Operating System is displayed as 
"Windows NT(unknown)". 



2-88 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

Controller 

Displays the BIOS version and the firmware version of the disk array controller. 

 
 

Property item Description 

Product Name Vender's name of the disk array controller board 

Serial No Serial number of the disk array controller board 

Vendor ID Vendor ID of the disk array controller board 

SubVender ID Sub-vendor ID of the disk array controller board 

Device ID Device ID of the disk array controller board 

Device Port Count Number of the SAS ports of the disk array controller board 

Host Interface Host interface of the disk array controller board 

Metadata Size Meta data size of the disk array controller board 

Host Port Count Number of the host ports of the disk array controller board 

FRU Customer-replaceable component number 

* FRU is not supported. 

Alarm Present Implementation status of the buzzer alarm 

Alarm Enabled*1 Enabled/disabled status of the buzzer alarm 

Cache Flush Interval Interval of cache memory flush 

Coercion Mode Capacity control setting of physical drives 
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Property item Description 

BBU Present Implementation status of cache backup module 

NVRAM Present Implementation status of NVRAM 

NVRAM Size*1 Size of NVRAM 

BIOS Version*1 BIOS version of disk array controller board 

Native Command Queuing Enabled/disabled status of command queuing 

Flash Size*1 Flash memory capacity of disk array controller board 

Memory Size*1 Cache memory capacity 

Chip Temperature*1 Temperature of disk array controller 

Shield State Support Diagnosis of the physical drives of disk array controller. 

This function is disabled regardless of the setting. 

Power savings on 
unconfigured drives 

Power-saving mode of unused physical drives 

Power saving on hot spares Power-saving mode setting of physical drives configured as hot 
spares 

Power Save Policy for 
Configured Drives*1 

Power-saving mode setting of physical drives configured for virtual 
drives 

Firmware Package Version Firmware package version of disk array controller board 

Firmware Version*1 Firmware version of disk array controller board 

Firmware Build Time*1 Time stamp of firmware of disk array controller board 

Backend SAS Address 0 to 7 Back-end address of SAS device 

Correctable Error Count*1 Number of errors that can be corrected 

Memory uncorrectable 
count*1 

Number of errors for which memory correction is disabled 

Cluster Enable Cluster setting 

Cluster Active Cluster operation status 

SSD Guard Setting of SSD GuardTM 

SSD Disk Cache Setting Setting of SSD cache 

Drive security capable Enabling/disabling of encryption 

Rebuild Rate Priority of rebuild processing 

Patrol Read Rate*1 Priority of Patrol Read processing 

Reconstruction Rate*1 Priority of disk array configuration processing such as capacity 
expansion 

BGI Rate Priority of background processing 

Consistency Check Rate Priority of consistency check 

Global Hotspare for 
Emergency*1 

Availability of rebuild of a physical drive (global hot spare) of a 
different type (Not supported) 

Unconfigured Good for 
Emergency*1 

Availability of rebuild of a physical drive (not used) of a different 
type (Not supported) 

Emergency for SMARTer*1 Availability of SMART copyback of a physical drive (hot spare) of a 
different type (Not supported) 

*1: These menus may not be displayed depending on the disk array controller type (including LSI 
Software RAID). 
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Physical drive 

Displays physical drive properties such as vendor name, device ID, and status. 

 
 

Property item Description 

Usable Capacity Configured capacity of a physical drive 

Raw Capacity Raw data size of a physical drive 

Certified*1 Device recognition function (not supported) 

Product ID Product name of a physical drive 

Vendor ID Vendor name of a physical drive 

Device ID Device ID of a physical drive 
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Property item Description 

Status Status of a physical drive including the following: 

Online: Operating normally 

Failed: 

Failed and detached from the disk array. 
The disk array controller detached the physical drive due to its 
fault. 

Offline: 

Failed and detached from the disk array. 
The physical drive is detached from the disk array because the 
user registered a fault. 

Unconfigured Bad: 

Failed and detached from the disk array. Inconsistency has 
been identified in the disk array configuration data.  
This happens, for example, when you insert a physical drive 
that has been used. 

Rebuild: Being rebuilt 

Unconfigured Good: The physical drive is not used. 

Hot Spare: 

The physical drive is configured as a hot spare (global or 
dedicated). 

being replaced with <copy destination hot spare>: 

SMART copyback is running, copying data from this physical 
drive, on which SMART error occurs, to the copy destination hot 
spare. 
The physical drive becomes Unconfigured Bad when the 
SMART copyback finishes. 

replacing <copy source physical drive>: 

SMART copyback is running, copying data from the drive on 
which SMART error occurs to this hot spare. 
This hot spare becomes Online when the SMART copyback 
finishes. 

Drive Type*1 Type of a physical drive 

Drive Speed Transmission speed of a physical drive 

Negotiated Link Speed Negotiated link speed for data transmission of a physical drive 

SCSI Device Type SCSI device type 

SAS Address x*2 SAS address 

Temperature*1 Temperature of a physical drive 

Commissioned Hotspare*1, *3 (Not supported) 

Power Status*3 Power status of a physical drive 

Emergency Hotspare*1, *3 Availability of the hot spare functionality for a virtual drive made up 
of physical drives of different types 

Revision Level Revision level of a physical drive 

Media Error Count Number of media errors of a physical drive 

Pred Fail Count Number of received SMART reports 

Enclosure ID*2 Enclosure ID 

Enclosure Model*2 Model of an enclosure 

Enclosure Location*2 Location of an enclosure 
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Property item Description 

Connector*2 Group of physical ports to which a physical drive is connected 

Slot Number Slot number on which a physical drive is mounted 

Full Disk Encryption capable Availability setting of encryption for a physical drive 

Secured*1, *2 Encryption function of a physical drive (not supported) 

Type*1, *2 Device type of a physical drive 

Data Protection Encryption function of a physical drive (not supported) 

*1: This item is not displayed depending on a type of a connected physical drive. 

*2: This item is not displayed for LSI Software RAID. 

*3: This item is not displayed depending on the status of a physical drive. 

 

 
Media Error Count and Pred Fail Count are initialized when the 
power is switched on or off, or when the system unit is restarted. 

 

 
The number displayed in " " (Physical Drive x) does not 
coincide with Device ID. 
Device ID and Slot Number do not coincide. Slot Number is 
recorded in the MSM log. 
For a system unit with SATA physical drive installed, the following 
message may be displayed when you click a physical drive icon on 
MSM. The message does not indicate a problem and you can ignore it. 
 
Controller ID X: Unexpected sense: PD = X - Invalid field in 
CDB, 
CDB = 0x4d 0x00 0x4d 0x00 0x00 0x00 0x00 0x00 0x20 0x00 , 
Sense = 0x70 0x00 0x05 0x00 0x00 0x00 0x00 0x0a 0x00 0x00 0x00 
        0x00 0x24 0x00 0x00 0x00 0x00 0x00 
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Virtual drive 

Displays information on the configuration of a virtual drive. 

 
 

Property item Description 

RAID Level RAID level of a virtual drive 

Name*1 Volume name of a virtual drive 

Size Capacity of a virtual drive 

Mirror Data Size Mirroring size of a virtual drive (displayed only for RAID1 and 
RAID10) 

Parity Size Parity size of a virtual drive (displayed only for RAID5 and RAID6) 

Stripe Size Stripe size of a virtual drive 

Virtual Disk State The operating status of a virtual drive including the following: 

Optimal: Operating normally 

Degraded: 

The virtual drive is degraded. One physical drive (two physical 
drives for RAID6) of the virtual drive has failed. Or it is being 
rebuilt. 

Partially Degraded: 

Partially degraded. One physical drive of the RAID6 virtual drive 
has failed. Or it is being rebuilt. 

This item is displayed only for RAID6. 

Offline: 

The virtual drive is inoperable. Multiple physical drives of the 
virtual drive have failed, or a physical drive of a non-redundant 
virtual drive has failed. 

Disk Cache Policy Cache policy of a physical drive 

Read Policy Read policy of a virtual drive 

IO Policy Data input and output policy of a virtual drive 
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Property item Description 

Current Write Policy*2 Current write policy of a virtual drive 

(1) When Default Write Policy = "Write Through": Always "Write 
Through"  

(2) When Default Write Policy = "Always Write Back": Always 
"Write Back"  

(3) When Default Write Policy = "Write Back with BBU": "Write 
Back" or "Write Through" 

Default Write Policy Default write policy of the configured virtual drive 

Current Access Policy Data access policy of the current virtual drive 

Default Access Policy Data access policy of the configured virtual drive 

Default Power save policy*3 Power-saving mode setting of the configured physical drive 

Current Power save policy*3 Power-saving mode of the current physical drives 

*1: This item is not displayed for a virtual drive configured with MegaRAID WebBIOS. 

*2: The following display and operation are made when Default Write Policy = "Write Back with 
BBU": 

- The value is changed to "Write Trough" for a RAID not supporting BBU.  
At this time, "Reason for difference in write policy": "BBU is not installed" is displayed. 

- The value is changed to "Write Trough" when the capacity is being expanded. 
At this time, "Reason for difference in write policy": "Reconstruction is in progress" is 
displayed. 

*3: These items may not be displayed depending on the disk array controller type (including LSI 
Software RAID). 

 

 
The number displayed in " " (Physical Drive x) does not 
coincide with Device ID. 
When the entire capacity of a drive group is not used, Total Free 
Capacity is displayed. In this case, you can construct an additional 
virtual drive on the drive group. 
The RAID level that can be used is the one currently constructed in the 
drive group. 
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Enclosure 

Displays enclosure information. 

 
 

Property item Description 

Vendor ID Vendor name of an enclosure 

Enclosure ID ID of an enclosure 

Serial Number Serial number of an enclosure 

Enclosure Model Model of an enclosure 

Enclosure Location Location of an enclosure 

 

 
No enclosure device is displayed for LSI Software RAID 
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Enclosure (for expansion) 

Displays information on an extension enclosure. 

 
 

Property item Description 

Vendor ID Vendor name of an enclosure 

Enclosure ID ID of an enclosure 

Serial Number Serial number of an enclosure 

Enclosure Model Model of an enclosure 

Enclosure Location Location of an enclosure 

Connector Connector of an enclosure 

Number of Slots Number of slots 

Product Revision Level Revision level of the product 

Number of Fans Number of fans 

Number of Power Supplies Number of power sources 

Number of Voltage Sensors Number voltage sensors 

 

 
No enclosure device is displayed for LSI Software RAID. 
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Displays graphical information on an extension enclosure. 

 
 

 
Information is not displayed on a real-time basis. Execute a rescan 
when an incident occurs. For how to rescan, see "Rescan" on page 2-
153. 
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Cache back module (BBU) 

Displays information on the cache backup module (BBU) 

 
 

Property item Description 

BBU Battery Type Battery type 

Full Capacity Maximum electric capacity 

Remaining Capacity Remaining electric capacity 

Temperature Environment temperature 

Voltage Charging voltage 

Current Electric current 

Capacitance Capacitance 

Automatic Learn Cycles Automatic diagnosis setting 

Auto Learn Period Automatic diagnosis interval (fixed number of days) 

Next Learn Cycle Date and time of the next automatic diagnosis 

It is 28 days after the last diagnosis. 

Battery State Battery state 

Battery Replacement Necessity of battery replacement (Not supported) 

Battery Predictive Failure Necessity of battery replacement as a preventive action (Not 
supported) 

 

 
This item is displayed only for disk array controllers (with cache 
backup). 

 

 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 
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Creating new virtual drives 

This section explains how to create a new virtual drive. 
 

 
LSI Software RAID supports creation of virtual drives of only RAID0 
and RAID1. 
The maximum number of virtual drives created for each disk array 
controller is 24. 
The maximum number of virtual drives created for each drive group is 
16. 
MSM does not support creation of a virtual drive that includes both 
HDD and SSD. 
If all of the following conditions are met, the entire capacity of a drive 
group may not be used. In such a case, a total free capacity of 2 MB or 
less remains. 

 There are 1 or more virtual drives in the drive group. 
 The remaining capacity of the drive group is 1 TB or more. 
 When you try to use all the remaining capacity to create a 

virtual drive 

The following table shows the number of physical drives required for creating 
virtual drives of different RAID levels. 
However, you cannot configure virtual drive more than maximum number of 
physical drive in the system unit. 

 
RAID level Number of physical drives required 

RAID0 at least 1 unit 

RAID1 2 units 

RAID5 at least 3 units 

RAID6 at least 4 units 

RAID10 at least 4 units, a maximum of 16 units 

 

 
To configure a hot spare, you need a separate physical drive in 
addition to physical drives required for each RAID level. You cannot 
configure a hot spare for RAID0. 

There are two virtual drive configuration options: Simple and Advanced. Use 
only Advanced. 

The overview of these options is as follow: 

• Advanced: 

You can make only virtual drive configuration for any purpose. Select this 
option when you want to specify a physical drive to build or the capacity of 
a virtual drive. 
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• Simple: 

This option allows you to interactively and easily configure a currently 
configurable virtual drive for any purpose. You can specify the RAID level 
and creation of a hot spare. 

 

 
Do not create a virtual drive with the Simple option. 
Do not create a new virtual drive when a task such as rebuilding is 
running. 
MSM does not support a RAID6 configuration with 3 physical drives. 
Avoid such a configuration. 
MSM does not support a RAID1 configuration with 3 or more physical 
drives. Avoid such a configuration. 
A RAID10 configuration must have 4 or more even-number physical 
drives. For example, a RAID10 configuration cannot be made up of 5 
or 7 physical drives. 
In the case where there are 1 or more virtual drives and a global hot 
spare, clear the global hot spare one and then reconfigure as a 
dedicated hot spare, if you are to create a new virtual drive using a 
physical drive with a different capacity. After that, create a new virtual 
drive. For how to set and remove a hot spare, see "Configuring a hot 
spare" on page 2-125. 
If you create a virtual drive using a physical drive with a different 
capacity, the following pop-up error message is displayed: 

 

Next we explain how to create a new virtual drive with the Advanced option. 

In the following example, we describe the case where you create a RAID5 
virtual drive with 3 physical drives. To create a RAID10 virtual drive, perform 
step 1 and step 2, and see "Creating a RAID10 virtual drive" on page 2-107. 
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1. With the Controller selected, click Go To > Controller > Create Virtual 
Drive in the menu. 

You can also right-click the Controller and click Create Virtual Drive. 
The other way is to click  in the graphical menu. 

 

2. The Console mode window opens. 

Select Advanced, and click Next. 

 
 

 
Do not create a virtual drive with the Simple option. 
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If there is a virtual drive that does not use the entire capacity of the 
drive group, clicking Next. The following selection window opens. 

 
To create a new virtual drive in the existing drive group, select Use 
free capacity on an existing drive group and select the target 
virtual drive, and then click Next to go to step 6. 
To create a new virtual drive using a physical drive in the 
Unconfigured Good state (not used), select Use Unconfigured 
drives (create new drive group), and then click Next to go to step 
3. 

3. Selecting Advanced displays the Drive Group Settings window. 

Select the desired RAID level (RAID5) from RAID level. 
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4. In the Select unconfigured drives window, select three physical drives 
to create while pressing Ctrl. 

With three physical drives selected, click Add. 

 
 

 
Make sure that Select power save mode is set to None. 
This item may not be displayed depending on the disk array controller 
type (including LSI Software RAID). 

 

 
If you have selected a wrong physical drive, click Cancel to exist from 
virtual drive creation and try to build a physical drive from the 
beginning. 

5. Confirm whether the selected drives have moved to the Drive groups 
window or not. 

After configuration, click Create Drive Group. Then, click Next. 

 
 

 
You can also configure a dedicated hot spare when you create a virtual 
drive (RAID1, RAID5, or RAID6). See "Configuring a dedicated hot 
spare when creating a virtual drive" on page 2-131. 
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6. The Virtual drive settings window is displayed. Specify parameters for 
the new virtual drive, and click Create Virtual Drive. 

 
 

The parameters for a new virtual drive are as follows: 
 

Parameter Description 

Virtual drive name Sets a volume name (voluntary) 

Capacity Sets the capacity of a virtual drive 

Initialization state Sets an initialization method (Full Initialize is recommended.) 

Stripe size Sets a stripe size (only for RAID5 and RAID6) (Default: 64 KB 
(recommended)) 

Read policy Sets a read policy. 

No Read Ahead is recommended. 

Write policy Sets write policy. 

- For a disk array controller (with cache backup):  

Default: Write Back with BBU is mandatory. 

- For others: 

Default: Write Through is recommended. 
When a UPS is connected, Always Write Back can be selected. 

IO policy Sets an IO policy. (Default: Direct IO (recommended)) 

Access policy Sets data access policy. 

(Default: Read Write (recommended)) 

Disk cache policy Sets a physical drive cache. (Disabled is recommended) 
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Set each parameter to the required or recommended value. 

Set "Write policy" in accordance with your environment with reference 
to the description in the above table. 

"Write Back with BBU" can be selected only for disk array controllers 
(with cache backup). 

 

 
We cannot guarantee normal operation of the product if the 
recommend values are not used. 
For LSI Software RAID, the parameters specified for the new virtual 
drive are applied to all virtual drives in the same drive group. 
If you specify Always Write Back for LSI Software RAID, Write Back 
with BBU is displayed after the restart of the system unit, but this is 
not a problem. 

 

 
With Linux, only alpha-numeral characters are allowed for the volume 
name. 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 

7. The Write Through Selected pop-up window is displayed. Click Yes. 

 
 

 
This pop-up message is displayed when Write policy is set to Write 
Through. An attempt to set this parameter to another value displays 
the same pop-up message. 
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8. The new virtual drive is displayed in Drive groups. Click Next. 

 

9. The Summary window opens. Confirm the content and click Finish. 

The virtual drive is created. 

 

10. The pop-up window is displayed to notify you of the completion of the 
virtual drive creation. Click OK. 
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11. Initialize the virtual drive. 

Make sure that you initialize the virtual drive. See "Initializing virtual 
drive" on page 2-116 for how to initialize a virtual drive. 

 

 
If you have set Init State to Full Initialize, clicking Finish starts 
initialization of the virtual drive. You do not have to initialize the virtual 
drive again. 
To find the initialization progress, see "Displaying task progress and 
terminating a task" on page 2-157. 

 

Creating a RAID10 virtual drive 

1. Selecting Advanced displays the Drive Group Settings window. 

Select the desired RAID level (RAID 10 - Spanned drive group) from 
RAID level. 
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2. In the Select unconfigured drives window, select two physical drives to 
create while pressing Ctrl. 

With two physical drives selected, click Add. 

 
 

 
Make sure that Select power save mode is set to None. This item 
might not be displayed depending on the disk array controller type 
(including LSI Software RAID). 

 

 
If you have selected a wrong physical drive, click Cancel to exist from 
virtual drive creation and try to build a physical drive from the 
beginning. 

3. Confirm whether the selected drives have moved to the Drive groups 
window or not. 

After confirmation, click Create Span. 
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4. In the Select unconfigured drives window, select two physical drives to 
create while pressing Ctrl again. 

With two physical drives selected, click Add. 
 

 
You can also configure a dedicated hot spare when you create a virtual 
drive (RAID10). See "Configuring a dedicated hot spare when creating 
a virtual drive" on page 2-131. 

5. Confirm that the selected drives have moved to the Drive groups window 
and there are two spans. 

After confirmation, click Create Drive Group. Then, click Next. 

 

6. The Virtual drive settings window is displayed. Specify parameters for 
the new virtual drive, and click Create Virtual Drive. 
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The parameters for a new virtual drive are as follows: 
 

Parameter Description 

Virtual drive name Sets a volume name (voluntary) 

Capacity Sets the capacity of a virtual drive 

Initialization state Sets an initialization method (Full Initialize is recommended.) 

Stripe size Sets a stripe size (Default: 64 KB (recommended)) 

Read policy Sets a read policy (No Read Ahead is recommended.) 

Write policy Sets a write policy. 

- For a disk array controller (with cache backup): 

Default: Write Back with BBU is mandatory. 

- For others: 

Default: Write Through is recommended. 
When a UPS is connected, Always Write Back can be selected. 

IO policy Sets an IO policy. (default: Direct IO (recommended)) 

Access policy Sets a data access policy. 

(Default: Read Write (recommended)) 

Disk cache policy Sets a physical drive cache. (Disabled is recommended) 

Set each parameter to the required or recommended value. 

Set "Write policy" in accordance with your environment with reference 
to the description in the above table. 

"Write Back with BBU" can be selected only for disk array controllers 
(with cache backup). 

 

 
We cannot guarantee normal operation of the product if the 
recommend values are not used. 

 

 
With Linux, only alpha-numeral characters are allowed for the volume 
name. 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 

7. The Write Through Selected pop-up window is displayed. Click Yes. 

 



 MegaRAID Storage Manager 2-111 

MegaRAID Storage Manager Instruction Manual 

 

 
This pop-up message is displayed when Write policy is set to Write 
Through. An attempt to set this parameter to another value displays 
the same pop-up message. 

8. The new virtual drive is displayed in Drive groups. Click Next. 

 

9. The Summary window opens. Confirm the content and click Finish. 

The virtual drive is created. 
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10. The pop-up window is displayed to notify you that the virtual drive has 
been created. Click OK. 

 

11. Initialize the virtual drive. 

Make sure that you initialize the virtual drive. See "Initializing virtual 
drive" on page 2-116 for how to initialize a virtual drive. 

 

 
If you have set Init State to Full Initialize, clicking Finish starts 
initialization of the virtual drive. You do not have to initialize the virtual 
drive again. 
To find the initialization progress, see "Displaying task progress and 
terminating a task" on page 2-157. 
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Changing the setting of virtual drive(s) 

Change the setting of a virtual drive in the procedure described below. 
 

 
LSI Software RAID is not supported. 

1. In the Logical view, select the virtual drive that you have created. 

2. Right-click the virtual drive, and click Set Virtual Drive Properties. 
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3. The following parameters are displayed: 

 
 

Parameter Description 

Name Sets a virtual drive name. (voluntary) 

Read Policy Sets a read policy. 

No Read Ahead is recommended. 

Write Policy*2 Sets a write policy setting 

- For a disk array controller (with cache backup): 

Default: Write Back with BBU is mandatory. 

- For other cases: 

Default: Write Through is recommended. 
When a UPS is connected, Always Write Back can be selected 

IO Policy*1 Sets an IO policy. (Default: Direct IO (recommended)) 

Access Policy*1 Sets a data access policy. (Default: Read Write (recommended)) 

Disk Cache Policy*1 Sets a physical drive cache. (Disabled is recommended) 

Background Initialization*1 Sets background initialization (Disabled is recommended.) 

*1:  Use the default value for this parameter. 

*2:  Write Back with BBU can be selected only for disk array controllers (with cache backup). 

4. Click Go after you have changed the setting. 
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5. The following pop-up message is displayed. Check Confirm and click Yes. 
 

 
The setting is saved. 

 

 
For how to change the write policy, see "Changing write cache" on 
page 2-140. 
We cannot guarantee normal operation of the product if the 
recommend values are not used. 
For LSI Software RAID, the parameters specified for the new virtual 
drive are applied to all virtual drives in the same drive group. 
If you specify Always Write Back for LSI Software RAID, Write Back 
with BBU is displayed after the restart of the system unit, but this is 
not a problem. 
The setting value of Disk Cache Policy is not displayed for LSI 
Software RAID. 

 

 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 
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Initializing virtual drive(s) 

Initialize a virtual drive in the procedure described below. 
 

 

All data in a virtual drive are lost when the drive is initialized. Be extremely 
careful in initializing the drive. Make a backup of important data. 

 

 
During initialization of virtual drive, do not restart, power on, or power 
off system unit. Processing stops and progress returns to 0%. 

 

 
The period of time required for initializing a virtual drive is proportional 
to the capacity of a physical drive, not to the capacity of the virtual 
drive. 
You can start initializing multiple virtual drives in a disk group, but the 
progress differs among different virtual drives. Simultaneous 
initialization of multiple virtual drives may take more time than 
initializing them individually. See "Estimate of various processing time" 
on page 5-2. 

1. Click Manage > Initialize. 
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2. The Group Initialization window opens. 

If there are multiple disk array controllers, select a target one. (You do not 
have to select a disk array controller if there is only one.) 

Then, select the target virtual drive and click Start. 

 
 

 
Do not use Fast Initialization. Otherwise, MSM may not function 
normally. 
Do not execute initialization if a consistency check is running for any 
other virtual drives of the same drive group. 

 

 
A virtual drive with an OS installed does not appear in the Group 
Initialization window. 

3. The initialization confirmation dialog box opens. Click Yes. 

Initialization starts. 

 
 

 
To find the initialization progress, see "Displaying task progress and 
terminating a task" on page 2-157. 
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Consistency check of virtual drives 

A consistency check reads data in all the areas of a target physical drive to 
check parity and mirror data consistency and to search for bad sectors. If any 
inconsistency is found, the parity or the mirror data is corrected. 

 
 

Conduct periodical consistency checks for LSI Software RAID. If there is a bad 
sector during the rebuild operation in the event of a physical drive failure, the 
data in the sector will be lost. See "Operation of Disk Arrays" on page 3-1 for 
details. 

 

 
No consistency check is required for RAID devices other than LSI 
Software RAID because Patrol Read is executed for periodically. 

MSM: Consistency check of virtual drive(s) 

Conduct a consistency check from MSM in the procedure described below. 
 

 
When you conduct a consistency check for a RAID device other than 
LSI Software RAID, stop Patrol Read beforehand. If you attempt a 
consistency check while Patrol Read is running, the system unit may 
shut down. For how to stop Patrol Read, see "Preparation for 
consistency check: Stopping Patrol Read" on page 2-123. 
Check Consistency cannot be selected while rebuild or other task is 
running. 
A consistency check is executable only for redundant virtual drives 
(RAID1, RAID5, RAID6, or RAID10). 
Do not execute a consistency check if initialization is running for any 
other virtual drive of the same drive group. 
A consistency check is not applicable to a hot spare. Use Patrol Read to 
check a hot spare. See "Setting Patrol Read" on page 2-179 for details. 

1. Click Manage > Check Consistency in the menu. 
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2. The Group Consistency Check window opens. 

If there are multiple disk array controllers, select a target one. (You do not 
have to select a disk array controller if there is only one.) 

Then, select the target virtual drive and click Start. 

A consistency check starts. 

 
 

 
To confirm the consistency check progress, see "Displaying task 
progress and terminating a task" on page 2-157. 
If the virtual drive is not fully initialized, the following pop-up window 
opens. Click Yes. 
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Command line: Consistency check of virtual drive(s) 

This subsection explains how to execute a consistency check manually by 
entering a command on the command line or from a terminal. For LSI 
Software RAID, incorporate this command in a batch file so that the command 
can be executed periodically according to an OS task schedule. 

RAID devices other than LSI Software RAID are configured as factory 
default in such a manner that Patrol Read verifies their physical drives 
periodically to correct bad sectors. Therefore, you do not have to 
execute a periodical consistency check for RAID devices other than 
LSI Software RAID. 

 

 
When you execute a consistency check for a RAID device other than 
LSI Software RAID, stop Patrol Read beforehand. If you attempt a 
consistency check while Patrol Read is running, the system unit may 
shut down. For how to stop Patrol Read, see "Preparation for 
consistency check: Stopping Patrol Read" on page 2-123. 
Check Consistency is not selectable while a task such as rebuilding is 
running. 
Consistency check is executable only for redundant virtual drives 
(RAID1, RAID5, RAID6, or RAID10). 
The command line can be used only for consistency check of virtual 
drives. Do not use the command line for any other purposes. 
Otherwise, a malfunction may occur. 

1. For Windows, start the command prompt. 

For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 

For Linux, move to the following directory: 

/opt/MegaRAID/MegaCli 
 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 
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3. Enter the following commands: 

For Windows: 

# MegaCli -LDCC -Start -force -Lx -ax 

For Linux: 

# ./MegaCli -LDCC -Start -force -Lx -ax 
- Lx: x is a virtual drive number. 

0, 1, 2, ... ALL ("ALL" indicates all devices.) 
-ax: x is a disk array controller number. 

0, 1, 2, ... ALL ("ALL" indicates all disk array controllers.) 
 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 

 

The following example specifies all virtual drives of disk array controller 
a0: 
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4. A consistency check starts. 

If any processing, such as rebuilding or consistency check, is running in 
background, a message Check Consistency is not possible on Virtual 
Drive ... at this time is displayed and no consistency check is performed. 

 
 

 
The consistency check continues to be conducted even when you 
terminate the command line window or the terminal. 
The start and end events are registered in the MSM event log and the 
Windows application log. 
To confirm the consistency check progress, see "Displaying task 
progress and terminating a task" on page 2-157. 
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Preparation for consistency check: Stopping Patrol Read 

When you execute a consistency check for a RAID device other than LSI 
Software RAID, stop Patrol Read beforehand. If you attempt to perform a 
consistency check while Patrol Read is running, the system unit may shut 
down. 

Stop Patrol Read in the procedure described below. 
 

 
The schedule setting of Patrol Read stays effective after you stop 
Patrol Read in the procedure described below. 
That is, Patrol Read will be executed according to the factory default 
schedule even after you stop it. 
You can start initialization of multiple virtual drives in a disk group, but 
the progress differs among different virtual drives. Simultaneous 
initialization of multiple virtual drives may take more time than each 
individual process. See "Estimate of various processing time" on page 
5-2. 
Stop Patrol one if running, before conducting a consistency check. 

1. For Windows, start the command prompt. 

For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 

For Linux, move to the following directory: 

/opt/MegaRAID/MegaCli 
 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 

3. Enter the following commands: 

For Windows: 

# MegaCli -AdpPR -Stop -ax 

For Linux: 

# ./MegaCli -AdpPR -Stop -ax 
-ax: x is a disk array controller number. 

0, 1, 2, ... ALL ("ALL" indicates all disk array controllers.) 
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Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 
To stop Patrol Read from MSM, select and right-click Controller 
and click Stop Patrol Read. 
(Stop Patrol Read is not displayed when Patrol Read is not 
running.) 

 

4. After execution of the command, confirm that one of the following 
messages is displayed: 

Read the message and continue with a consistency check. 

Execution results displayed when Patrol Read is stopped: 

# No Patrol Read is in progress 

# Exit Code: 0x00 

Execution results displayed when Patrol Read is running: 

# Adapter x: Patrol Read is stopped. 

# Exit Code: 0x00 

* "x" stands for a specified disk array controller number. 
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Configuring a hot spare 

This section describes how a hot spare works and is to configured it. 
 

 
A hot spare setting is applicable only to drives of the same type. 
A hot spare setting is applicable only to virtual drives under the same 
controller. 

About hot spare 

The hot spare function protects virtual drives that have redundancy. If a single 
physical drive of a redundant virtual drive fails, rebuilding (reconfiguring data) 
is performed using a hot spare. 

 
 

 
In a system unit that supports hot swapping, a new physical drive is 
automatically configured as a hot spare during system operation when 
you replace the failed physical drive after completion of rebuilding. 

There are two types of hot spares: global hot spare and dedicated hot spare. 

A global hot spare can be used by any redundant virtual drive under the same 
disk array controller. 

A dedicated hot spare is used only by a specified virtual drive under the same 
disk array controller 

 

 
A global hot spare is displayed only in the Physical view. A dedicated 
hot spare is displayed in both the Physical and Logical views. 

You need to pay attention to the operation of a hot spare if the same 
disk array controller is equipped with physical drives with a different 
capacity. 

RAID5 

Hot spare 
If a drive fails 

End of rebuilding 
RAID5 

The hot spare is 
included in the 
virtual drive. 

Failed physical 
drive 

RAID5 

Hot spare 

The hot spare is automatically 
rebuilt (reconfiguring the 
data). 
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Do not use a global hot spare if the disk array controller is equipped with 
physical drives with a different capacy. Use a dedicated hot spare for a virtual 
drive that consists of physical drives with the same capacity. 

Rebuilding is executed for a hot spare whose capacity is larger than that of the 
failed physical drive. After completion of rebuilding, a new physical drive 
substituting the failed drive automatically becomes a hot spare. However, 
because the capacity of this hot spare is smaller than the one before, 
rebuilding cannot be executed in a next fault if the capacity of the failed 
physical drive is larger than the hot spare. 

If physical drives with a different capacity exist, cancel a global hot spare once. 
Then, configure a dedicated hot spare to a virtual drive that consists of 
physical drives with the same capacity. Cancel a global hot spare in the 
procedure described below. 

1. For Windows, start the command prompt. 

For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 

For Linux, move to the following directory: 

/opt/MegaRAID/MegaCli 
 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 
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3. Enter the following commands: 

For Windows: 

# MegaCli -PDHSP -Rmv -PhysDrv[?:Sx] -ax 

For Linux: 

# ./MegaCli -PDHSP -Rmv -PhysDrv[?:Sx] -ax 
Sx: Sx is a slot number for a target global hot spare. 

0, 1, 2, ...  
-ax: x is a disk array controller number. 

0, 1, 2, ... ALL ("ALL" indicates all disk array controllers.) 
 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 

The global hot spare is cancelled. 

In the above-mentioned procedure, use a dedicated hot spare for a system 
unit equipped with physical drives have the same capacity. That is, remove the 
global hot spare, and then configure a dedicated hot spare. 

If a physical drive for hot spare use is mounted on the purchased system unit, 
the hot spare is configured as a global hot spare before shipment. 

Configuring a global hot spare 

This subsection describes how to configure a hot spare for a current virtual 
drive (RIAD1, RIAD5, RAID6, or RAID10). 

 

 
A hot spare is applicable only to redundant virtual drives (RAID1, 
RAID5, RAID6, and RAID10). Hot spare setting for a RAID0 drive is not 
supported. 

 

 
A global hot spare is displayed only in the Physical view, not in the 
Logical view. 

1. In the Physical view, select the physical drive that you want to configure 
as a global hot spare. 
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2. Right-click the selected physical drive, and click Assign Global Hot Spare. 

 

3. The drive is configured as a global hot spare. 

 

Configuring a dedicated hot spare 

This subsection describes how to configure a hot spare to a current virtual 
drive (RIAD1, RIAD5, RAID6, or RAID10). 

 

 
A hot spare is applicable only to redundant virtual drives (RAID1, 
RAID5, RAID6, and RAID10). Hot spare setting for a RAID0 drive is not 
supported.  
Configure a dedicated hot spare only for a single drive group, not for 
multiple drive groups. 
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Configuring a hot spare for an existing drive group 

1. In the Physical view, select the physical drive that you want to configure 
as a dedicated hot spare. 

2. Right-click the selected physical drive, and click Assign Dedicated Hot 
Spare. 

 

3. The window for configuring a dedicated hot spare opens. 

Select a target drive group and click OK. 
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4. The dedicated hot spare is configured. 

In the Logical view, a hot spare is displayed for the target drive group. 
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Configuring a dedicated hot spare when creating a virtual drive 

You can configure a hot spare when you create a virtual drive (RAID1, RAID5, 
RAID6, or RAID10). Follow the procedure described below after performing 
steps 1 and 2 of "Functions of MegaRAID Storage Manager" on page 2-82. 

 

 
A dedicated hot spare cannot be configured in this procedure when you 
create a virtual drive in an existing drive group. 

1. Selecting Advanced displays the Drive Group Settings window. 

After setting the RAID level, select multiple physical drives while pressing 
Ctrl in the Select unconfigured drives window. 

With the target physical drives selected, click Add. 

 
 

 
Make sure that Select power save mode is set to None. 
This parameter may not be displayed depending on the disk array 
controller type (including LSI Software RAID). 
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2. Confirm whether the selected drives have moved to the Drive groups 
window or not. 

Then, click Create Drive Group. 

 

3. In the Select unconfigured drives window, reselect the physical drive to 
be configured as a hot spare window. 

Next, select the drive group to which the hot spare is configured, and click 
Add Hot Spare. 
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4. Confirm whether the physical drive configured as the dedicated hot spare 
has been moved to the Drive groups window, and click Next. 

 

5. Create the virtual drive with reference to "Functions of MegaRAID Storage 
Manager" on page 2-82. 
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Removing a hot spare 

This subsection explains how to remove a configured global hot spare. 

This procedure is also applicable to removing a dedicated hot spare. 

1. In the Physical view, select a physical drive set to the global hot spare 
that you want to remove. 

2. Right-click the selected global hot spare, and click Remove Hot Spare in 
the menu. 

Alternatively, you can click Go To > Physical Drive > Remove Hot 
Spare. 

 

3. A dialog box opens for confirming the deletion of the hot spare. Select 
Confirm and click Yes. 

The global hot spare is removed. 
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Expansing virtual drive capacity 

The capacity of a RAID5 or RAID6 virtual drive can be expanded without 
erasing data by adding an unused physical drive. 

Follow the procedure described below. To prepare against any unexpected 
risk, make a full system backup before expanding the capacity. 

 
 

During capacity expansion, do not restart, power on, or power off the system 
unit. Do not stop the system until the expansion is completed. A failure to do so 
may cause loss of data. 

 

 
Capacity expansion is not supported for the case where there are 
multiple virtual drives in the drive group or there is a virtual drive that 
is not using the entire capacity of the drive group. 

 

 
During capacity expansion, the IO policy of all virtual drives under the 
disk array controller is temporarily set to Cached IO. 
Capacity expansion for a disk array controller (with cache backup) sets 
the write policy of the virtual drive to Write Through (when set to 
Write Back With BBU). 
Background initialization is automatically executed after expansion of 
the capacity. (Background initialization takes about 1 minute per 10-
GB data of the prior-expansion virtual drive.) 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 

1. In the Logical view, click the drive group that contains the target virtual 
drive. 
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2. Click Go To > Drive Group > Modify Drive Group in the menu. 

Alternatively, right-click the drive group and click Modify Drive Group. 

 

3. The confirmation dialog box opens to prompt you to back up data. After 
the backup, select Confirm and click Yes. 

 

4. The Modify Drive Group window opens. Select the RAID level to be 
applied after expansion, and click Next. 
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Select the same RAID level as the current one. Selecting a different 
RAID level may cause unsuccessful capacity expansion or corruption of 
disk array data. 

5. The Add drive to the current configuration window opens. Check the 
drive to be added and click Next. 

 

6. The Summary window opens. Click Finish. 
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7. The Confirmation window opens. Click Yes. 

Capacity expansion starts. 

 
 

 
To confirm the capacity expansion progress, see "Displaying task 
progress and terminating a task" on page 2-157. 
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Deleting virtual drive(s) 

This paragraph describes how to delete a virtual drive, and return all physical 
drives of the virtual drive to the unused state. 

Follow the procedure described below. 
 

 

All data in a virtual drive are lost when the drive is deleted. Be careful in 
deleting a drive. Backup important data. 

1. In the Logical view, select the virtual drive to be deleted. 

2. Click Go To > Virtual Drive > Delete Virtual Drive in the menu. 

Alternatively, right-click the virtual drive and click Delete Virtual Drive. 

 

3. A dialog box opens for confirming the deletion of the virtual drive. Select 
Confirm and click Yes. 

 
The virtual drive is deleted. The virtual drive is deleted also from the 
Logical view. 
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Within a drive group, it is only possible to delete the last virtual drive 
that you created. 
To delete a virtual drive older than the last one, delete all the virtual 
drives from the last drive through the target one in descending order 
of creation date. 

Changing write cache 

MSM allows you to change the write cache setting for each virtual drive. 
 

 

For controller boards other than disk array controllers (with cache backup), set 
the write policy to Always Write Back only when the system unit is connected 
to an uninterruptible power supply (UPS). If you set the write policy to Always 
Write Back without connecting to a UPS, a power failure or instantaneous 
power loss may cause data corruption due to loss of data in the write cache. 

Set the write policy of the disk array controller (with cache backup) board to 
Write Back with BBU. If the write policy is not set to Write Back with BBU, 
a power failure or an instantaneous power loss may cause data corruption due 
to loss of data in the write cache of the disk array controller. 

 

 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 

1. In the Logical view, select the virtual drive for which you want to change 
the write cache setting. 

2. Right-click the selected virtual drive and click Set Virtual Drive 
Properties in the menu. 
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3. Select Write Policy, change the setting in accordance with the 
environment as described below, and click OK. 

For the disk array controller (with cache backup): 

Change the setting to Write Back with BBU. 

For the system unit is connected to an uninterruptible power supply (UPS): 

Change the setting to Always Write Back. 

 

4. The pop-up window for confirming the write cache setting opens. Click Yes. 
 

  
Setting to Always Write Back Setting to Write Back with BBU 

5. The cache change dialog box opens. Select Confirm and click Yes. 

 
The write cache is configured for the virtual drive. 
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6. Confirm that Write Policy is displayed as shown below. 

When setting to Always Write Back: 

Current Write Policy: Write Back 

Default Write Policy: Always Write Back 

When setting to Write Back with BBU 

Current Write Policy: Write Back 

Default Write Policy: Write Back with BBU 
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Blinking LEDs 

You can blink the LEDs on individual mounted physical drives and logical drives 
to confirm their location. 

This paragraph describes a virtual drive as an example. The procedure also 
applies to physical drives. 

 

 
LSI Software RAID is not supported. 

Blinking LEDs 

1. In the Logical view, select the virtual drive whose LEDs you want to blink 

2. Click Go To > Virtual Drive > Start Locating Virtual Drive. 

Alternatively, right-click the virtual drive and click Start Locating Virtual 
Drive in the menu. 

 
 

 
If you select a physical drive, click Start Locating Drive. 

3. The LEDs on the physical drives that make up the virtual drive will blink. 
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Stopping blinking LEDs 

1. In the Logical view, select the virtual drive whose LEDs you want to stop 
blinking. 

2. Click Go To > Virtual Drive > Stop Locating Virtual Drive. 

Alternatively, right-click the virtual drive and click Stop Locating Virtual 
Drive in the menu. 
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Diagnosing cache back module (BBU) 

The diagnostic function Learn Cycle performs one cycle of charging and 
discharging a cache back module to diagnose its status. Diagnosis can be 
performed in the procedure described below. However, automatic diagnosis is 
performed periodically. 

 

 
This function can be used only for disk array controllers (with cache 
backup). 
Set Learn Cycle Properties is not supported. Do not use this 
parameter. Use automatic diagnosis with factory default (Enable). 
The diagnosis progress cannot be confirmed. 

 

 
To check if the device is a disk array controller (with cache backup), 
check BBU Present of "Controller" on page 2-88. If the value is Yes, 
the device is a disk array controller (with cache backup). 
The diagnosis time is about 5 minutes. 
Automatic diagnosis is performed 28 days after the last diagnosis.  
(For example, if automatic diagnosis is executed at 11 pm on May 10, 
the next one will be done at 11 pm on June 7.) 

MSM: Execution of diagnosis 

Execute diagnosis from MSM in the procedure described below. 

1. Select BBU in the Physical view. 

2. Right-click the selected BBU, and click Start Learn Cycle. 

Diagnosis starts. 
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MSM takes a log named Battery relearn started. when a diagnosis 
starts. 
MSM takes a log called Battery relearn completed. when a diagnosis 
completes. 
After you click Start Learn Cycle, preparation for diagnosis is made. 
It may take about two minutes to start diagnosis. 

Command line: Execution of diagnosis 

This is the procedure for executing diagnosis manually by entering a command 
on the command line or from a terminal. To execute diagnosis periodically, 
include this command in a batch file so that it is executed by an OS task 
schedule. Set an interval of less than 28 days because automatic diagnosis is 
already scheduled for every 28 days.* 

* The BBU property Next Learn Cycle indicates the date and time of next 
automatic diagnosis. 

1. For Windows, start the command prompt. 

For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 

For Linux, move to the following directory: 

/opt/MegaRAID/MegaCli 
 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 

3. Enter the following commands: 

For Windows: 

# MegaCli -AdpBbuCmd -BbuLearn -a0 

For Linux: 

# ./MegaCli -AdpBbuCmd -BbuLearn -a0 
 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 
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4. Diagnosis starts. 

 
 

 
The diagnosis continues to run after you terminate the command 
line window or the terminal. 
Start and end events are registered in the MSM event log as well as 
in the Windows application log. 
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SMART copyback 

The SMART copyback function allows you to copy all data from a physical drive 
expected to fail from which SMART warning is issued to a hot spare drive. 
(The physical drive is a part of a virtual drive which is created using RAID1, 
RAID5, RAID6, or RAID10.) 

Consequently, the function makes it possible to replace the physical drive 
safely with redundancy of the virtual drive retained. 

In addition the function lowers the possibility for a degraded virtual drive to 
fail additionally with another physical drive failure during rebuild operation. 

 

 
Since the SMART copyback operation copies all data of a physical drive 
expected to fail, system performance becomes lower when the 
operation runs than when it doesn't run. 
This function is not supported on LSI Software RAID systems. 

 

 
The SMART copyback function is disabled by default. 
Use MegaCli on the command line to enable or disable the function. 
During the SMART copyback operation, the physical drive from which 
the SMART warning occurs is marked as being replaced with <copy 
destination hot spare> in the Physical view. 
During the SMART copyback operation, the copy destination hot spare 
is marked as replacing <copy source physical drive> or Copyback 
in progress in the Physical view. 
The physical drive from which the SMART warning occurs becomes the 
Unconfigured Bad status after the SMART copyback operation 
finishes. 
If the SMART copyback operation is suspended before completion, the 
related physical drives revert to their original status. 
To confirm the SMART copyback operation progress, see "Displaying 
task progress and terminating a task" on page 2-157. 
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Enabling SMART copyback function 

To enable SMART copyback: 

1. For Windows, start the command prompt. 
For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 
For Linux, move to the following directory: 
    /opt/MegaRAID/MegaCli 

 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 

3. Execute the following command: 

For Windows: 

# MegaCli -AdpSetProp -CopyBackDsbl -0 -a0 

For Linux: 

# ./MegaCli -AdpSetProp -CopyBackDsbl -0 -a0 

 
 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 

4. The following message is displayed: 
 

  Adapter 0:  Set CopyBack to Enable success. 
  Exit Code:  0x00 

5. Execute one of the following commands: 

When enabling SMART copyback for a HDD: 

For Windows: 
# MegaCli -AdpSetProp -SMARTCpyBkEnbl -1 -a0 

For Linux: 
# ./MegaCli -AdpSetProp -SMARTCpyBkEnbl -1 -a0 

When enabling SMART copyback for a SSD: 
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For Windows: 
# MegaCli -AdpSetProp -SSDSMARTCpyBkEnbl -1 -a0 

For Linux: 
# ./MegaCli -AdpSetProp -SSDSMARTCpyBkEnbl -1 -a0 

 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 

6. The following message is displayed: 

When enabling SMART copyback for a HDD: 
 

  Adapter 0:  Set Copyback on SMART error is Enable success. 
  Exit Code:  0x00 

When enabling SMART copyback for a SSD: 
 

  Adapter 0:  Set Copyback on SMART error for SSD device is Enable success. 
  Exit Code:  0x00 

The procedure for enabling SMART copyback function is completed. 
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Disabling SMART copyback 

To disable SMART copyback: 

1. For Windows, start the command prompt. 
For Linux, start the terminal. 

2. For Windows, move to the MSM installation directory. 
For Linux, move to the following directory: 
    /opt/MegaRAID/MegaCli 

 

 
For Windows, MSM is installed in the following default directory: 

- 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager 

- 32bit OS: 
C:\Program Files\MegaRAID Storage Manager 

3. Execute one of the following commands: 

When disabling SMART copyback for a HDD: 

For Windows: 
# MegaCli -AdpSetProp -SMARTCpyBkEnbl -0 -a0 

For Linux: 
# ./MegaCli -AdpSetProp -SMARTCpyBkEnbl -0 -a0 

When disabling SMART copyback for a SSD: 

For Windows: 
# MegaCli -AdpSetProp -SSDSMARTCpyBkEnbl -0 -a0 

For Linux: 
# ./MegaCli -AdpSetProp -SSDSMARTCpyBkEnbl -0 -a0 

 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 
In Windows Server 2012, if you execute the above command, the 
message "No more interfaces" is output. 
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4. The following message is displayed: 

When disabling SMART copyback for a HDD: 
 

  Adapter 0:  Set Copyback on SMART error is Disable success. 
  Exit Code:  0x00 

When disabling SMART copyback for a SSD: 
 

  Adapter 0:  Set Copyback on SMART error for SSD device is Disable success. 
  Exit Code:  0x00 

5. Execute one of the following commands: 

For Windows: 

# MegaCli -AdpSetProp -CopyBackDsbl -1 -a0 

For Linux: 

# ./MegaCli -AdpSetProp -CopyBackDsbl -1 -a0 
 

 
Distinguish between upper and lower case letters when you execute 
the above command on Linux. 
If you execute the above command on 64 bit OS, replace the word 
"MegaCli" with "MegaCli64". 

6. The following message is displayed: 
 

  Adapter 0:  Set CopyBack to Disable success. 
  Exit Code:  0x00 

The procedure for disabling SMART copyback function is completed. 
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Rescan 

Rescan allows the system unit to recognize that you have added new physical 
drive during its operation. 

Follow the procedure described below. 

1. Click Manage > Refresh in the menu. Alternatively, click  in the 
graphical menu. 

Rescan starts. 

 

 
 

Rescan finishes after a while. 

Event reference 

When you start MSM, the event log reported by managed servers is 
automatically displayed in the message window on the main screen. 

 

You can store and delete the event log. You can also display the stored log. 

Follow the procedures described below. 



2-154 MegaRAID Storage Manager 

MegaRAID Storage Manager Instruction Manual 

Save 

Saves the current event log. 

1. Click Log > Save or Save as Text in the menu. 

 

2. The window for saving the log opens. 

Specify the saving location of the event log as well as the file name, and 
then click Save. 

The event log is saved. 

 
 
 

 
The maximum number of events in the current event log that can be 
saved is 3000. Save the event log before the number of events does 
not exceed 3000, and then delete the events. 
See "Collecting/Operating event logs" on page 3-3 for details. 
For Linux, only alphanumeric characters can be used for the name of a 
file to be saved. 
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Clear 

Deletes the event log that is currently displayed. 
 

 
Do not use Clear. Otherwise, fault analysis may be affected. 

1. Click Log > Clear in the menu. 

 

2. The dialog box is displayed for confirming the deletion of the event log 
opens. Click Yes. 

 

3. The dialog box for confirming whether or not to save the current event log 
opens. 

Clicking Yes saves the event log. Specify the saving location and the file 
name as in the case of the Save function. 

Clicking No deletes the event log without saving. 

 

4. The event log displayed in the message window is deleted. 
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Load 

Loads and displays the saved event log. 

1. Click Log > Load in the menu. 

 

2. Select the event log file to be loaded, and then click Open. 
 

3. The loaded event log is displayed in the message window. 

 
 

 
After you have viewed the saved log, select Log > Rollback to 
Current Log. The latest events are not displayed until you select 
Rollback to Current Log. 
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Displaying task progress and terminating a task 

This function allows you to display the status of running tasks (initialization of 
a virtual drive, rebuild, consistency check, and capacity expansion). You can 
also stop a task. 

Follow the procedures described below. 
 

 
Suspend, Suspend All, and Suspend Patrol Read displayed in the 
task progress window are not supported and should not be used. 
The progress displayed by Show Progress or Background 
operation of Dashboard sometimes stops. In such a case, execute 
Manage > Refresh. In the case of Show Progress, close the Show 
Progress window before executing Manage > Refresh. 
When Full Initialize is specified upon creation of a virtual drive, 
progress item Clear: displayed in Background operation of 
Dashboard stays at 0%. 
To erase this progress display, execute Manage > Refresh. 

Displaying task progress 

1. Click Manage > Show Progress in the menu. Alternatively, click More 
details of Dashboard. 

 
If there are multiple disk array controllers, select the target one. (You do 
not have to select a disk array controller if there is only one.) 
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• The progress of running tasks is displayed. The progress status 
windows of different tasks are shown below. 
Initializing virtual drive(s) 

 
• Rebuild • Consistency check 

  
• Expending virtual drive capacity  • Patrol Read 
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• SMART copyback*1  

 

 

*1: replacing <copy source physical drive> in the example window 
may be displayed as Copyback in progress. 
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Terminating a task 
 

 

During capacity expansion, do not restart, power on, or power off the system 
unit. Do not stop the system until a task is completed. Otherwise, data may be 
lost. 

1. Click Abort in the task progress window. 

To terminate all tasks, click Abort All. 
 

 
Suspend, Suspend All, and Suspend Patrol Read displayed in the 
task progress window are not supported and should not be used. 

2. The dialog box for confirming the termination of the task opens. Click Yes. 
 

 
When clicking Abort When clicking Abort All 

3. The task stops. 

 
 

 
Patrol Read cannot be terminated in the task progress window. 
Select the controller, and then select Go To > Controller > Stop 
Patrol Read. 
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Setting network security exceptions 

This function sets network security exception for MSM. 

Port number 

MSM uses its reserved ports 3071 and 5571. These port numbers cannot be 
changed. When you introduce a network security feature, register these ports 
as exceptions. 

3071: TCP, UDP;   5571: UDP 
 

 
Port 5571 is not used by this version of MSM, hat is reserved for MSM. 
If you introduce network security, please register this port number as 
an exception. 
Do not use the MSM ports for any other applications. 

Setting exceptions with Windows firewall function 

When you install or start MSM with the Windows firewall function and popup 
message enabled, a pop-up message of Windows Security Alert opens. 

Pop-up windows: 

• When you set up MSM after OS installation without closing the Windows 
Server Post-Setup Security Updates window 

• When enabling the firewall function 
 

  

Windows Server 2012 Windows Server 2008 R2 

  
Windows Server 2008 Windows Server 2003 R2 /  

Windows Server 2003 
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• When you start MSM with the firewall function enabled 
 

 
Windows Server 2012 Windows Server 2008 R2 

  

Windows Server 2008 Windows Server 2003 R2 / 
Windows Server 2003 

To inhibit the pop-up display, set an exception in the procedure described 
below. 

When a pop-up message is displayed 

When the Windows Security Alert pop-up message is displayed and the 
program name is java or javaw, click Unblock to register the program as an 
exception. 

 

 
For Windows Server 2012 / Windows Server 2008 R2, select both 
Private Network and Public Network, and then click Allow 
access. 

Setting exceptions from the Windows firewall 

When you enable the Windows firewall, follow the procedure described below 
to register the program as a firewall exception. 

1. Click the Exceptions tab in the Windows firewall window. 
 

 
For Windows Server 2012, select Allow an app or feature 
through Windows Firewall. 
For Windows Server 2008 R2, select Allow a program or feature 
through Windows Firewall. 
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2. Click Add Program. 
 

 
For Windows Server 2012, select Allow another app. 
For Windows Server 2008 R2, select Allow another program. 

 

Windows Server 2012 Windows Server 2008 R2 

  

Windows Server 2008 Windows Server 2003 R2 / 
Windows Server 2003 

3. Click Browse, enter the program path, and click OK. 
 

 
For Windows Server 2012 / Windows Server 2008 R2, click Browse, 
enter the program path, and click Add. 
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Windows Server 2012 Windows Server 2008 R2 

  
Windows Server 2008 Windows Server 2003 R2 / 

Windows Server 2003 
The program paths* are as follows: 
* When MSM is installed in the default location. 

java: 

• 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager\JRE\bin 

• 32bit OS: 
C:\Program Files\MegaRAID Storage Manager\JRE\bin 

javaw: 

• 64bit OS: 
C:\Program Files (x86)\MegaRAID Storage Manager\JRE\bin 

• 32bit OS: 
C:\Program Files\MegaRAID Storage Manager\JRE\bin 
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4. Confirm that these programs are added in the Exception tab and their 
check boxes are selected. 

Set java and javaw for the program. 
 

 
For Windows Server 2012, confirm that the program is added to 
Allow apps and features and the checkbox of Name, Private, 
and Public are selected. Otherwise, select the unchecked the 
checkbox, and select OK. 
For Windows Server 2008 R2, select Allow a program or feature 
through Windows Firewall. Confirm in the window opened that 
the programs are added as allowed programs, and the check boxes 
Name, Home/Work (Private), and Public are selected. If any of 
these check boxes is not selected, select it. 
Exception programs for Ver.8.10-04, Ver.8.31-01 are javaw, 
mrmonitor, and popup. 
Exception programs for Ver.3.04-08 and earlier are javaw and 
popup. 

 

Windows Server 2012 Windows Server 2008 R2 

  
Windows Server 2008 Windows Server 2003 R2 / 

Windows Server 2003 
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Setting exceptions with the Red Hat Enterprise Linux firewall 
function 

When the Red Hat Enterprise Linux firewall function is enabled, servers of 
other MSM instances cannot be viewed through the network. When you enable 
the firewall, register ports 3071 and 5571 as exceptions in the following 
procedure. (However, some functions such as progress windows are 
restricted.) 

 

 
Centralized management is not possible when the firewall is enabled. 

1. For Red Hat Enterprise Linux 6, click [System] > [Administration] > 
[Firewall] in the Linux OS menu. (Close the [Firewall Configuration 
Startup] window, which is displayed after selecting [Firewall].  

For Red Hat Enterprise Linux 5, click [System] > [Administration] > 
[Security Level and Firewall] in the Linux OS menu. 

 

  
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 
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2. For Red Hat Enterprise Linux 6, click [Other ports] in the menu on the 
left. 

For Red Hat Enterprise Linux 5, select the [Firewall Options] tab and 
click [Other ports]. 

 

  
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 

3. The following window is displayed: Click Add. 
 

  
Red Hat Enterprise Linux 6   Red Hat Enterprise Linux 5 
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4. The following window is displayed: 

For Red Hat Enterprise Linux 6, select [User Defined], set [Port / Port 
Range] to "3071" and [Protocol] to tcp, and then click OK. 

For Red Hat Enterprise Linux 5, set [Port] to "3071" and [Protocol] to 
tcp, and then click OK. 

 

 

 

5. The port specified in step 4 is added in [Other ports]. 
 

 
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 

6. Repeat steps 3 and 4 and add a port with the following. 

Setting 

(1) Port: 3071, Protocol: udp 

(2) Port: 5571, Protocol: udp 

 

 
 
 
 
 
 

 
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 
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7. Confirm that three setting items have been added in [Other ports]. 

For Red Hat Enterprise Linux 6, click [Apply]. 

For Red Hat Enterprise Linux 5, click OK. 
 

 
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 

8. The following pop-up massage is displayed. 

Click Yes to apply the setting. 
 

 
Red Hat Enterprise Linux 6 Red Hat Enterprise Linux 5 
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In the CUI environment, add the following items in file 
/etc/sysconfig/iptables to register exceptions: 
In Red Hat Enterprise Linux 6 

-A INPUT -m state --state NEW -m tcp -p tcp --dport 3071 -j 
ACCEPT 
-A INPUT -m state --state NEW -m udp -p udp --dport 3071 -j 
ACCEPT 
-A INPUT -m state --state NEW -m udp -p udp --dport 5571 -j 
ACCEPT 

In Red Hat Enterprise Linux 5 
-A RH-Firewall-1-INPUT -m state --state NEW -m tcp -p tcp --dport 
3071 -j ACCEPT 
-A RH-Firewall-1-INPUT -m state --state NEW -m udp -p udp --
dport 3071 -j ACCEPT 
-A RH-Firewall-1-INPUT -m state --state NEW -m udp -p udp --
dport 5571 -j ACCEPT 

Make sure that you restart the system after adding these items to 
the file. 
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Setting event notification 

This function sets an event notification when a disk array event occurs. 

The following items can be set for an event notification: 
 

Setting item Description 

Customizing an event 
notification 

Sets what kind of notification should be made for each event level. 

Setting email  Configures items required for email event notifications. 

Clicking Tools > Monitor Configure Alerts in the menu displays the event 
notification setting window. 

 

 
 

 
You cannot operate event notification setting from MSM Client of a 
management PC. Try this setting it from MSM Client of a managed 
server or a management server. 

 

 
We recommend that you make a backup using Save Backup when 
you have made event notification setting. You can restore the setting 
to the original by Load Backup when you reconfigure the system unit. 
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Customizing an event notification 

Sets what kind of event notification should be made for each event level. The 
initial settings are as follows: 

 
Alert delivery method Severity level 

Windows OS Linux OS 

Fatal (error) Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Pop-up window (Popup) 

Email notification (email) 

Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Email notification (email) 

Critical (error) Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Pop-up window (Popup) 

Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Warning Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Information Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

Recorded in the OS event log (system 
log) 

Output to the MSM message window 
(MSM log) 

 

 
For a non-GUI environment of Linux, pop-up window notification is not 
supported and should not be enabled. 

 

 
MSM messages are recorded in the OS event log and displayed on 
pop-up windows not in a system unit which is remotely connected for 
management, but in a system unit where MSM events have occurred. 
Use the MSM Log with the initial value. 
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Change the setting in the following procedure as necessary. 

1. Select a target severity level in the Alert Delivery Methods box of the 
Alert Settings tab, and click Edit. 

 

2. Change to any setting. Checking the box enables the selected function(s). 

 
 

Setting item Function 

MSM Log Outputs events to the MSM message window. 

System Log Records events in the OS event log 

Popup Pop-up window 

Email Email notification 

3. Click OK after you finish the setting. 
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4. The event notification setting window opens again. Click OK. 

 

Event notification setting is now completed. 

You can also change the severity level and the alert delivery method for each 
event message. In this case, change the setting in the following procedure: 

1. Click Change Individual Events of the Alert Settings tab. 

The list of event messages is displayed. 
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2. Click an event message. 

To change the severity level, click Severity and select a level in the 
displayed pull-down menu. 

To change the alert delivery method, select any setting in the Alert 
Delivery Methods box. 

 

3. Click OK when you finish the setting. 

4. The event notification setting window opens again. Click OK. 

The setting of severity level and the alert delivery methods are now completed. 
 

 
Do not click Restore defaults in the event message list window. 
Otherwise, the setting is initialized and some important event 
notifications may not be made. 
If you have made a wrong setting, click Cancel. In this case, the 
following pop-up window opens. Click Yes. 
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Setting email 

Sets the items required for email event notifications. 

 

 
When you want to receive event notifications from the MSM by email, 
open port 25 and port 7 in your SMTP server's firewall. 

1. Click the Mail Server tab. 

 

2. Enter information into each box. 
 

Entry Description 

Sender email Address Enter the email address of the sender. 

The address specified herein is used as the sender address of email. 

SMTP Server Enter the SMTP server name or its IP address. 

User name Enter the username registered for SMTP.*1 

Password Enter the password registered for SMTP.*1 

 

 
*1: When This server requires authentication is selected, AUTH-

LOGIN (LOGIN) is used as the authentication method of MSM. 
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3. Click the Email tab. 

 

4. Enter the email address of a sender in New recipient email address, 
and click Add. 

 
 

5. Click OK when you finish the setting. 
 

 
You can send an email test event by clicking Test. After setting, send 
a test event to confirm that email notification can be sent properly. 

 

Title of transmitted email 

The title of the transmitted email is as follows: 

<Severify>: Vivaldi E-mail Notification: Event occurred on: <ServerName> 
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<Severity> stands for a severity level (INFO, WARNING, CRITICAL, or 
STOP). <Server Name> stands for a server name where the event 
occurred. 

The body of the email includes the event content and the date and time. 

However, ignore for the time and date. 

Example: 
 

Title:INFO: Vivaldi E-mail Notification: Event occurred on: XXXXXX 
 
Controller ID: 0 VD is now OPTIMAL VD 0  
Generated on:Sat Jun 09 13:56:42 2007 
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Setting Patrol Read 

Patrol Read periodically verifies and repairs bad sectors of each physical drive. 
Other normal functions take precedence in the IO processing, so that Patrol 
Read has almost no impact on performance. 

 

 
Do not disable Patrol Read while running. Stop Patrol Read first 
whenever you disable. 
To stop Patrol Read, select the controller and click Go To > Controller 
> Stop Patrol Read. 
Patrol Read does not support LSI Software RAID. Disable Patrol Read. 

 

Prerequisite 

Patrol Read setting including schedule management is configured in the 
hardware before shipment. The default setting of the schedule is 3 days. (We 
recommend that you use the factory default setting for the schedule.) 

If you start the system after the scheduled date and time of Patrol Read, 
Patrol Read starts immediately even when you change the setting through 
MSM. 

If you have implemented centralized management, be sure to set Patrol Read 
on the target server. 

Set the scheduler interval to 1 day or longer for this version. 

Use the following command to reset the interval setting to the factory default: 

MegaCli -AdpPR -SetDelay 72 -aALL 

Apply Patrol Read to all virtual drives and hot spares. 

1. Select the disk array controller in the Physical view or the Logical view. 
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2. Click Go to > Controller > Set Patrol Read Properties. 

 

3. The Patrol setting window opens. 

 
Set Patrol Read in detail as described below. 

• Select Patrol Read mode: 

Specifies the execution of Patrol Read. 

Automatic: Executes Patrol Read automatically. 

Manual: Executes Patrol Read manually. 

Disable: Disables Patrol Read. 

* We recommend that you execute Patrol Read by Automatic. 

• Maximum number of Physical drives allowed for Patrol Read 
concurrently: 

Specifies the maximum number of physical drives for which Patrol Read 
is executed. 

Use the default setting. 

* The number of connected physical drives is displayed by default. 

• Available Virtual drives: 

Displays the virtual drives for which Patrol Read can be executed. 
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• Included Virtual drives: 

Displays the virtual drives for which Patrol Read can be executed. 

* Typically, use Add All to set all virtual drives of Available Virtual 
drives to Included Virtual drives. 

 

 
When you set Select Patrol Read mode to Disable, click OK and go 
to step 5. 

4. Set an interval of executing Patrol Read. 

 
• Patrol Read Interval: 

• Hourly: Every hour 

• Daily: Every day 

• Weekly: Every week 

• Monthly: Every month (30 days) 

* Do not use (select) Run Patrol Read non-stop. 
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• Patrol Read Schedule: 

Specifies a starting date and time of a schedule. 

Selecting Perform Patrol Read when I press OK starts Patrol Read 
immediately regardless of the specified starting date and time of the 
schedule. 

Set the starting date and time of the schedule to later than or equal to 
the current time. 

 
Click OK. 

 
 

 
Minutes are cut off in the time displayed as Patrol Read Schedule. 
Therefore, the displayed time can be almost an hour earlier than the 
actual starting time. 

5. The dialog box for confirming the setting opens. Click OK. 
 

If you check Perform Patrol 
Read when I press OK 

If you do not check Perform 
Patrol Read when I press OK 
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6. The starting event is obtained in the message window, and the Patrol Read 
starts. 

 

 
Patrol Read does not start if disabled or already running. 
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Restrictions 

This section explains the restrictions on using MSM. 

• Do not use Go To > Controller > Load Configuration which is not 
supported. 

• Do not use Go To > Controller > Scan Foreign Configuration which is 
not supported.  

• RAID level change by Go To > Controller > Modify Drive Group is not 
supported. Only capacity expansion with the same RAID level is supported. 

Do not use this item for any purpose other than capacity expansion. 

• Do not use Go To > Controller > Set Adjustable Task Rates which is 
not supported. 

• Do not use Go To > Controller > Power Settings which is not supported. 

• Do not use Go To > Controller > Schedule Consistency Check which is 
not supported. 

• Do not use Go To > Controller > Set Consistency Check Properties 
which is not supported. 

• Do not use Go To > Controller > Enable SSD Guard which is not 
supported. 

• Do not use Go To > Controller > Disable SSD Guard which is not 
supported. 

• Do not use Go To > Controller > Enable Alarm which is not supported. 

• Do not use Go To > Controller > Disable Alarm which is not supported. 

• Do not use Go To > Controller > Manage Link Speed which is not 
supported. 

• Do not use Go To > Controller > Save TTY Log which is not supported. 

• Do not use Go To > Controller > Drive Erase which is not supported. 

• Do not use Go To > Controller > Virtual Drive Erase which is not 
supported. 

• In an environment where centralized management is conducted, make sure 
that you stop the MSM of the management PC before you start or restart a 
managed server. Starting a managed server with MSM running may hang 
up the MSM of the management PC. If the network fails due to a LAN cable 
disconnection or other causes while MSM Client is running on a managed 
server or a management server, the MSM Client window may disappear or 
a pop-up massage is displayed to prompt you to logon again. In such cases, 
the array configuration and the array controller are not displayed after you 
logon or restart the MSM Client. 
In such a case, check the network status and repair the fault. If the 
network connection status does not recover, restart the system unit before 
starting MSM Client. 
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• For Linux, only the root has the administrator privileges. You cannot logon 
the system by assigning the root privilege to an ordinary user name. 

• Disable any unused LAN adapter of the system unit. 

• Do not try an operation prohibited or not described in this manual. 

• Otherwise, the disk array malfunction or data inconsistency can be caused. 

• MSM does not support the operation on a guest OS of Hyper-V®. 

• If you logon MSM with the View Only permission, you are restricted to the 
following capabilities: 

• Outputting an event notification configuration to a file 

• Outputting an event log to a file 

• Only displaying and viewing information regarding other functions 

Logon with the View Only permission is allowed only for the accounts 
registered in the target server. 

• Logon with the Full Access permission is allowed only for the 
administrator accounts registered in a target server (For Windows: 
Administrator privilege; for Linux: root). 

• For Linux, CUI installation of MSM is not supported except for the 
standalone format. 

• If MSM is installed in the CUI environment of Linux, the only MSM 
functions that can be used are event output to Linux (var/log/messages) 
and some functions that use MegaCli (functions described in this manual 
such as consistency check). 

• When you execute a consistency check for a RAID device other than LSI 
Software RAID, stop Patrol Read beforehand. If you execute a consistency 
check while Patrol Read is running, the system unit may stop. 

• MSM does not support creation of a virtual drive that includes both HDD 
and SSD. 

• The maximum number of virtual drives created for a disk array controller is 
24. 

• The maximum number of virtual drives created for a disk group is 16. 

• Within a drive group, it is only possible to delete the last virtual drive that 
you created. 

To delete a virtual drive older than the last one, delete all the virtual 
drives from the last drive through the target one in descending order of 
creation. 

• Do not execute initialization if a consistency check is working for any other 
virtual drives in the same drive group. 

• Do not execute a consistency check if initialization is working for any other 
virtual drives in the same drive group. 
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• Capacity expansion is not supported for the case where there are multiple 
virtual drives in the drive group or there is a virtual drive that is not using 
the entire capacity of the drive group. 

• For a system unit with system memory of 4 GB or more, the following 
additional settings will improve the MSM performance. 

The amount of system memory used by MSM increases a maximum of 1 
GB than the standard setting. 

[Windows] 

(1) Move to the following folder: 
64bit OS: C:\Program Files (x86)\MegaRAID Storage Manager 
32bit OS: C:\Program Files\MegaRAID Storage Manager 

(2) Open the file startupui.bat, and change as follows: 
Before change: 
start JRE\bin\javaw -Duser.country....................... 
After change: 
start JRE\bin\javaw -Xms1024m -Xmx1024m -
Duser.country.................... 

[Linux] 

(1) Move to the following folder: 
/usr/local/MegaRAID Storage Manager 

(2) Open the file startupui.sh, and change as follows: 
Before change: 

LD_LIBRARY_PATH=$MSM_HOME/lib ./jre/bin/java -DVENUS=true.... 
After change: 

LD_LIBRARY_PATH=$MSM_HOME/lib ./jre/bin/java -Xms1024m -
Xmx1024m -DVENUS=true.... 

• In the following conditions, the event time in the MSM message window 
are displayed one day early. To find out the date and time of an MSM 
event occurrence, see the OS system log (var/log/messages): 

• Linux (UTC is not specified in the time zone setting of the system 
clock.) 

• LSI Software RAID  

• The system has been started in the time period between 15:00:00 and 
23:59:59. 

• The event is one of those that occur during system activation (for 
example, ID0: Firmware initialization started). 

• Do not use Suspend, Suspend All, and Suspend Patrol Read displayed 
in the task progress window which is not supported.  

• When you want to receive event notifications from the MSM by email, open 
port 25 and port 7 in your SMTP server's firewall. 
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Precautions 

This section explains precautions on using MSM. 

• The following messages may be displayed during installation on Linux: 

Warning: libstdc++34-3.4.0-1.i386.rpm: V3 DSA signature: NOKEY, key 
ID 4f2a6fd2 

The above message output does not have any impact. 

• The following messages are displayed during installation on Linux: 

Can not find snmptrap in /usr/bin 

Can not continue installation of LSI SAS Agent 

Please install the net-snmp agent 

The above messages indicate that the activation of the SNMP demon was 
not successful during MSM installation. You can ignore this message. 
Check whether snmp of Linux has been installed. 

• MSM installation on Linux sometimes was not successful when the 
following message is displayed: 

Example: error while loading shared libraries: libstdc++.so.5: cannot open 
shared object file: No such file or directory 

This phenomenon happens when libstdc++.so.5 has not been installed 
because Legacy Software Development was not selected during Linux 
installation. Check whether Legacy Software Development is set as an 
installation option. 

• For Linux OS (AMD/Intel 64), we recommend that you install all packages 
by selecting System > Compatibility Arch Support > Multilib support 
packages at the time of package installation. 

• Transmission of multicast packets 

If you have installed MSM in the complete format, multicast packets of 
class D are transmitted. The IP address is 229.111.112.12. 

If you do not conduct remote monitoring, we recommend that you install 
MSM in the standalone format. See "Installing and removing MegaRAID 
Storage Manager" on page 2-1 for details. 

• For both Windows and Linux, do not change the default setting for the 
MSM service activation. With the default setting, MSM automatically starts 
when the OS is launched. We do not guarantee that the MSM service starts 
normally for an activation method other than the automatic activation 
during OS start. 

• Consistency check 

Consistency check sometimes detects a data inconsistency. However, if 
both condition 1 and 2 below apply, the inconsistency does not affect the 
operation of the system unit. Ignore the warning in such a case. 

Condition 1: The virtual drive is of RAID1 or RAID10. 
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Condition 2: The virtual drive contains a partition to which Windows 
paging is made. 

The Windows specification presents apparent data inconsistency in page 
files.  

Windows sometimes updates the system memory before the RAID 
firmware finishes writing data in the physical drive of RAID1 (RAID10), 
and this causes data inconsistency. 

In the event of such a case for user data or other data that requires 
consistency, Windows later issues a write command to recover the data 
consistency. 

Thus the consistency for RAID1 (RAID10) is maintained, and the operation 
of the system unit is not affected. 

• During MSM operation, the MSM screen sometimes corrupts. In such a 
case, refresh the screen by minimizing and then maximizing the window 
for example. 

• MIB file 

For MIB of Windows, use the following file included in the "Server 
installation and monitoring tool DVD" or "Driver Kit CD". 

[ When "Server installation and monitoring tool DVD" is used ] 

Execute the following MegaRAID Storage Manager installer file while 
referring to "Support_EN.html" as attachment in the "Server installation 
and monitoring tool DVD". The directory path of MSM is different 
according to the system unit and OS. 

"d:(the target directory path)\lsi-adaptersas.mib" 

[ When "Driver Kit CD" is used ] 

"d:WIN2008\UTILITY\MSM\lsi-adaptersas.mib" 

* d stands for the CD/DVD drive. 

For Linux, use the following MIB file, which is expanded upon installation 
of SNMP. 

"./etc/lsi_mrdsnmp/sas/LSI-AdapterSAS.mib" 

• When you start MSM right after OS activation, wait about five minutes and 
then boot the OS. 

• For a system unit with SATA physical drive installed, the following message 
may be displayed when you click a physical drive icon on MSM. The 
message does not indicate a problem and may be ignorable. 

Controller ID: X Unexpected sense: PD = X - Invalid field in CDB, CDB = 
0x4d 0x00 0x4d 0x00 0x00 0x00 0x00 0x00 0x20 0x00, Sense = 0x70 
0x00 0x05 0x00 0x00 0x00 0x00 0x0a 0x00 0x00 0x00 0x00 0x24 0x00 
0x00 0x00 0x00 0x00 
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• If Failed of Audit Logon*1 is enabled*2, a Fail Audit event is recorded in 
the security log of Windows Events when MSM logon fails (due to, for 
example, a wrong user name or password). An example of Fail Audit is 
shown below. 

*1: The UI display may be different depending on the OS version and an 
environment. 

*2: Depending on the OS version, the default value may be Enable. 

*3: The account domain name sometimes is not displayed correctly. 

 
Account unsuccessful in logon: 

Security ID: XXXXXXXX 

Account name: YYYYYYYY 

Account domain: ZZZZZZZZ 

• OS warning log event: Write Cache Enabled 

When the write policy is set to Write Back and the server is used as a 
domain controller, the following event may be recorded in the Windows 
system log: 

 
Type Warning 

Source Disk 

Description The driver detected that the device \Device\Harddisk0\DR0 has its write cache 
enabled. Data corruption may occur. 

• The check item Policy > Enable write caching on the device of disk 
drive properties of the device manager depends on the write policy setting. 

The setting cannot be changed by changing this check item. To change the 
setting, change the write policy on MSM. 

• This disk array controller does not support SCSI commands that have the 
FUA bit. 

• Services MrMonitor and MrMonitor monitoring are not installed in MSM 
Ver.11.08.XX.XX or later. 
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Replacing a physical drive 

This section explains how to replace a physical drive in the event of a failure. 
 

 
In replacing a physical drive, make sure that you also read the manual 
that accompanies the system unit. 

 

 
If a system unit shuts down or reboots during the rebuild operation, 
the operation is suspended. The operation resumes from the point 
where the operation was suspended after the system unit is booted. 

 

With a hot spare 

If a physical drive fails in a virtual drive that has a hot spare configured, 
rebuild is automatically executed. During rebuild, the virtual drive is indicated 
by a yellow icon , and the physical drive icon becomes . 

1. Wait until rebuilding is finished. 

To confirm the progress of rebuilding, see "Displaying task progress and 
terminating a task" on page 2-157. 

2. When rebuilding finishes, replace the failed physical drive. 

A failed physical drive is indicated by a red icon  in the Physical and 
Logical views. 

The LED of the failed physical drive turns on. 

3. Wait 1 minute or more, and insert a new physical drive. 

4. Confirm that the error LED turns off and the substituted physical drive is 
indicated by a hot spare icon in the Physical and Logical views. 
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Without a hot spare 

If a fault occurs in a virtual drive, the virtual drive operates in the degraded 
mode. During the degraded operation, the virtual drive is indicated by a yellow 
icon , and the physical drive icon becomes red . 

1. Replace the failed physical drive. 

A failed physical drive is indicated by a red icon  in the Physical and 
Logical views. 

The LED of the failed physical drive turns on. 

2. Wait 1 minute or more, and insert a new physical drive. 

3. The substituted physical drive is rebuilt. 

It takes about 1 to 2 minutes until rebuilding starts. 

While rebuilding is running, the physical drive is indicted by the icon , 
and the error LED changes to blinking. 

4. After rebuilding is finished, confirm that the error LED turns off, and the 
substituted physical drive and the virtual drive are displayed as normal in 
the Physical and Logical views. 
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Operation of Disk Arrays 

This section explains how to operate disk arrays. 

 Daily operation 
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Daily operation 

Backup 

Use of disk arrays improves the reliability, but it does not protect data 
perfectly. Therefore, as the minimum preventive action, backup the data 
periodically. For details on how to make a backup, see the User's Guide 
(Hitachi Compute Rack xxxx User's Guide) of the system unit. 

 

 
As more data increases, it takes a longer time to back up the data. The 
backup time can be shortened by backing up only the difference files 
(including updated files or new ones). For how to backup the difference 
file, see the manual of the backup program you use. 
We recommend that you use four or five pieces of backup media and 
rotate them every day. 

Periodical consistency check of LSI Software RAID virtual drives 

If a bad sector (inaccessible area) is detected in a physical drive during data 
read or data write processing, replacement processing (replacement by a 
spare area) is automatically performed. This replacement processing, however, 
is not performed for a bad sector in the mirror data area or in an area that is 
not accessed in daily operation. If a physical drive fails in this status, 
rebuilding cannot be performed normally due to inability of reading the mirror 
data, resulting in loss of data of the bad sector. 

To avoid this status, make sure that you perform a consistency check 
periodically for LSI Software RAID. The consistency check reads data from 
all area of each physical drive to check if the mirror data is corrupted. For LSI 
Software RAID, make sure that you perform a consistency check about 
once a week. 

We recommend that you perform a consistency check after business hours 
because of significant decrease in system (disk access) performance during 
the check. For how to perform consistency check of a virtual drive, see 
"Consistency check of virtual drives" on page 2-118. 

 

 
RAID devices other than LSI Software RAID are configured as factory 
default so that Patrol Read verifies their physical drives periodically to 
correct bad sectors. Therefore, you do not have to execute a periodical 
consistency check for RAID devices other than LSI Software RAID. 
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Collecting/Operating event logs 

The event log records information including disk array status and error 
causes/factors. Each log is classified into four levels: Fatal, Critical, Warning, 
and Information. 

Collection of events makes it possible to locate the cause of an error early 
using the past log and take proper actions promptly, which minimizes the 
system down time. 

Collect logs regularly considering the following preconditions and log collection 
guidelines. 

Preconditions 

• Up to 3000 events can be saved in the current event log. 

• There are two logging methods: Save Log and Save Log Text. 

The following table shows their features. 
 

Save time for 3000 Events 
Logging method Format Capacity for 3000 

events (KB) MSM server  Management PC 

Save Log Xml Approx. 2500 Approx. 3 minutes Approx. 35 minutes 

Save Log Text Text Approx. 500 Approx. 2 minutes Approx. 2 minutes 

Log collection guidelines 

The number of events is calculated as follows with a system configuration and 
system operation under the following conditions: 

• Conditions 

• Number of HDDs in the system: 8 

• Number of logical devices: 4 

• Patrol read execution frequency: Once a week 

• Consistency check execution frequency: Once a week for all logical 
devices 

• System shutdown/reboot execution frequency: Once a week 

• Number of events that occur weekly 

• Number of events at system startup due to system shutdown/reboot: 
42 

• Number of patrol read events executed weekly: 6 maximum (1 time /3 
days, 2 events/time) 

• Number of consistency check events executed weekly: 8 (2 [start/end] 
x 4 logical devices) 
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Total of events per week: 56 

Total of events per year: 56 x 52 weeks = 2912 

This calculation of the number of events assumes no error. 

Therefore, semiannual log collection is recommended under the above 
conditions and operation. The Save Log Text logging method is also 
recommended. 

After events are collected, clear them with the Clear Log menu. 

The event log is registered as the Windows event viewer application log for 
Windows or as the system log (/var/log/messages) for Linux. 

 

 

 

 

 



 

4 
 

 In the Event of a Fault  

MegaRAID Storage Manager Instruction Manual 

4-1

In the Event of a Fault 

This section explains the troubleshooting procedures against disk array faults. 

 Troubleshooting procedures 
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Troubleshooting procedures 

Checking the status of both disk array and physical drives 

Check the status of both virtual drives and physical drives by MSM to verify 
what fault occurred. 

Checking events 

Check the event log in the MSM message window. If a fault-related event is 
recorded, contact the sales representative or call maintenance personnel. 
Some events are displayed as pop-up messages at the occurrence of an event. 

For Windows, before the pop-up notification window opens, the pop-up 
notification list is displayed as shown below. 

 

Select the target pop-up notification from Alerts and click Open Item to 
display the pop-up notification window as shown below. 

 
 

 
To close a pop-up notification window, click OK. 
In the pop-up notification list, click Dismiss All and then Yes to close 
the window. 
For Linux, pop-up windows are not displayed if no X Window has been 
launched. 
If a drive group includes multiple virtual drives, a failure of a physical 
drive causes all virtual drives of the drive group to be in a degraded 
operation (Degraded or Partially Degraded). 
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Data backup 

A failure of a physical drive can be recovered by replacing the physical drive. 
However, if rebuilding is not successful for some reason, data may be 
completely lost. Make sure that you create a data backup if a fault occurs. 

Contacting the maintenance company 

If you confirm any fault in the current system status, contact the sales 
representative or call maintenance personnel. 
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Appendix 

 

 Estimate of various processing time 

 Events list 

 Request sense data 

 List of services 

 List of processes 

 Port number 

 System log (in Linux) 
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Estimate of various processing time 

This section provides an estimate of the time required for processing by the 
system unit in the unloaded state. 

 

 
The processing time indication returns to 0 when it takes more than 18 
hours to process task. In this case, estimated time of completion is not 
displayed correctly due to continue the progress rate. 

 

 
The "unloaded state of the system unit" means the state in which you 
have installed on the system unit without only other applications, and 
the system unit is idle. The processing time given in this document is 
the processing when individual tasks run on the OS. 
The system unit has the feature* that dynamically varies the task rate 
depending on the IO load. 
This feature prioritizes IO processing over task processing, so that 
actual processing time can be 30 times or more the estimated 
processing time when the system is highly loaded. (It may take over a 
day.) 
* This feature shortens the task processing time by raising the task 

rate when there is no IO processing. 

Estimate of virtual drive initialization time (in the unloaded state of 
system unit) 

 

Physical drive capacity Initialization time 

147 GB (SAS 2.5-inch) Approx. 15 min 

250 GB (SATA 3.5-inch) Approx. 300 min 

80 GB (SSD SATA 2.5-inch) Approx. 10 min 

200 GB (SSD SATA 2.5-inch) Approx. 20 min 

250 GB (SATA 3.5-inch) (LSI Software RAID (built-in SATA RAID)) Approx. 9 hours 

 

 
The time required for initializing a virtual drive is proportional to the 
capacity of the physical drive, not to the capacity or the RAID level of 
the virtual drive. 
We recommend that you execute tasks when IO processing is less 
active (for example, at night). 
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Estimate of virtual drive consistency check time (in the unloaded 
state of system unit) 

 

RAID level Virtual drive capacity Consistency check 
time 

RAID 1 147 GB (SAS 2.5-inch: 147-GB HDD × 2) Approx. 15 min 

 250 GB (SATA 3.5-inch: 250-GB HDD × 2) Approx. 25 min 

 80 GB (SSD SATA 2.5-inch: 80-GB SSD × 2) Approx. 10 min 

 200 GB (SSD SAS 2.5-inch: 200-GB SSD × 2) Approx. 20 min 

RAID1 (LSI Software RAID 
(built-in SATA RAID)) 

250 GB (SATA 3.5-inch: 250-GB HDD × 2) Approx. 40 min 

RAID 5 294 GB (SAS 2.5-inch: 147-GB HDD × 3) Approx. 15 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 3) Approx. 25 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 3) Approx. 10 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 3) Approx. 25 min 

RAID 6 294 GB (SAS 2.5-inch: 147-GB HDD × 4) Approx. 15 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 4) Approx. 25 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 4) Approx. 10 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 4) Approx. 25 min 

RAID 10 294 GB (SAS 2.5-inch: 147-GB HDD × 4) Approx. 15 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 4) Approx. 25 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 4) Approx. 15 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 4) Approx. 45 min 

 

 
The time required for a consistency check of a virtual drive is 
proportional to the capacity of the virtual drive. 
This does not apply to the case when you execute a consistency check 
for multiple virtual drives simultaneously in the same group. 
We recommend that you execute tasks when IO processing is less 
active (for example, at night). 
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Estimate of rebuilding time (in the unloaded state of system unit) 
 

RAID level Virtual drive capacity Rebuild time 

RAID 1 147 GB (SAS 2.5-inch: 147-GB HDD × 2) Approx. 15 min 

 250 GB (SATA 3.5-inch: 250-GB HDD × 2) Approx. 30 min 

 80 GB (SSD SATA 2.5-inch: 80-GB SSD × 2) Approx. 10 min 

 200 GB (SSD SAS 2.5-inch: 200-GB SSD × 2) Approx. 10 min 

RAID1 (LSI Software RAID 
(built-in SATA RAID)) 

250 GB (SATA 3.5-inch: 250-GB HDD × 2) Approx. 50 min 

RAID 5 294 GB (SAS 2.5-inch: 147-GB HDD × 3) Approx. 15 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 3) Approx. 25 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 3) Approx. 10 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 3) Approx. 10 min 

RAID 6 294 GB (SAS 2.5-inch: 147-GB HDD × 4) Approx. 20 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 4) Approx. 50 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 4) Approx. 10 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 4) Approx. 10 min 

RAID 10 294 GB (SAS 2.5-inch: 147-GB HDD × 4) Approx. 15 min 

 500 GB (SATA 3.5-inch: 250-GB HDD × 4) Approx. 25 min 

 160 GB (SSD SATA 2.5-inch: 80-GB SSD × 4) Approx. 10 min 

 400 GB (SSD SAS 2.5-inch: 200-GB SSD × 4) Approx. 10 min 

 

 
The time required for rebuilding is proportional to the capacity of the 
physical drive, not to the capacity of the virtual drive. We recommend 
that you execute tasks when IO processing is less active (for example, 
at night). 
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Estimate of virtual drive capacity expansion time (in the unloaded 
state of the system unit) 

 
Manner of capacity expansion 

RAID 
level Hard structure 

Virtual drive capacity 
before carrying out 
capacity extension 

Virtual drive capacity after carrying out 
capacity extension 

Capacity 
expansion 

time 

RAID 0 SAS 2.5-inch: 147-
GB HDD × 3 441 GB 

558 GB 

(One set of 147-GB HDD is added ) 

Approx. 
100 min 

 SATA 3.5-inch: 250-
GB HDD × 3 750 GB 

1000 GB 

(One set of 250-GB HDD is added ) 

Approx.  

6 hours 

 SSD SATA 2.5-inch: 
80-GB SSD × 3 240 GB 

320 GB 

(One set of 80-GB SSD is added ) 

Approx.  

50 min 

 SSD SAS 2.5-inch: 
200-GB SSD × 3 600 GB 

800 GB 

(One set of 200-GB SSD is added ) 

Approx.  

70 min 

RAID 5 SAS 2.5-inch: 147-
GB HDD × 3 294 GB 

441 GB 

(One set of 147-GB HDD is added ) 

Approx.  

80 min 

 SATA 3.5-inch: 250-
GB HDD × 3 500 GB 

750 GB 

(One set of 250-GB HDD is added ) 

Approx.  

4 hours 

 SSD SATA 2.5-inch: 
80-GB SSD × 3 160 GB 

240 GB 

(One set of 80-GB SSD is added ) 

Approx.  

35 min 

 SSD SAS 2.5-inch: 
200-GB SSD × 3 400 GB 

600 GB 

(One set of 200-GB SSD is added ) 

Approx.  

50 min 

RAID 6 SAS 2.5-inch: 147-
GB HDD × 4 294 GB 

441 GB 

(One set of 147-GB HDD is added ) 

Approx.  

80 min 

 SATA 3.5-inch: 250-
GB HDD x 4 500 GB 

750 GB 

(One set of 250-GB HDD is added ) 

Approx.  

6 hours 

 SSD SATA 2.5-inch: 
80-GB SSD x 4 160 GB 

240 GB 

(One set of 80-GB SSD is added ) 

Approx.  

35 min 

 SSD SAS 2.5-inch: 
200-GB SSD x 4 400 GB 

600 GB 

(One set of 200-GB SSD is added ) 

Approx.  

50 min 

 

 
The time required for capacity expansion is proportional to the capacity 
of the target virtual drive. It does not depend on the number of 
physical drives to be added. 
We recommend that you execute tasks when IO processing is less 
active (for example, at night). 
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Events list 

This section lists the events that are recorded in the MSM log and Windows 
Event Viewer (or to the system log for Linux). 

Some events are notified by pop-up messages. 

For Windows, before the pop-up notification window appears, the pop-up 
notification list is displayed as shown below. 

(For Linux, pop-up windows are not displayed if no X Window has been 
launched.) 

 

Select the target pop-up notification from Alerts and click Open Item to 
display the pop-up notification window as shown below. 

 
 

 
Events that occurred during the period between power-on and OS 
activation are not recorded in the event log. 
All pop-up messages do not indicate faults. Confirm what event 
occurred. 
To close a pop-up notification window, click OK. 
On the pop-up notification list, click Dismiss All and then Yes to close 
the window. 
For Linux, pop-up windows are not displayed if no X Window has been 
launched. 

MSM registers events in Windows Event Viewer Application Log (or the system 
log for Linux). 
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Events are registered in the log of the server on which MSM Server 
has been installed. 

MSM registers events in Windows Event Viewer Application Log with source: 
MR_MONITOR. This applies also for Linux. 

 
 

 
 

Windows Server 2012 / 
Windows Server 2008 R2 / 
Windows Server 2008 

Windows Server 2003 R2 / 
Windows Server 2003 

The following items are described in the list of event log below. 

• Event ID: 

The identification number assigned to each event type 

• Level: 

The severity of an event 

• Fatal 

• Critical 

• Warning 

• Information 
 

 
The following are the types of the events registered in Windows Event 
Viewer Application Log: 

1. Fatal, Critical 
2. Warning 
3. Information 

• Remarks 

Added in Ver.x.xx-xx: Indicates that the event is supported from MSM 
version x.xx-xx. 

("x" in x.xx-xx varies depending on the MSM version.) 
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Actions for event notification 

As long as no hard disk is faulty, the system operation automatically recovers 
from events of Warning level and Caution level. In this case, no hard disk 
needs to be replaced. 

However, if the same event occurs repeatedly, the relevant hard disk should 
be replaced. 

To replace a hard disk, contact the dealer of purchase or call the maintenance 
personnel. 

Note that the security of data at an error event is not guaranteed. 
 

 
There are variable parts in a message as listed below. 

 

Notation Meaning 

<VDs> Logical drive number 

Example: 0 

<PDs> Enclosure number and device ID connected to hard disk 

[Enclosure number]: Displayed in the device ID format 

Since enclosure number varies depending on the system condition, ignore it. 

Example: 1:0 

<Version> Various versions 

Example: 1.02-0096 

<rate> The value of newly set rate 

Example: 30% 

<val> Newly set value 

Example: 10 

<date> Date and time 

Example: Aug 01 12:00:00 2007 

<sec> Elapse time [seconds] 

Example: 60 

<location> Event occurrence location (address) [hexadecimal] 

Example: 0x1000 

<strip> Event occurrence stripe number [hexadecimal] 

Example: 0x1000 

<setting> Setting value 

Example: BGI: Enabled 

<state> Status 

Example: Optimal 

<cdb> Command issued to hard disk 

Example: 0x28 0x00 0x00 0x12 0x00 0x00 0x00 0x00 0x80 0x00 

<sense> Request sense data received from hard disk 

Example: 0xf0 0x00 0x03 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x00 0x11 0x01 
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List of MegaRAID Storage Manager events 
 
Event 

ID Category Level Message Description and required action Remarks 

0 CTRL Information Firmware initialization started  
(PCI ID 
0xXXXX/0xXXXX/0xXXXX/ 
0xXXXX) 

Disk array controller has started 
firmware initialization. 

Action is not required. 

 

1 CTRL Information Image version <version> The firmware version of disk array 
controller. 

Action is not required. 

 

4 CONFIG Information Configuration cleared Configuration information has 
been initialized. 

Action is not required. 

 

7 CTRL Information Alarm disabled by user The user disabled the buzzer of 
disk array controller. 

Action is not required. 

 

8 CTRL Information Alarm enabled by user The user enabled the buzzer of 
disk array controller. 

Action is not required. 

 

9 CTRL Information Background initialization rate 
changed <rate> 

The rate of background 
initialization has been changed. 

Action is not required. 

 

10 CTRL Warning Controller cache discarded due to 
memory/battery problems. 

Power-off or reboot has been done 
inappropriately during write 
processing. Or power-off or reboot 
has been done during consistency 
check, rebuild, Patrol Read, or 
initialization. This is not a problem 
of cache memory or battery. 
Action is not required. 

If this event is registered during 
system activation made after a 
hang-up of the system unit, cache 
memory might have a problem. In 
this case, contact the sales 
representative or call maintenance 
personnel. 

 

11 CTRL Fatal Unable to recover cache data due 
to configuration mismatch 

There was a mismatch in the 
configuration data, so that the 
cache data could not be recovered. 
Some data may have been lost. 

We recommend that you 
reconfigure the disk array and 
restore the data from the backup. 

 

12 CTRL Information Cache data recovered 
successfully 

Succeeded in the recovery of 
cache data. 

Action is not required. 
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13 CTRL Fatal Controller cache discarded due to 
firmware version incompatibility 

Cache data was discarded due to 
incompatibility of the firmware 
version of disk array controller 
board. 

Some data may have been lost. 

We recommend that you 
reconfigure the disk array and 
restore the data from the backup. 

 

14 CTRL Information Consistency Check rate changed 
<rate> 

The rate of a consistency check 
has been changed. 

Action is not required. 

 

15 CTRL Fatal Fatal firmware error : <code> A fatal error has been detected in 
the firmware. 

Contact the sales representative or 
call maintenance personnel. 

 

16 CTRL Information Factory defaults restored The hardware setting of disk array 
controller has been reset to the 
factory default. 

Action is not required. 

 

17 CTRL Warning Flash downloaded image corrupt The firmware image used for 
update is corrupted. 

Use a good firmware image. 

 

18 CTRL Critical Flash erase error Initialization of flash memory 
failed. 

Contact the sales representative or 
call maintenance personnel. 

 

19 CTRL Critical Flash timeout during erase A timeout occurred during the 
initialization of the flash memory. 

Contact the sales representative or 
call maintenance personnel. 

 

20 CTRL Critical Flash error Access to flash memory failed. 

Contact the sales representative or 
call maintenance personnel. 

 

21 CTRL Information Flashing image <version> Updating the firmware or other 
image. 

Action is not required. 

 

22 CTRL Information Flash of new firmware image(s) 
complete 

Update of disk array controller has 
been completed. 

Action is not required. 

 

23 CTRL Critical Flash programming error Failed in writing into flash 
memory. 

Contact the sales representative or 
call maintenance personnel. 

 

24 CTRL Critical Flash timeout during 
programming 

A timeout occurred during writing 
data into flash memory. 

Contact the sales representative or 
call maintenance personnel. 
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25 CTRL Critical Flash chip type unknown This flash memory is unknown. 

Contact the sales representative or 
call maintenance personnel. 

 

26 CTRL Critical Flash command set unknown This flash command is unknown. 

Contact the sales representative or 
call maintenance personnel. 

 

27 CTRL Critical Flash verify failure An error occurred during flash 
memory verification. 

Contact the sales representative or 
call maintenance personnel. 

 

28 CTRL Information Flush rate changed <val> 
Seconds. 

The cache flash timing rate of disk 
array controller has been changed. 

Action is not required. 

 

29 CTRL Information Hibernate command received 
from host 

The host has issued the command 
to enter standby mode or 
hibernate mode. 

Action is not required. 

 

31 CTRL Information Event log wrapped The event log has wrapped in the 
disk array controller. No action is 
needed. 

 

32 CTRL Fatal Multi-bit ECC error: 
ECAR=<address> 

A multi-bit error has been detected 
in cache memory of disk array 
controller. 

Contact the sales representative or 
call maintenance personnel. 

 

33 CTRL Warning Single-bit ECC error: 
ECAR=<address> 

A single-bit error has been 
detected in cache memory of disk 
array controller. 

The error should have been 
corrected and action is not 
required. However, if this error 
occurs frequently, contact the 
sales representative or call 
maintenance personnel. 

 

34 CTRL Fatal Not enough controller memory A required memory space cannot 
be obtained in disk array 
controller. 

Contact the sales representative or 
call maintenance personnel. 

 

35 CTRL Information Patrol Read complete Patrol Read has been completed. 

Action is not required. 

 

36 CTRL Information Patrol Read paused Patrol Read has temporarily 
stopped. 

Action is not required. 

 

37 CTRL Information Patrol Read Rate changed 
<rate> 

Patrol Read rate has been 
changed. 

Action is not required. 

 

38 CTRL Information Patrol Read resumed Patrol Read has started again. 

Action is not required. 
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39 CTRL Information Patrol Read started Patrol Read has started. 

Action is not required. 

 

40 CTRL Information Rebuild rate changed <rate> The rebuilding rate has been 
changed. 

Action is not required. 

 

41 CTRL Information Reconstruction rate changed 
<rate> 

The rate of capacity expansion 
processing rate has been changed. 

Action is not required. 

 

42 CTRL Information Shutdown command received 
from host 

The host issued a shutdown 
command. 

Action is not required. 

 

43 CTRL Information Test event:  This is a test event. 

Action is not required. 

 

44 CTRL Information Time established since power on 
Time <date> <sec>Seconds. 

The time point when disk array 
controller started and the time 
elapsed since then. 

Action is not required. 

 

45 CTRL Information User entered firmware debugger The firmware debugger has 
started. 

Action is not required. 

 

46 VD Warning Background Initialization aborted 
on VD <VDs> 

The background initialization has 
stopped. 

Action is not required if the user 
stopped it. If it stopped by a cause 
other than a user operation, check 
the physical drive for failures. 

 

47 VD Information Background Initialization 
corrected medium error (<VDs> 
Location <location>, PD <PDs> 
Location <location>). 

The medium error that occurred 
during background initialization 
has been repaired. 

Action is not required. 

 

48 VD Information Background Initialization 
completed on VD <VDs> 

The background initialization has 
been completed. 

Action is not required. 

 

49 VD Warning Background Initialization 
completed with uncorrectable 
errors on VD <VDs> 

The background initialization has 
been completed, but there is an 
unrecoverable error. 

Initialize (Full Initialize) the 
virtual drive. 

 

50 VD Warning Background Initialization 
detected uncorrectable multiple 
medium errors (PD <PDs> 
Location <location> VD <VDs> 
Location <location>) 

The background initialization has 
been completed, but there is an 
unrecoverable medium error. 

Initialize (Full Initialize) the 
virtual drive. 

 

51 VD Critical Background Initialization failed 
on VD <VDs> 

The background initialization has 
unsuccessfully terminated. 

Check the physical drive for 
failures. 
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53 VD Information Background Initialization started 
on VD <VDs> 

The background initialization has 
started. 

Action is not required. 

 

54 VD Information Policy change on VD <VDs> 
Previous = <setting> Current = 
<setting> 

The policy of the virtual drive has 
been changed. 

Action is not required. 

 

56 VD Warning Consistency Check aborted on 
VD <VDs> 

The consistency check has 
stopped. 

Action is not required if the user 
stopped it. If it was stopped by 
some other cause, contact the 
sales representative or call 
maintenance personnel. 

 

57 VD Information Consistency Check corrected 
medium error (<VDs> Location 
<location>, PD <PDs> Location 
<location>). 

A medium error was detected 
during consistency check, and it 
has been corrected. 

Action is not required. 

 

58 VD Information Consistency Check done on VD 
<VDs> 

The consistency check has been 
completed. 

Action is not required. 

 

59 VD Information Consistency Check done with 
corrections on VD <VDs> 

The consistency check has been 
completed, but an inconsistency 
has been detected. 

No action is needed. 

For RAID1 
and RAID10, 
see 
"Consistency 
check" of 
"Precautions"
on page 2-
187 for the 
action to be 
taken. 

60 VD Warning Consistency Check detected 
uncorrectable multiple medium 
errors (PD <PDs> Location 
<location> VD <VDs>) 

An unrecoverable medium error 
was detected during consistency 
check. 

Medium errors have occurred at 
the same address in multiple 
physical drives. This phenomenon 
happens when a medium error 
occurs at the source drive during 
rebuild. We recommend that you 
initialize the virtual drive and 
restore the data from the backup. 

 

61 VD Critical Consistency Check failed on VD 
<VDs> 

The consistency check has 
unsuccessfully terminated. 

Check the physical drive for faults. 
If a fault has been detected, 
contact the sales representative or 
call maintenance personnel. 
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62 VD Warning Consistency Check completed 
with uncorrectable errors on VD: 

The consistency check has 
finished, but an unrecoverable 
error has been detected. 

Medium errors have occurred at 
the same address in multiple 
physical drives. This phenomenon 
happens when a medium error 
occurs at the source drive during 
rebuild. We recommend that you 
initialize the virtual drive and 
restore the data from the backup. 

 

63 VD Warning Consistency Check found 
inconsistent parity on VD strip 
(VD = <VDs>, strip = <strip>) 

Data inconsistency has been 
detected in consistency check. 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

For RAID1 
and RAID10, 
see 
"Consistency 
check" of 
"Precautions"
on page 2-
187 for the 
action to be 
taken. 

64 VD Warning Consistency Check inconsistency 
logging disabled, too many 
inconsistencies on VD <VDs>. 

Consistency check has detected 10 
or more locations of data 
inconsistency. Data inconsistency 
events will not be output anymore. 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

For RAID1 
and RAID10, 
see 
"Consistency 
check" of 
"Precautions"
on page 2-
187 for the 
action to be 
taken. 

66 VD Information Consistency Check started on VD 
<VDs> 

The consistency check has started. 

Action is not required. 

 

67 VD Warning Initialization aborted on VD 
<VDs> 

Initialization of the virtual drive 
has stopped. 

Action is not required if the user 
stopped it. If it was stopped by 
some other cause, contact the 
sales representative or call 
maintenance personnel. 

 

68 VD Critical Initialization failed on VD <VDs> Initialization of the virtual drive 
has failed. 

Check whether there is a fault in 
the physical drive. If you find a 
fault, contact the sales 
representative or call maintenance 
personnel. 

 

70 VD Information Fast initialization started on VD 
<VDs> 

Initialization (fast mode) of the 
virtual drive has started. 

Action is not required. 

 

71 VD Information Full initialization started on VD 
<VDs> 

Initialization (full mode) of the 
virtual drive has started. 

Action is not required. 
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72 VD Information Initialization complete on VD 
<VDs> 

Initialization of the virtual drive 
has been completed. 

Action is not required. 

 

73 VD Information Properties updated on <VDs> 
Previous = <settings> Current = 
<settings> 

The properties of the virtual drive 
have been updated. 

Action is not required. 

 

74 VD Information Reconstruction complete on VD 
<VDs> 

Capacity expansion of the virtual 
drive has been completed. 

Action is not required. 

 

75 VD Fatal Reconstruction stopped due to 
unrecoverable errors VD <VDs>. 

Capacity expansion of the virtual 
drive has stopped due to an 
unrecoverable error. 

Contact the sales representative or 
call maintenance personnel. 

 

76 VD Warning Reconstruct detected 
uncorrectable multiple medium 
errors (VD <VDs> Location 
<location>,PD <PDs> Location 
<location>) 

Medium errors have occurred at 
the same address in multiple 
physical drives during capacity 
expansion of the virtual drive. This 
phenomenon happens when a 
medium error occurs at the source 
drive during rebuild. 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

 

78 VD Information Reconstruction resumed VD 
<VDs> 

Capacity expansion processing has 
been started again. 

Action is not required. 

 

79 VD Fatal Reconstruction resume failed due 
to configuration mismatch 

The capacity expansion could not 
be started again due to a 
configuration data mismatch. 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

 

80 VD Information Reconstructing started VD 
<VDs> 

Capacity expansion of the virtual 
drive has started. 

Action is not required. 

 

81 VD Information State change on VD <VDs> 
Previous = <state> Current = 
<state> 

The state of the virtual drive has 
changed. 

Action is not required. 

 

87 PD Critical Error <PDs> An error has occurred in the 
physical drive. 

Check the physical drive for 
failures. If you find a fault, contact 
the sales representative or call 
maintenance personnel. 

 

88 PD Information Format complete: Low level formatting has been 
completed. 

Action is not required. 

 

89 PD Information Format started: Low level formatting has started. 

Action is not required. 
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91 PD Information PD inserted <PDs> The physical drive has been 
inserted. 

Action is not required. 

"Precautions" 
on page 2-
187  

92 PD Warning PD is not supported: The device type is not supported. 

Use a supported physical drive. 

 

93 PD Information Patrol Read corrected medium 
error: PD <PDs> Location 
<location> 

The medium error detected by 
Patrol Read has been repaired. 

Action is not required. 

 

95 PD Warning Patrol Read found an 
uncorrectable medium error PD 
<PDs> Location <location> 

A medium error that cannot be 
repaired by Patrol Read has been 
detected. 

Medium errors have occurred at 
the same address in multiple 
physical drives. This phenomenon 
happens when a medium error 
occurs at the source drive during 
rebuild. We recommend that you 
initialize the virtual drive and 
restore the data from the backup. 

 

96 PD Critical Predictive failure: The physical drive reported a 
SMART error. Replace the physical 
drive as a preventive action. 

 

97 PD Information Puncturing bad block PD <PDs> 
Location <location> 

A medium error has been created 
in the physical drive. 

During rebuild, if a medium error 
occurs in the source drive or at the 
same address of multiple physical 
drives when writing data, a 
medium error is intentionally 
created to inhibit data access 
(because the data integrity cannot 
be guaranteed). 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

 

98 PD Warning Rebuild aborted by user PD 
<PDs> 

Rebuilding has been stopped by 
user operation. 

Execute rebuild again if necessary. 

 

99 PD Information Rebuild complete on <VDs> Rebuilding has been completed. 

Action is not required. 

 

100 PD Information Rebuild complete Rebuilding has been completed. 

Action is not required. 

 

101 PD Critical Rebuild failed due to source drive 
error PD <PDs> 

Rebuilding failed due to an error at 
the source drive. 

Contact the sales representative or 
call maintenance personnel. 

 

102 PD Critical Rebuild failed due to target drive 
error PD <PDs> 

Rebuilding has failed due to an 
error at the target drive. 

Contact the sales representative or 
call maintenance personnel. 
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104 PD Information Rebuild resumed PD <PDs> Rebuilding has started again. 

Action is not required. 

 

105 PD Information Rebuild started PD <PDs> Rebuilding has started. 

Action is not required. 

 

106 PD Information Rebuild automatically started PD 
<PDs> 

Rebuilding has started 
automatically for the hot spare. 

Action is not required. 

 

108 PD Warning Reassign write operation failed: Failed in getting a substitute area 
for the physical drive. 

Check the physical drive for 
failures. If you find a fault, contact 
the sales representative or call 
maintenance personnel. 

 

109 PD Warning Unrecoverable medium error 
during rebuild: 

A medium error has been detected 
during rebuild. Some data might 
have been lost. 

We recommend that you initialize 
the virtual drive and restore the 
data from the backup. 

 

110 PD Information Corrected medium error during 
recovery PD <PDs> Location 
<location> 

The medium error has been 
repaired. 

Action is not required. 

 

111 PD Warning Unrecoverable medium error 
during recovery PD <PDs> 
Location <location> 

A medium error has been 
detected, but it could not be 
repaired. 

This message is output when a 
medium error occurs at the same 
address of physical drives or in a 
configuration without redundancy. 
Initialization of the virtual drive 
and restoration of backup data are 
recommended. 

 

112 PD Warning PD removed <PDs> The physical drive has been 
disconnected. 

If you have intentionally removed 
the physical drive, action is not 
required. 
In other cases, contact the sales 
representative or call maintenance 
personnel. 

The level was 
corrected in 
Ver.2.67-02. 
"Precautions" 
on page 2-
187. 

113 PD Warning Unexpected sense PD = <PDs>, 
CDB = <cdb>, Sense = <sense> 

Request sense data has been 
obtained from the physical drive. 

Check the physical drive for 
failures. If no fault is found, this 
situation should have been 
handled properly, and action is not 
required. 

For details on the request sense 
data, see "Request sense data" on 
page 5-38. 
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114 PD Information State change PD = <PDs> 
Previous = <state> Current = 
<state> 

The status of the physical drive 
has changed. 

Action is not required. 

 

115 PD Information State change by user: The status of the physical drive 
has changed. 

Action is not required. 

 

118 PD Warning Dedicated Hot Spare PD <PDs> 
no longer useful due to deleted 
array 

The dedicated hot spare 
configured for the deleted disk 
array has not been used for a long 
time. 

Remove the hot spare once, and 
configure it again. 

 

119 SAS Critical SAS topology error: Loop 
detected 

SAS topology error: A loop 
connection has been detected. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

120 SAS Critical SAS topology error: Device not 
addressable 

SAS topology error: The device 
could not be addressed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

121 SAS Critical SAS topology error: Multiple 
ports to the same SAS address 

SAS topology error: Multiple ports 
have the same SAS address. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

122 SAS Critical SAS topology error: Expander 
error 

SAS topology error: The expander 
has failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

123 SAS Critical SAS topology error: SMP timeout SAS topology error: SMP timeout 
has occurred. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

124 SAS Critical SAS topology error: Out of route 
entries 

SAS topology error: An entry is 
out of route. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

125 SAS Critical SAS topology error: Index not 
found 

SAS topology error: The index 
cannot be found. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

126 SAS Critical SAS topology error: SMP function 
failed 

SAS topology error: SMP function 
has failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

127 SAS Critical SAS topology error: SMP CRC 
error 

SAS topology error: SMP has a 
CRC error. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  
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128 SAS Critical SAS topology error: Multiple 
subtractive 

SAS topology error: Multiple 
subtractive 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

129 SAS Critical SAS topology error: Table to 
table 

SAS topology error: Table to table 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

130 SAS Critical SAS topology error: Multiple 
paths 

SAS topology error: Multiple paths. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

131 PD Fatal Unable to access device PD 
<PDs> 

The device cannot be accessed. 

Use a supported physical drive. If 
this problem still happens with a 
supported physical drive, contact 
the sales representative or call 
maintenance personnel. 

 

132 PD Information Dedicated Hot Spare created PD 
<PDs> 

The dedicated hot spare has been 
created. 

Action is not required. 

 

133 PD Information Dedicated Hot Spare disabled PD 
<PDs> 

The dedicated hot spare has been 
disabled. 

Action is not required. 

 

134 PD Critical Dedicated Hot Spare <PDs> no 
longer useful for all arrays 

The dedicated hot spare has not 
been used for a long time. 

Action is not required. 

 

135 PD Information Global Hot Spare created <PDs> The global hot spare has been 
created. 

Action is not required. 

 

136 PD Information Global Hot Spare disabled <PDs> The global hot spare has been 
disabled. 

Action is not required. 

 

137 PD Critical Global Hot Spare does not cover 
all arrays <PDs> 

There is no virtual drive that can 
be protected by the global hot 
spare. 

As a hot spare, use a physical 
drive whose capacity is the same 
as the physical drives of a virtual 
drive. 

 

138 VD Information Created VD <VDs> The virtual drive has been created. 

Action is not required. 

 

139 VD Information Deleted VD <VDs> The virtual drive has been deleted. 

Action is not required. 

 

140 VD Warning VD Marked inconsistent due to 
active writes at shutdown 

The system has been shutdown 
during the write processing. 

We recommend that you restore 
the data from the backup. 

 

141 BBU Information Battery Present Cache backup is enabled. 

Action is not required. 

Added in 
Ver.8.31-01 
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142 BBU Warning Battery Not Present Cache backup is disabled. 
Check the cable connection of 
cache backup. 
In other cases, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.31-01 

143 BBU Information New Battery Detected A new cache backup module has 
been connected. Action is not 
required. 

Added in 
Ver.8.31-01 

144 BBU Information Battery has been replaced The cache backup module has 
been replaced. 

Action is not required. 

Added in 
Ver.8.31-01 

145 BBU Warning Battery temperature is high The cache backup module has high 
temperature. 

If ID 149 is issued within one 
minute of this event, ignore this 
event. 
Check the environmental 
temperature and the fan for any 
abnormality. In other cases, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01 

146 BBU Warning Battery voltage low The voltage of the cache backup 
module is low. 
If this event occurs repeatedly 
during system operation, contact 
the sales representative or call 
maintenance personnel. 

When this event log is output after 
booting the system unit from the 
situation that the system unit was 
turned off, no action is needed. 

Added in 
Ver.8.31-01 

147 BBU Information Battery started charging The cache backup module has 
started battery charging. Action is 
not required. 

Added in 
Ver.8.31-01  

148 BBU Information Battery is discharging The cache backup module is 
discharging. Action is not required. 

Added in 
Ver.8.31-01  

149 BBU Information Battery temperature is normal The temperature of the cache 
backup module has returned to a 
normal level. Action is not 
required. 

Added in 
Ver.8.31-01 

150 BBU Fatal Battery has failed and cannot 
support data retention. Please 
replace the battery. 

The cache backup module has 
failed and cannot hold data. 
Contact the sales representative or 
call maintenance personnel. 

Ignore this event when this event 
occurs just after the system 
startup. 

Added in 
Ver.8.31-01 

151 BBU Information Battery relearn started The diagnosis of the cache backup 
module has started. Action is not 
required. 

Added in 
Ver.8.31-01 

152 BBU Information Battery relearn in progress The diagnosis of the cache backup 
module is in progress. Action is not 
required. 

Added in 
Ver.8.31-01 
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153 BBU Information Battery relearn completed The diagnosis of the cache backup 
module has been completed. 
Action is not required. 

Added in 
Ver.8.31-01 

154 BBU Information Battery relearn timed out A timeout occurred during the 
diagnosis of the cache backup 
module. Action is not required. 

Added in 
Ver.8.31-01 

155 BBU Information Battery relearn pending: Battery 
is under charge 

The diagnosis of the cache backup 
module is suspended. The cache 
backup module is being charged. 
Action is not required. 

Added in 
Ver.8.31-01 

156 BBU Information Battery relearn postponed The diagnosis of the cache backup 
module has been postponed. 
Action is not required. 

Added in 
Ver.8.31-01  

157 BBU Information Battery relearn will start in 4 
days 

The diagnosis of the cache backup 
module will start 4 days later. 
Action is not required. 

Added in 
Ver.8.31-01 

158 BBU Information Battery relearn will start in 2 day The diagnosis of the cache backup 
module will start 2 days later. 
Action is not required. 

Added in 
Ver.8.31-01 

159 BBU Information Battery relearn will start in 1 day The diagnosis of the cache backup 
module will start 1 day later. 
Action is not required. 

Added in 
Ver.8.31-01 

160 BBU Information Battery relearn will start in 5 
hours 

The diagnosis of the cache backup 
module will start 5 hours later. 
Action is not required. 

Added in 
Ver.8.31-01 

161 BBU Warning Battery removed The cache backup module has 
been disconnected. Check the 
cable connection of cache backup 
module. In other cases, contact 
the sales representative or call 
maintenance personnel. 

Added in 
Ver.8.31-01 

162 BBU Warning Current capacity of the battery is 
below threshold 

The capacity of the cache backup 
module is below the threshold. 
Action is not required. 

Added in 
Ver.8.31-01  

163 BBU Information Current capacity of the battery is 
above threshold 

The capacity of the cache backup 
module is above the threshold. 
Action is not required. 

Added in 
Ver.8.31-01  

164 ENCL Information SES enclosure discovered:Port % A SES enclosure has been 
discovered. 

Action is not required. 

Added in 
Ver.8.10-04 

165 ENCL Information SAF-TE enclosure 
discovered:Port % 

A SAF-TE enclosure has been 
discovered. 

Action is not required. 

Added in 
Ver.8.10-04 

166 ENCL Critical Communication lost on 
enclosure:Port % 

Communication with the enclosure 
has been lost. 

Check whether the enclosure is 
properly connected and powered 
on. In other cases, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 
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167 ENCL Information Communication restored on 
enclosure:Port % 

Communication with the enclosure 
has resumed. 

Action is not required. 

Added in 
Ver.8.10-04 

168 ENCL Critical Fan failed on enclosure:Port % % The fan of the enclosure has failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

169 ENCL Information Fan inserted on 
enclosure:Port % % 

The fan of the enclosure has been 
connected. 

Action is not required. 

Added in 
Ver.8.10-04 

170 ENCL Warning Fan removed on 
enclosure:Port % % 

The fan in the enclosure has been 
disconnected. 

Check the connection and the 
power of the ESM unit. In other 
cases, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.10-04 

171 ENCL Critical Power supply failed on 
enclosure:Port % Power 
supply % 

The power unit in the enclosure 
has failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

172 ENCL Information Power supply inserted on 
enclosure:Port % Power 
supply % 

The power unit in the enclosure 
has been connected. 

Action is not required. 

Added in 
Ver.8.10-04 

173 ENCL Warning Power supply removed on 
enclosure:Port % Power 
supply % 

The power unit in the enclosure 
has been disconnected. 

Check whether the enclosure is 
properly connected and powered 
on. In other cases, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 

174 ENCL Critical ESM failed on 
enclosure:Port % % 

The ESM unit in the enclosure has 
failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

175 ENCL Information ESM inserted on 
enclosure:Port % % 

The ESM unit in the enclosure has 
been connected. 

Action is not required. 

Added in 
Ver.8.10-04 

176 ENCL Critical SIM removed on 
enclosure:Port % % 

The SIM in the enclosure has been 
disconnected. 

Check the connection and the 
power of the ESM unit. In other 
cases, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.10-04 

177 ENCL Warning Temperature sensor below 
warning threshold on 
enclosure:Port % % 

The enclosure temperature is 
below the warning threshold of the 
temperature sensor. 

Check the environmental 
temperature and the fan for any 
abnormality. 

Added in 
Ver.8.10-04 
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178 ENCL Critical Temperature sensor below error 
threshold on enclosure:Port % % 

The enclosure temperature is 
below the error threshold of the 
temperature sensor. 

Check the environmental 
temperature and the fan for any 
abnormality. If there may be other 
abnormalities, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.10-04 

179 ENCL Warning Temperature sensor above 
warning threshold on 
enclosure:Port % % 

The enclosure temperature is 
above the warning threshold of the 
temperature sensor. 

Check the environmental 
temperature and the fan for any 
abnormality. 

Added in 
Ver.8.10-04 

180 ENCL Critical Temperature sensor above error 
threshold on enclosure:Port % % 

The enclosure temperature is 
above the error threshold of the 
temperature sensor. 

Check the environmental 
temperature and the fan for any 
abnormality. In other cases, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

181 ENCL Critical Enclosure shutdown The enclosure has been shutdown. 
Action is not required. 

If the enclosure is not shutdown 
intentionally, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.10-04 

182 ENCL Warning Too many enclosures connected 
to port. Enclosure not supported; 

Enclosures cannot be supported 
because the number of enclosure 
connections exceeds the supported 
number. 

Check the number of enclosure 
connections. If the number of 
connections is normal, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 

183 ENCL Critical Firmware mismatch on 
enclosure: 

A firmware mismatch has 
happened in the enclosure. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

184 ENCL Warning Sensor bad on enclosure: The sensor of the enclosure is 
abnormal. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

185 ENCL Critical Phy is bad on enclosure: The phy of the enclosure is 
abnormal. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

186 ENCL Critical Unstable Enclosure: The sensor of the enclosure is 
abnormal. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 
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187 ENCL Critical Hardware error on enclosure: A hardware error has occurred in 
the enclosure. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

188 ENCL Critical No response from enclosure: The enclosure returns no 
responses. 

Check whether the enclosure is 
properly connected and powered 
on. In other cases, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 

189 ENCL Critical SAS/SATA mixing not supported 
in enclosure; disabled PD <PDs> 

Both SAS and SATA physical drives 
exists in the enclosure, so that 
they cannot be used. 

Use a supported physical drive. 

 

190 ENCL Information Unsupported hotplug was 
detected on SES enclosure: 

An unsupported hot plug has been 
detected in the SES enclosure. 

Check the connections of the parts 
mounted on the enclosure. 

Added in 
Ver.8.10-04 

193 PD Critical PD too small to be used for auto-
rebuild: 

The capacity of the substituted 
physical drive is too small for 
starting rebuild. 

Replace with a physical drive of an 
adequate capacity. 

 

194 BBU Information BBU enabled; changing WT 
logical drives to WB 

The cache backup function has 
been enabled. 
The write policy has been changed 
from WT to WB. 
Action is not required. 

Added in 
Ver.8.31-01 

195 BBU Warning BBU disabled; changing WB 
logical drives to WT 

The cache backup function has 
been disabled. 

The write policy was changed from 
WB to WT. 

If this event repeatedly occurs not 
during the diagnosis of the cache 
backup module (ID 152), check 
the cable connection of the cache 
backup module. If the cable 
connection has no problems, 
contact the sales representative or 
call maintenance personnel. 

When this event log is output after 
booting the system unit from the 
situation that the system unit was 
turned off, no action is needed. 

Added in 
Ver.8.31-01 

196 PD Warning Bad block table is 80% full on PD 
<PDs> 

The remaining substitute area for 
bad blocks is running short. 
Occurrence of a bad block without 
an available substitute area causes 
a disk fault. 
Collect the backup data, and 
contact the sales representative or 
call maintenance personnel. 
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197 PD Critical Bad block table is full; unable to 
log block: 

The substitute area for bad blocks 
has been exhausted. 
Occurrence of a bad block without 
an available substitute area causes 
a disk fault. 
Collect the backup data, and 
contact the sales representative or 
call maintenance personnel. 

 

200 BBU Critical Battery/charger problems 
detected; SOH Bad 

A fault was detected in the cache 
backup module. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

201 CTRL Warning Single-bit ECC error; warning 
threshold exceeded 

The number of single-bit errors 
detected in cache memory of the 
disk array controller has exceeded 
the threshold. 

Contact the sales representative or 
call maintenance personnel. 

 

202 CTRL Critical Single-bit ECC error; critical 
threshold exceeded 

The number of single-bit errors 
detected in cache memory of the 
disk array controller has exceeded 
the threshold. 

Contact the sales representative or 
call maintenance personnel. 

 

203 CTRL Critical Single-bit ECC error; further 
reporting disabled 

The number of single-bit errors 
detected in cache memory of the 
disk array controller has exceeded 
the threshold. 

Contact the sales representative or 
call maintenance personnel. 

 

204 ENCL Warning Power supply switched off for 
enclosure:Port % Power 
supply % 

The power to the enclosure has 
been turned off. 

Action is not required. If the 
power-off is not intentional, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

205 ENCL Information Power supply switched on for 
enclosure:Port % Power 
supply % 

The power for the enclosure has 
been turned on. 

Action is not required. 

Added in 
Ver.8.10-04 

206 ENCL Warning Power supply cable removed on 
enclosure:Port % Power 
supply % 

The power cable in the enclosure 
has been disconnected. 

Check whether the power cable 
has been removed. In other cases, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

207 ENCL Information Power supply cable inserted on 
enclosure:Port % Power 
supply % 

The power cable in the enclosure 
has been connected. 

Action is not required. 

Added in 
Ver.8.10-04 

208 ENCL Information Fan returned to normal on 
enclosure: 

The fan in the enclosure has been 
connected. 

Action is not required. 

Added in 
Ver.8.10-04 
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218 CONFIG Information Foreign Configuration Detected Old configuration information has 
been deleted. 

Action is not required. 

 

219 CONFIG Information Foreign Configuration Imported Old configuration information has 
been imported. 

Action is not required. 

 

220 CONFIG Information Foreign Configuration Cleared Old configuration information has 
been cleared. 

Action is not required. 

 

223 SAS 

 

Warning Link lost on SAS wide port: {1} 
PHY = {2} 

The link of the SAS wide port has 
been lost. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

224 SAS 

 

Information Link restored on SAS wide port: 
{1} PHY = {2} 

The link of the SAS wide port has 
been restored. Action is not 
required. 

Added in 
Ver.8.31-01  

225 SAS 

 

Warning Allowed error rate exceeded on 
SAS port: {1} PHY = {2} 

The error rate of the SAS port has 
exceeded the allowed value. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

226 PD Information Bad block reassigned A bad block has been replaced. 

Action is not required. 

 

227 CTRL Information Controller Hot Plug detected A disk array controller has been 
hot-plugged. 

Action is not required. 

 

228 ENCL Warning Controller[%] Temperature 
sensor differential detected on 
enclosure:PD %(c Port A/p1) 
Sensor % 

The temperature sensor has 
detected changes of ambient 
temperature in the enclosure. 

No action is needed. 

Added in 
Ver.8.10-04 

234 ENCL Information Firmware download in progress 
on enclosure 

Firmware download is in progress 
on an enclosure. 

Action is not required. 

Added in 
Ver.8.10-04 

235 ENCL Warning Firmware download failed on 
enclosure 

Firmware download to an 
enclosure has failed. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

237 CTRL Information Dirty Cache data discarded by 
user 

Dirty cache data has been 
discarded by the user. 

Action is not required. 

 

238 CTRL Warning PDs missing from configuration 
at boot 

A physical drive has not been 
discovered during system 
activation. 

If the removal is not intentional, 
contact the sales representative or 
call maintenance personnel. 
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239 CTRL Critical VDs missing drives and will go 
offline at boot 

A virtual drive has been put to 
offline because it was not 
discovered during system 
activation. 

Contact the sales representative or 
call maintenance personnel. 

 

240 CTRL Critical VDs missing at boot <VDs> A virtual drive has not been 
discovered during system 
activation. 

If the removal is not intentional, 
contact the sales representative or 
call maintenance personnel. 

 

241 CTRL Critical Previous configuration completely 
missing at boot 

The previous configuration 
information has been lost during 
system activation. 

Reconfigure virtual drives. 

 

242 BBU Information Battery charge complete The charging of the cache backup 
module has been completed. 

Action is not required. 

Added in 
Ver.8.31-01  

243 ENCL Information Fan speed changed on 
enclosure:Port % % 

The fan speed in the enclosure has 
been changed. 

Action is not required. 

Added in 
Ver.8.10-04 

244 PD Information Dedicated spare imported as 
global due to missing arrays 

A dedicated hot spare has been 
changed to a global hot spare 
because the target virtual drive of 
the dedicated hot spare is missing. 

Reconfigure a virtual drive and a 
dedicated hot spare as necessary. 

 

245 PD Warning PD rebuild not possible as 
SAS/SATA is not supported in an 
array 

The substituted physical drive 
cannot be rebuilt because it is of a 
different type. 

Use a physical drive of a correct 
type (SAS or SATA). 

 

246 ENCL Information SEP has been rebooted as a part 
of enclosure firmware download. 
SEP will be unavailable until this 
process completes. 

The processor of the enclosure is 
restarting. 

The processor will become 
operative when the restart is 
complete. Action is not required. 

Added in 
Ver.8.10-04 

247 PD Information Device inserted The device has been inserted. 

Action is not required. 

 

248 PD Warning Device removed The physical drive has been 
disconnected. 

If you have intentionally removed 
the physical drive, action is not 
required. 
In other cases, contact the sales 
representative or call maintenance 
personnel. 

The level was 
corrected in 
Ver.2.67-02. 

249 VD Information VD is now OPTIMAL The physical drive has become 
optimal. 

Action is not required. 
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250 VD Warning VD is now PARTIALLY DEGRADED The virtual drive has become 
partially degraded. 

Contact the sales representative or 
call maintenance personnel. 

 

251 VD Critical VD is now DEGRADED The virtual drive has become 
degraded. 

Contact the sales representative or 
call maintenance personnel. 

 

252 VD Fatal VD is now OFFLINE The virtual drive has become 
offline. 
Contact the sales representative or 
call maintenance personnel. 

 

253 BBU Warning Battery requires reconditioning; 
please initiate a LEARN cycle 

The cache backup module requires 
reconditioning. Execute diagnosis. 

Added in 
Ver.8.31-01  

257 PD Warning PD missing A device is missing. 
If the removal is not intentional, 
contact the sales representative or 
call maintenance personnel. 

 

258 CTRL Warning Puncturing of LBAs enabled The puncturing function is 
enabled.  
Action is not required. 

Added in 
Ver.2.29-00 

259 CTRL Warning Puncturing of LBAs disabled The puncturing function is 
disabled. 
Action is not required. 

Added in 
Ver.2.29-00 

261 CTRL Information Package version Package version. 
Action is not required. 

Added in 
Ver.2.29-00 

263 CTRL Warning Foreign configuration table 
overflow  

The array configuration table has 
overflowed. 

An error occurred on the disk 
array controller. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

264 CTRL Warning Partial foreign configuration 
imported,PDs not imported: 

The configuration information has 
been partially added. Not all 
physical drives have been added. 
Check whether you have added a 
physical drive that was used in 
some other system unit. 
If you have not done anything, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

265 CTRL Information Connector is active: The connector is active. 
Action is not required. 

Added in 
Ver.2.29-00 

266 CTRL Information Board Revision Board revision. 
Action is not required. 

Added in 
Ver.2.29-00 

267 CTRL Warning Command timeout on PD: Timeout occurred in a command 
on the device. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 
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268 CTRL Warning PD Reset: The device was reset. 

Action is not required. However, if 
this error occurs frequently, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

269 CTRL Warning VD bad block table is 80% full: The remaining substitute area for 
bad blocks is running short. 
Occurrence of a bad block without 
an available substitute area causes 
a disk fault. 
Collect the backup data, and 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

271 CTRL Fatal Uncorrectable medium error 
logged: 

An uncorrectable medium error 
has been logged. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

272 CTRL Information VD medium error corrected: A virtual drive medium error has 
been fixed. 
Action is not required. 

Added in 
Ver.2.29-00 

273 CTRL Warning PD Bad block table is 100% full: The substitute area for bad blocks 
has been exhausted. 
Occurrence of a bad block without 
an available substitute area causes 
a disk fault. 
Collect the backup data, and 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

274 CTRL Warning VD Bad block table is 100% full: The substitute area for bad blocks 
has been exhausted. 
Occurrence of a bad block without 
an available substitute area causes 
a disk fault. 
Collect the backup data, and 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

275 CTRL Fatal Controller needs replacement 
since IOP is faulty 

An IOP fault is suspected. The 
controller board of the disk array 
needs to be replaced. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.2.29-00 

276 PD Information CopyBack started on PD: {1} 
Source PD: {2} 

CopyBack has started. Action is 
not required. 

Added in 
Ver.8.31-01  

277 PD Warning CopyBack aborted on PD: {1} 
Source PD: {2} 

CopyBack has stopped. 

Action is not required if the user 
stopped it. 

Added in 
Ver.8.31-01  

278 PD Information CopyBack completed on PD: {1} 
Source PD: {2} 

CopyBack has been completed. 
Action is not required. 

Added in 
Ver.8.31-01  

280 PD Information CopyBack resumed on PD: {1} 
Source PD: {2} 

CopyBack has started again. 
Action is not required. 

Added in 
Ver.8.31-01  

281 PD Information CopyBack automatically started 
on PD: {1} Source PD: {2} 

CopyBack has started 
automatically. Action is not 
required. 

Added in 
Ver.8.31-01  
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282 PD Critical CopyBack failed due to source 
drive error on PD: {1} Source 
PD: {2} 

CopyBack failed due to an error at 
the source drive. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

284 BBU Information BBU FRU is: FRU of the cache backup module 
has been loaded. Action is not 
required. 

Added in 
Ver.8.31-01 

292 CTRL Warning Patrol Read can't be started, as 
PDs are either not ONLINE, or 
are in a VD with an active 
process, or are in an excluded 
VD 

Patrol Read could not be started 
because there are no virtual drives 
that can be activated. 

Check the virtual drives of the disk 
array controller, and then contact 
the sales representative or call 
maintenance personnel. 

Added in 
Ver.3.04-08 

293 PD Information Copyback aborted by user on PD: 
{1} Source PD: {2} 

Copyback has been stopped by the 
user. Action is not required. 

Added in 
Ver.8.31-01  

294 PD Critical Copyback aborted on the hot 
spare as hot spare needed for 
rebuild. 

Hot Spare PD: {1} Source PD: 
{2} 

Copyback has aborted because the 
hot spare was needed for rebuild. 

Action is not required. 

Added in 
Ver.8.31-01  

295 PD Warning Copyback aborted as rebuild 
required in the array. 

PD: {1} Source PD: {2} 

Copyback has aborted because 
rebuild was requested. 

Action is not required. 

Added in 
Ver.8.31-01  

297 PD Warning Copyback cannot be started as 
drive is too small. 

PD: {1} Source PD: {2} 

The capacity of the substituted 
physical drive is too small for 
starting Copyback. 

Check whether a correct physical 
drive is mounted. 

If a correct physical drive is 
mounted, the physical drive has a 
fault. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

298 PD Warning Copyback cannot be started as 
SAS/SATA is not supported in an 
array. 

PD: {1} Source PD: {2} 

Copyback could not be started 
because the physical drive is of a 
different type. 

Check whether a correct physical 
drive is mounted. 

If a correct physical drive is 
mounted, the physical drive has a 
fault. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

303 CTRL Information Controller properties changed The controller properties have 
been changed. 

Action is not required. 

Added in 
Ver.8.10-04 

304 CTRL Information Patrol Read properties changed The Patrol Read properties have 
been changed. 

Action is not required. 

Added in 
Ver.8.10-04 
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306 BBU Information Battery properties changed The properties of the cache backup 
module have been changed. Action 
is not required. 

Added in 
Ver.8.31-01 

307 BBU Warning Periodic Battery Relearn is 
pending. Please initiate manual 
learn cycle as Automatic learn is 
not enabled. 

The diagnosis of the cache backup 
module is suspended. Start the 
diagnosis manually because 
automatic diagnosis is disabled. In 
other cases, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.31-01 

327 CTRL Warning Consistency Check started on an 
inconsistent VD: 

Consistency check has been 
executed on a virtual drive that 
has not been initialized or whose 
capacity has been expanded. 

Action is not required. 

Added in 
Ver.2.67-02 

331 CTRL Information Power state change on The power status has been 
changed. 

Action is not required. 

Added in 
Ver.8.31-01 

332 ENCL Information Enclosure element status 
changed 

The enclosure status has been 
changed. 

Action is not required. 

Added in 
Ver.8.10-04 

333 PD Information Rebuild is not allowed on PD as 
HDD/SSD mix is not supported in 
VDs. PD: 

Rebuilding cannot be executed 
because the virtual drive is 
configured so as not to allow 
mixture of HDD and SSD. Check 
the type of the substituted drive. 

Added in 
Ver.8.10-04 

334 PD Information Copyback is not allowed on PD as 
HDD/SSD mix is not supported in 
VDs. 

PD: {1} Source PD: {2} 

Copyback cannot be executed 
because the virtual drive is 
configured so as not to allow 
mixture of HDD and SSD. Check 
the type of the spare drive. 

Added in 
Ver.8.31-01  

335 VD Information VD Bad block table is Cleared. 
VD: 

A bad block table has been 
deleted. 

Action is not required. 

Added in 
Ver.8.10-04 

336 CTRL Critical SAS topology error: An SAS topology error occurred. 

Check the RAID setting of the 
enclosure. 

Added in 
Ver.8.10-04 

337 VD Information VD cluster of medium error 
corrected: 

A cluster medium error has been 
repaired. 

Action is not required. 

Added in 
Ver.8.10-04 

338 CTRL Information Controller requests a host bus 
rescan 

The controller has requested 
rescan of a host bus. 

Action is not required. 

Added in 
Ver.8.10-04 

339 CTRL Information Controller repurposed and 
factory defaults restored 

The controller has been redefined 
and the factory default has been 
restored. 

Action is not required. 

Added in 
Ver.8.10-04 

346 CTRL Information Snapshot enabled on A snapshot is enabled. 

Action is not required. 

Added in 
Ver.8.10-04 
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347 CTRL Information Snapshot disabled by the user on Snapshot has been disabled by the 
user. 

Action is not required. 

Added in 
Ver.8.10-04 

348 CTRL Critical Snapshot disabled on A snapshot is disabled. 

Check whether the snapshot 
repository or the snapshot view is 
full. Enable snapshot again. 

Added in 
Ver.8.10-04 

349 CTRL Information Snapshot Point In Time created 
on 

A snapshot has been created. 

Action is not required. 

Added in 
Ver.8.10-04 

350 CTRL Information Snapshot Point In Time deleted 
on 

A snapshot has been deleted. 
(When automatically deleted) 
action is not required. 

Added in 
Ver.8.10-04 

351 CTRL Information Snapshot View created on A snapshot view has been created. 

Action is not required. 

Added in 
Ver.8.10-04 

352 CTRL Information Snapshot View deleted on A snapshot view has been deleted. 

Action is not required. 

Added in 
Ver.8.10-04 

353 CTRL Information Snapshot rollback started for 
Point In Time on 

A snapshot rollback has started. 

Action is not required. 

Added in 
Ver.8.10-04 

354 CTRL Fatal Snapshot rollback internally 
aborted for Point In Time on 

A snapshot rollback has been 
aborted. 

Study the past events to find out if 
the snapshot data is enabled. You 
cannot execute rollback if the 
snapshot data is disabled. 
Reconfigure the snapshot in this 
case. 

Added in 
Ver.8.10-04 

355 CTRL Information Snapshot rollback completed for 
Point In Time on 

A snapshot rollback has been 
completed. 

Action is not required. 

Added in 
Ver.8.10-04 

356 CTRL Information Snapshot rollback progress on 
Point In Time on 

Snapshot rollback is in progress. 

Action is not required. 

Added in 
Ver.8.10-04 

357 CTRL Warning Snapshot repository 80% full on The snapshot repository has been 
used 80%. 

Reconsider the area of the 
snapshot repository. 

Added in 
Ver.8.10-04 

358 CTRL Critical Snapshot repository full on The snapshot repository has been 
exhausted. 

Reconsider the area of the 
snapshot repository. 

Added in 
Ver.8.10-04 

359 CTRL Warning Snapshot View 80% full on The snapshot view has been used 
80%. 

Reconsider the area of the 
snapshot view. 

Added in 
Ver.8.10-04 

360 CTRL Critical Snapshot View full on The snapshot view has been 
exhausted. 

Reconsider the area of the 
snapshot view. 

Added in 
Ver.8.10-04 
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361 VD Critical Repository lost for VD The snapshot repository for the 
virtual drive has been deleted. 

Check if the repository has been 
intentionally deleted. If you cannot 
check it, set the snapshot 
repository to the virtual drive 
again. 

Added in 
Ver.8.10-04 

362 VD Warning Repository restored for VD The snapshot repository for the 
virtual drive has been restored. 

Confirm that the correct data has 
been restored. 

Added in 
Ver.8.10-04 

363 CTRL Critical Snapshot encountered an 
unexpected internal error: 

An unexpected internal error 
occurred in the snapshot. 

Check if there are any other 
errors. Also check the snapshot 
settings. 

Added in 
Ver.8.10-04 

364 CTRL Information Auto Snapshot enabled on Auto snapshot is enabled. 

Action is not required. 

Added in 
Ver.8.10-04 

365 CTRL Information Auto Snapshot disabled on Auto snapshot is disabled. 

Action is not required. 

Added in 
Ver.8.10-04 

366 CTRL Critical Configuration command could 
not be committed to disk, please 
retry. 

Update of the configuration 
information has not been finished. 

Retry the update. 

Added in 
Ver.8.10-04 

367 PD Information COD on PD updated as it was 
stale. PD: 

The configuration data has been 
updated. 

Action is not required. 

Added in 
Ver.8.10-04 

368 CTRL Warning Power state change failed on Power state change has failed. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01 

369 VD Warning VD is not available. VD: The virtual drive cannot be used. 

Check the virtual drive settings. 
Check if there are any other 
errors. If there are, take 
appropriate action. In other cases, 
contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.10-04 

370 VD Information VD is available. VD: Cache Cade or the virtual drive 
has become available. 

Action is not required. 

Added in 
Ver.8.10-04 

371 VD Information VD is used for Cachecade(TM). 
VD: 

The Cache Cade function is 
assigned for the virtual drive. 

Action is not required. 

Added in 
Ver.8.10-04 

372 VD Information VD is being cached in 
Cachecade(TM). VD: 

The Cache Cade function has 
stored the cache data of the virtual 
drive. 

Action is not required. 

Added in 
Ver.8.10-04 

373 VD Information VD is no longer being cached in 
Cachecade(TM). VD: 

The Cache Cade function cannot 
store the cache data of the virtual 
drive anymore. 

Action is not required. 

Added in 
Ver.8.10-04 
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374 CTRL Critical Snapshot deleted due to resource 
constraints on 

One of the snapshot data item has 
been deleted because of the 
exceedance of the snapshot data 
capacity. 

Reconsider the area of the 
snapshot repository. 

Added in 
Ver.8.10-04 

375 CTRL Warning Auto Snapshot failed for Auto snapshot failed because it is 
set to "Stop taking snapshot" and 
the number of snapshots has 
reached the maximum number(8). 

Check if there is any problem in 
the auto snapshot setting. 

Added in 
Ver.8.10-04 

376 CTRL Warning Controller reset on-board 
expander 

The controller has reset the 
expander. 

Action is not required. If this event 
occurs frequently, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 

377 VD Warning Cachecade(TM) VD capacity 
changed VD: 

The capacity of the virtual drive for 
Cache Cade has been changed. 

Check if any constituting drive has 
been changed or has a fault. If 
there is any fault, contact the 
sales representative or call 
maintenance personnel. 

Added in 
Ver.8.10-04 

379 VD Information Advanced Software Options Key 
was applied 

The activation key has been 
authorized. 

Action is not required. 

Added in 
Ver.8.10-04 

380 VD Information Snapshot schedule properties 
changed on VDs: 

The snapshot schedule has been 
changed. 

Action is not required. 

Added in 
Ver.8.10-04 

381 VD Information Snapshot scheduled action is 
due-Schedule timer expired on 
VDs: 

The term of the snapshot schedule 
has expired. 

Action is not required. 

Added in 
Ver.8.10-04 

383 CTRL Information Advanced Software Options was 
transferred 

Advanced Software Options have 
been transferred. 

Action is not required. 

Added in 
Ver.8.10-04 

384 CTRL Information Advanced Software Options 
Serial number: 

Serial number. 

Action is not required. 

Added in 
Ver.8.10-04 

385 CTRL Warning Advanced Software Options 
Serial number mismatched. Key 
vault Serial number is: 

Serial number mismatch. 

Perform re-hosting. 

Added in 
Ver.8.10-04 

387 CTRL Information Power policy changed in VD: The power policy has been 
changed. Action is not required. 

Added in 
Ver.8.31-01 

388 CTRL Warning Cannot transition to max power 
savings on VD: 

The power policy cannot become 
max power savings mode. Restore 
the power policy to the factory 
default. 

Added in 
Ver.8.31-01 

389 CTRL Information Host driver is loaded and 
operational 

The host driver has been normally 
loaded and is in operational. Action 
is not required. 

Added in 
Ver.8.31-01 
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392 SAS Warning Link failed on Wide Port {1} Link 
{2} 

The link of the wide port has been 
lost. 

Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01  

393 SAS Information Link restored on Wide Port {1} 
Link {2} 

The link of the wide port has been 
restored. Action is not required. 

Added in 
Ver.8.31-01  

394 BBU Information Memory module FRU is: The cache backup module has 
been loaded. Action is not 
required. 

Added in 
Ver.8.31-01 

395 BBU Critical Cache-Vault power pack is sub-
optimal. Please replace the pack. 

The cache backup module has 
entered fault mode. Replace the 
cache backup module. 
Contact the sales representative or 
call maintenance personnel. 

Added in 
Ver.8.31-01 

397 BBU Warning Cache-Vault microcode update 
required. 

The firmware of disk array 
controller and that of the cache 
backup module does not match. 
Check if the firmware of disk array 
controller is supported. In other 
cases, contact the sales 
representative or call maintenance 
personnel. 

Added in 
Ver.8.31-01 

403 CTRL Information Drive Cache settings enabled 
during rebuild on PD: 

Rebuilding will be executed with 
the physical drive cache enabled. 
Action is not required. 

Added in 
Ver.8.31-01 

404 CTRL Information Drive Cache settings restored 
after rebuild on PD: 

The physical drive cache will be 
restored to the original after 
rebuilding. Action is not required. 

Added in 
Ver.8.31-01 

407 CTRL Information Consistency Check suspended on 
VD : {1} 

The consistency check has been 
suspended. Action is not required. 

Added in 
Ver.8.31-01  

408 CTRL Information Consistency Check resumed on 
VD : {1} 

The consistency check has started 
again. Action is not required. 

Added in 
Ver.8.31-01  

409 CTRL Information Background Initialization 
suspended on VD : {1} 

The background initialization has 
been suspended. Action is not 
required. 

Added in 
Ver.8.31-01  

410 CTRL Information Background Initialization 
resumed on VD : {1} 

The background initialization has 
started again. Action is not 
required. 

Added in 
Ver.8.31-01  

411 CTRL Information Reconstruction suspended on 
VD : {1} 

Capacity expansion processing has 
been suspended. Action is not 
required. 

Added in 
Ver.8.31-01  

412 CTRL Information Rebuild suspended on PD : {1} Rebuilding has been suspended. 
Action is not required. 

Added in 
Ver.8.31-01  

413 CTRL Information Copyback suspended on PD : {1} Copyback has been suspended. 
Action is not required. 

Added in 
Ver.8.31-01  

414 CTRL Information Reminder: Consistency Check 
suspended on VD : {1} 

Reminder: The consistency check 
has been suspended. 

Action is not required. 

Added in 
Ver.8.31-01  

415 CTRL Information Reminder: Background 
Initialization suspended on VD : 
{1} 

Reminder: The background 
initialization has been suspended. 
Action is not required. 

Added in 
Ver.8.31-01  
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416 CTRL Information Reminder: Reconstruction 
suspended on VD : {1} 

Reminder: Capacity expansion 
processing has been suspended. 
Action is not required. 

Added in 
Ver.8.31-01  

417 CTRL Information Reminder: Rebuild suspended on 
PD : {1} 

Reminder: Rebuild has been 
suspended. Action is not required. 

Added in 
Ver.8.31-01  

418 CTRL Information Reminder: Copyback suspended 
on PD : {1} 

Reminder: Copyback has been 
suspended. Action is not required. 

Added in 
Ver.8.31-01  

419 CTRL Information Reminder: Patrol Read 
suspended 

Reminder: Patrol Read has been 
suspended. Action is not required. 

Added in 
Ver.8.31-01  

420 CTRL Information Erase aborted on PD : {1} The user has suspended the erase 
operation. 

The original data has been 
deleted. 

Restore the backup data as 
necessary. 

Added in 
Ver.8.31-01  

421 CTRL Critical Erase failed on PD : {1} (Error 
{2}) 

The erase operation has stopped. 

The physical drive may have 
failed. 

Contact the sales representative or 
call maintenance personnel. 

Restore the backup data as 
necessary. 

Added in 
Ver.8.31-01  

423 CTRL Information Erase started on PD : {1} The erase operation has started. 

After completion of the erase 
operation, restore the backup data 
as necessary. 

Added in 
Ver.8.31-01  

424 CTRL Information Erase completed on PD : {1} The erase operation has been 
completed. 

The original data has been 
deleted. 

Restore the backup data as 
necessary. 

Added in 
Ver.8.31-01  

425 CTRL Information Erase aborted on VD : {1} The user has suspended the erase 
operation. 

The original data has been 
deleted. 

Restore the backup data. 

Added in 
Ver.8.31-01  

426 CTRL Critical Erase failed on VD : {1} The erase operation has stopped. 

The physical drive may have 
failed. 

Contact the sales representative or 
call maintenance personnel. 

Restore the backup data as 
necessary. 

Added in 
Ver.8.31-01  

428 CTRL Information Erase started on VD : {1} The erase operation has started. 

After completion of the erase 
operation, restore the backup data 
as necessary. 

Added in 
Ver.8.31-01  
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429 CTRL Information Erase complete on VD : {1} The erase operation has been 
completed. 

The original data has been 
deleted. 

Restore the backup data as 
necessary. 

Added in 
Ver.8.31-01  

430 CTRL Warning Potential leakage during erase on 
VD : {1} 

The original data may be readable 
during the erase operation. 

After completion of the erase 
operation, restore the backup data 
as necessary. 

Added in 
Ver.8.31-01  

440 SAS Information Link speed changed on SAS port 
{1} PHY = {2} 

The link speed of SAS port has 
been changed. Action is not 
required. 

Added in 
Ver.8.31-01  

445 CTRL Warning Patrol Read aborted on PD : {1} Patrol Read has stopped. 

Action is not required if the user 
stopped it. 

Added in 
Ver.8.31-01  

61440 MONITOR Information Monitor has started successfully. The RAID monitor service has 
started. 

Action is not required. 

 

61441 MONITOR Information Monitor has shutdown 
successfully 

The RAID monitor service has 
stopped. 

Action is not required. 

 

61442 MONITOR Warning No controllers detected The disk array controller cannot be 
found. 

Check whether a correct device 
driver is installed 

 

NA NA NA Successful log on to the server You have logged on to the server 
successfully. 

Action is not required. 

 

NA NA NA Successful log out from the 
server 

You have logged out from the 
server. 

Action is not required. 

 

NA NA NA Full access denied on the server You have logged on to the server 
in full access mode. 

Action is not required. 

 

NA NA NA Server log cleared The server log has been cleared. 

Action is not required. 
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Request sense data 

The request sense data shown below is output following <CDB> to the event 
log. 

CDB = xx xx xx  
Sense = 0xf0 0x00 0x04 0x00 0x01 0x00 0x00 0x28 0x00 0x00 0x00 
        0x00 0xc4 0x00 0x00 0x00 0x00 0x00 0x20 0x28 0x00 0x21 
        0xb0 0x01 0x15 0x02 0x00 0x00 0x00 0x15 0x00 0x78 0x00 
        0x00 0x00 0x22 0x1f 0x40 0x00 0x00 0x00 0x00 0x00 0x00 
        0x00 0x00 0x00 0x00 

The first three bytes of the <Sense> data are "sense key" that indicates the 
main error code from the hard disk. 

The following table describes each sense key:  
Sense key Name Description 

0x00 No Sense Indicates that there is no particular sense key. 

0x01 Recovered 
Error 

Indicates that the last command was executed successfully with 
device recovery processing. 

0x02 Not Ready Indicates that the device is not accessible. 

0x03 Medium Error Indicates that an uncorrectable error was detected due to a media 
defect or stored-data error. 

0x04 Hardware 
Error 

Indicates that an uncorrectable hardware error was detected during 
execution of command or self-diagnosis in the device. 

0x05 Illegal Request Indicates that an invalid value was detected in the CDB or parameter 
transferred by the designation in the command. 

0x06 Unit 
Attention 

Indicates that unit attention condition occurred. 

0x07 Data Protect Indicates that violating access was attempted to data area of 
read/write-protected recording media. 

0x08 Blank Check Indicates that the write-once device or sequential-access device 
detected blank area or data end mark during read operation or the 
write-once device attempted to write data to a non-blank area. 

0x09 (Reserved) - 

0x0A Copy Aborted Indicates that the Copy command, Compare command, or 
CopyandVerify command abended due to an error in the source 
device or destination device. 

0x0B Aborted 
Command 

Indicates that the target caused the command to abend. 

0x0C Equal Indicates that the Search Data command ended successfully with 
data search condition Equal met. 

0x0D Volume Overflow Indicates that unwritten data is remaining in the buffer because media 
data area ended in the device with a buffer. 

0x0E Miscompare Indicates that a mismatch was detected in the data compare 
command. 

0x0F (Reserved) - 
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List of services 
MSM services are listed below. 

Windows 

• MSMFramework 

Linux 

• msm_profile 

• vivaldiframeworkd 

• lsi_mrdsnmpd (daemon) 
 

 
For both Windows and Linux, use the default setting values of MSM 
service startup. 
(Services automatically start during the OS startup by default.) 

List of processes 

MSM processes are listed below. 

Windows: 

• cmd.exe 

• javaw.exe 

• popup.exe 

• VivaldiFramework.exe 

Linux: 

• sh /usr/local/MegaRAID Storage Manager/Framework/startup.sh 

• ../jre/bin/java -classpath ../jre/lib/rt.jar:../jre/lib/jsse.jar:../jre/lib/ 

jce.jar:mail.jar:Framework.jar -Djava.library.path=. 
Framework.FrameworkManager 

• . /bin/sh ./popup 

• /bin/sh /usr/local/MegaRAID Storage Manager/startupui.sh *1 

• ../jre/bin/java -classpath .:Popup.jar:../GUI.jar Popup.Communicator 
ajsgyqkj=71244 

• ./jre/bin/java -Duser.country=US -Duser.language=en -DVENUS=true  
-DGUI_VERSION=11.08.03.00 -classpath  
.:GUI.jar:monitorgui.jar:DebugLog.jar:log4j-1.2.15.jar:jaxen-
1.1.jar:jdom-1.1.jar GUI.VivaldiStartupDialog ajsgyqkj=71244 *1 

• /usr/sbin/lsi_mrdsnmpagent -c /etc/snmp/snmpd.conf 

(When SNMP is enabled) 

*1: only while running MSM. 
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Port number 

This section explains the port numbers used by MSM. 

• Port numbers 

3071: protocol: TCP and UDP 

5571: protocol: UID 

49152 to 65535: Dynamic and/or Private Ports 
 

 
Although Port 5571 is not used by this version of MSM but is reserved 
for MSM. If you introduce the network security, register the port 
number as an exception. 
Do not use the MSM ports for other applications. 

System log (in Linux) 

This section explains how events are stored in different syslog files for Linux. 

Linux syslog event output 

To store events in different files based on their levels, add the lines listed 
below to one of the following log setting files: 

For Red Hat Enterprise Linux 6: /etc/rsyslog.conf 

For Red Hat Enterprise Linux 5: /etc/syslog.conf 

The lines to be added are as follows: 

• user.=info        /var/log/user.info 

• user.=crit         /var/log/user.crit 

• user.=warning  /var/log/user.warning 

• user.=emerg     /var/log/user.emerg 

Level 

The correspondence between the above levels and the event levels used in this 
manual is as follows: 

• Information = info 

• Critical = crit 

• Warning = warning 

• Fatal = emerg 
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